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Preface

The Oracle Retail Price Management User Guide describes the application user interface
and how to navigate through it.

Audience

This document is intended for the users and administrators of Oracle Retail Price
Management. This may include merchandisers, buyers, and business analysts.

Related Documents

For more information, see the following documents in the Oracle Retail Price
Management Release 12.0.6 documentation set:

Oracle Retail Merchandising Batch Schedule
Oracle Retail Price Management Data Model
Oracle Retail Price Management Installation Guide
Oracle Retail Price Management Release Notes
Oracle Retail Price Management Operations Guide

Oracle Retail Price Management Online Help

Customer Support

https:/ / metalink.oracle.com

When contacting Customer Support, please provide the following:

Product version and program/module name

Functional and technical description of the problem (include business impact)
Detailed step-by-step instructions to re-create

Exact error message received

Screen shots of each step you take

Review Patch Documentation

For a base release (".0" release, such as 12.0), Oracle Retail strongly recommends that you
read all patch documentation before you begin installation procedures. Patch
documentation can contain critical information related to the base release, based on new
information and code changes that have been made since the base release.

Oracle Retail Documentation on the Oracle Technology Network

In addition to being packaged with each product release (on the base or patch level), all
Oracle Retail documentation is available on the following Web site:

http:/ /www-.oracle.com/technology/documentation/oracle_retail.html

Documentation should be available on this Web site within a month after a product
release. Note that documentation is always available with the packaged code on the
release date.

Xi


https://metalink.oracle.com/
http://www.oracle.com/technology/documentation/oracle_retail.html

Conventions

Navigate: This is a navigate statement. It tells you how to get to the start of the procedure
and ends with a screen shot of the starting point and the statement “the Window Name
window opens.”

Note: This is a note. It is used to call out information that is
important, but not necessarily part of the procedure.

This is a code sample
It is used to display examples of code

A hyperlink appears like this -

Xii
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Welcome to Oracle Retail Price Management

Oracle® Retail Price Management (RPM) is a strategy-based pricing solution that
suggests and assists with pricing decisions. With RPM, you can automate and streamline
pricing strategies across the organization to yield a more predictable and profitable
outcome. RPM provides decision support with pricing-focused business information to
validate and approve pricing and markdown suggestions. The results are higher
margins, increased sales, and strengthened productivity, all while remaining
competitive.

User Guide 1






2
Navigate RPM

Access the Workspace

Log In to RPM

How you access Oracle Retail Price Management depends on how the application is set
up at your location. Contact your system administrator for instructions. Use the exit
procedure when you are done using the application.

Exit RPM

There are several ways that you can log out and close RPM:
= (lick Logout in the global links area of the header.

= Select Close Window from the File menu.

=  Select Exit from the File menu.

= Click the close button on the title bar.

If any tasks are open, you are prompted to confirm your decision to log out.

User Guide 3



View the Workspace

View the Workspace

After logging into RPM, you have access to the application window. The primary
elements in the application window are as follows:
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The RPM Workspace

The workspace is comprised of all the elements within the application window. You
manage the application and perform tasks within the workspace. Many of the elements
within the workspace can be minimized, maximized, or manually resized. This allows
you to customize the workspace to fit your work habits. Any changes you make are
remembered by the application. The next time you log in, the elements appear as you last

left them.

Element Purpose

A Title bar Located at the top of the window. The title bar displays the product name.
The three buttons at the far right on the title bar allow you to minimize,
restore, maximize, and close the application window.

B Header Located below the title bar. The header provides access to commands that
remain static across all tasks. The menu bar and welcome message appear
here.

C Toolbar Located below the header. The toolbar contains paging control icons.

D Workspace Located next to the task pad and below the toolbar. What appears in the
workspace depends on what you select on the task pad. The workspace is
where you complete the tasks assigned to you.

4 Oracle Retail Price Management



View the Workspace

Element Purpose
E Task pad Located on the left side of the application window. From top to bottom, you
can access an application, a task group, and then a task. When you select a
task, the contents of the task are displayed in the workspace.
Note: The Simplified RPM task pad may display a different navigational
menu.
ORACLE: =IE R
(© system Options :
=~ Tl
Simplified RPM Task Pad
F Task bar Located at the bottom of the window. Task buttons, located on the task bar

G Status bar

H Pane

Task

allow you to switch between open tasks.

Located at the bottom of the window. The status bar lists the status of a task
and gives other information.

A sub-section of a window that appears in the work space. Multiple panes
may appear in the workspace when a task is selected.

A pane or a group of panes that appear in the workspace, allowing you to
work.
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Resize Elements of the Workspace

Resize Elements of the Workspace

The benefits of resizing become apparent as you customize the workspace to fit your
work habits. You can hide or minimize elements that do not pertain to the current task.
You can show or maximize the elements that are of greater importance.

The RPM Window

Toolbar

You can resize the RPM window in order to increase or decrease the amount of space it
occupies on your desktop.

* To manually resize the window, place the cursor over the edge of the window. When
the cursor changes to a double arrow, press and hold the left mouse button. Move the
cursor until the window is the desired size. Release the left mouse button.

J (3l -] (& ]

Alerts | _ogout | Logou: (<]

Minimize and Maximize the RPM Window

= To minimize the window, click the minimize icon (A).
* To maximize the window, click the maximize icon (B).
= To restore the window to its previous size, click the restore icon (C).

* Asan alternative method for resizing the window, right click on the RPM button
found on the Microsoft Windows task bar. On the context menu that appears, select
Restore, Minimize, or Maximize.

Although the toolbar occupies relatively little space in the window, you can choose to
hide it or show it.

[ f=T]Fd

Alerts | Logout (z)

RPM Toolbar

= To collapse the toolbar (A), click the expand/collapse toolbar icon (B). The icon is
located on the far right side of the header.

= To expand the toolbar, click again on the same icon.
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Resize Elements of the Workspace

Workspace
The workspace is likely to be the most used element in the application. As such, you may
want to maximize its size. Should you need to access the task pad, restore the content
area to its original size.
= [rrm
B
Foundation
Aggregation Level A
A
RPM Workspace
= To expand the workspace (A), click the explode icon (B). The icon is located on the
upper left corner of the content area. The content area expands to the width of the
window. The task pad and the toolbar disappear.
= To restore the window to its original size, click again on the same icon. The task pad
and toolbar reappear.
Task Pad

The task pad provides access to the tasks assigned to you. Once you are working on a
task, you may want to reduce the size of the task pad. You may want to increase the size
of the task pad in order to see the full names of the task. As you increase or decrease the
width of the task pad, the width of the workspace is resized proportionally.

Note: The Simplified RPM task pad may display a different
navigational menu.
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Resize Elements of the Workspace

[ |[ml]

oms: Alain Fracan Alerts | Logout |€

System Dptions

Foundation
Link Codes
Zone Stucture

Price Guides

Price Changes

Clearances

Promotion Events

Promotions

Promotion Threshold
Promotion Constraints
Vendor Funding Defaults
onflict Checl Results

View Tasks

Price Inquiry

System Dptions Edit
System Dptions View
System Defaults Edit
.+ System Defaults View

Simplified RPM Task Pad

To maximize the task pad, click the right arrow on the separator bar (A). To minimize the
task pad, click the left arrow.
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Resize Elements of the Workspace

Tasks

= |REM [~
Systerm Optons

Foundation

Aggregation Lewvel
Zone Stucture

Price Guides

Calendar
Candidate Rules

Price Changes

Clearances

Promotion Events

Promotions
Promotion Threshold

Promotion Constraints A
Vendor Funding Defaults By
Pricing Strategy

Worisheet

Link Codes

Market Basket Codes

o,

@ System Dplions

: System Options Edit

+ System Dpbtons Wiew
: System Defaults Edit
: System Defaults Wiew

oo,

>'a

Ao

RPM Task Pad
Note that the width of the task pad can be:

Maximized to the width of the application window
Minimized so that it is no longer visible

Restored to its previous size

To manually resize the width of the task pad or the length of the work areas within the
task pad, place the cursor over the desired resizer (B). When the cursor changes to a
left/right (or an up/down) arrow, press and hold the left mouse button. Drag the resizer
until the task pad or work area is the desired size. Release the mouse button.
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Pane

One or more panes appear in the workspace when you select a task on the task pad. You
can collapse a pane so that it does not distract you from the panes you want to work in.
Only the title bar of the container is displayed after you collapse it. When you are ready
to work in the collapsed container, you can then return it to its regular size.

%5 create Price Change

I@__I?_f_ce Change List A |
Price Change T B || &
10 Link Code Iten Item Descript Item Level Diff ID Diff ID Desc| Location Location Desd Lacation Typd
Filkay by: lEI | Filtay by.‘lzl | Filkar by.‘lzl | Filkar by:lzl | Fittay by: lEI | Filtay by.‘lzl | Filkay by.‘lzl | Filkar by:lzl | Fittay by: lEI | Filtay by.‘lzl
4 3
9 — |
.

Mew

7
I'/-(f- Price Change Maintenance

A

RPM Pane

To collapse a pane (A), click the collapse icon (B).

To expand a pane, click the expand icon (C).
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Look Up Field Level Data

Look Up Field Level Data

The basic method for entering data in a text field is to type the text in the field. Some
fields are restricted, however, as to the type of data that may be entered. The options for
entering or selecting data depend on the type of data that may be required or permitted
in the field. For example, some fields permit only numeric data, while others permit only
alphabetic or alphanumeric data. Some fields require a date to be entered in a specific
format. Some fields permit only one value, while others permit multiple values.

Calendars, drop-down lists, lists of values, and transfer boxes provide you with access to
preformatted, predefined values. Instructions for using these tools are provided below.

Drop-Down List

Some fields are restricted to a predefined list of values. You access a drop-down list from
which you can pick the desired value.

A-...h-q‘

Itern Lavel

Tran Level

Parent Level
iffl Level
Diff2 Level
Liff2 Level
Frar by E FilkeDitfd Level

| Diff Type Lewel
I |

Drop-Down List

ice Change Indici Con

1. Click on the drop-down arrow (A) next to a field. A list of predefined values appears.

2. Scroll through the list until the desired value appears. Select the value. The field is
automatically filled in with the selected value.
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Look Up Field Level Data
List of Values
When a drop-down list has many values, you can typically access them from the list of
values & (LOV) button.
%S Create Price Guide
I@ Price Guide Create
Price Guide Type |Corp0rate
¥ Name |
&3 Dezcription |
Cepartrment
* currency UsD EAUS Dollar
AR
Code Description B
Fitker by: B Flibar by -
ADP Andorran Peseta E
AED UAE Crirham
AFA Afghani l
ALL Lek
AMD Armeanian Dram
AMG Metherlands &ntillian Guilder
ADA Kwanza
ARE Argentine Pesa
ATS Schilling
ALD Auztralian Dollar
ANG Aruban Guilder
AZM Azerbaijanian Manat
BAM Convertible Marks
BEL Barbados Callar
BODT Taka
BEF Belgian Franc
BGL Lew
BGM Bulgarian Lew
BHL Bahraini Dinar -
FC D 1-133 of 123
| Cancel || Select |—
HTTCET

List of Values

1. Click the LOV B button next to a text field (A). The list of values opens. The number
of values in the list and the total number of values appears at the bottom (D) of the

LOV.

=  Click the page icon (C) to open the Paging Configuration window and adjust the

page size and page links.
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Look Up Field Level Data

Paging Configuration |

Ed

Page Size 100

“izible Page Links

Paging Configuration Window

2.

To find a value, use one or a combination of the following methods:
= Scroll through the list.

= Enter a partial value in the Filter by text box (B) and press Enter. Select the
desired value from the results.

=  Select the down arrow next to the Filter by text box (B) and use the Advanced
Filter option. Enter conditions in the Advanced Filter and click OK.

= Enter the wildcard (%) and letters before or after it in the Filter by text box (B) to
limit values.

Select the value and click Select. The field is automatically filled in with the selected
value.

User Guide 13



Look Up Field Level Data

Multi-Select List of Values

Some lists of value allow you to select more than one value. Multi-select LOV & button
allows a user to select multiple rows in a single block by using the Shift and Control keys.
The functionality is similar to the select functionality of other Windows applications.

I
ID Description
Fitkar by - lEI | Filker by IEI
T f 4]
icé icé
SIMREG1 Externally generated Price Change
test tast .
AREADIFFAA Area Diff Auto Approve Price Change
Joes Code Joez Description
RegCodeMew newlesc =
F 1-16 of 16

=] (2]

12 |

I Descripton

Fitkar by IEI | Fitkar by lzl

Cancel | | Select

Multi-Select List of Values

Open the Multi-Select LOV

Click the LOV 1 button next to a text field, or click the down arrow. The list of values
opens.

Select Continuous Information
1. Select a row.

2. Press Shift and click on another row to select all the rows in between, inclusively.

Select Non-Continuous Information
1. Select a row.

2. Control click on rows to select or clear the individual rows clicked on (depending on
whether they are currently selected) while leaving the other selected rows still
selected.

Add the Values
1. Click the down arrow to add the value to the selected area.

2. Click the up arrow to remove a value from the selected area.
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Search for and Filter Records

Search for and Filter Records

You search for records when none are displayed. By entering search criteria, you indicate
which records must be displayed for your use. Filtering, on the other hand, allows you to
reduce the number of records (or values) displayed. Again, you enter criteria indicating
which of the currently displayed records must remain visible. The unwanted records are
hidden from view. In either case, you are restricting the number of records (or values)
displayed to a more manageable and useful number.

Filter Records in a Table
Column-level filtering is available in tables that have drop-down lists.
e To use a simple filter:

a. Enter a partial string in the active cell. For example: Enter D or d to retrieve all
records that begin with D, such as Department.

Merchandise Level | Merchandise ID

Cepartrnent il d IFZI TS bt

Clear Filtar h
| Clear all Filtars
| Advanced Filter...

Departrment

Departrnent -

Simple Filter

b. Press Enter. The records that match the filter criterion are displayed in the table.

c. To show all records again, click on the down arrow in the active cell and select
Clear Filter.

e To use the advanced filter tool:

a. Click the down arrow in the active cell and select Advanced Filter. The
Advanced Filter window opens.

Advanced Filter, E|
Show rows where
Merchandise Lavel |is equal to lEI
| =l
|[none) lEI
| Cancel || 0K |

Advanced Filter

b. Select a relational operator in the first list box. Then select a value in the second
list box.
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Search for and Filter Records

c. If another condition is necessary, select a logical operator (And or Or). Then
select the second relational operator and value.

d. Click OK. The records that match the conditions are displayed in the table.

e. To show all records again, click on the down arrow in the active cell and select
Clear Filter.

e Toreuse a filter:
a. Click the down arrow in the active cell.
b. Scroll through the list of recent filters; then select the desired filter.

c. Toshow all records again, click on the down arrow in the active cell and select
Clear Filter.
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System Options

System Options

The system options workspace allows you to configure RPM to maximize the system for
your company. System options allow you to customize various parameters, defaults, and
constants that are used throughout the system. Normally, these elements are set when
RPM is installed by the system or database administrator. They tend to remain fixed
unless a business practice is changed which necessitates a change in RPM. System
options are the values used in your system that define the overall configuration of the
system.

System Defaults

The System Defaults Edit workspace allows you to configure RPM to maximize the
system for your company. Select the values that should be should be initially displayed
when a user enters the workspace. This helps the user save time as they do not have to
select the appropriate value each time they complete a task. The values entered will
appear in other areas of the application.

Aggregation Levels

The Aggregation Level Settings workspace allows you to define system parameters that
vary for price strategies and price worksheet. When a department is created in the
merchandising system, Oracle Retail Price Management assigns the default value for
each parameter to the default or default level defined in the system. You may choose to
define the aggregation level at a different parameter than the default. When a price
strategy exists for a department, parameters are disabled and cannot be changed.

System Options Definitions

System Option Definition

Sales Calculation Method The method used by the merchandise extract program to
populate the Projected Sales column in the worksheet.

Multiple Item/Loc Promotions When selected, an item/location can exist on more than
one promotion (and more than one component within
the promotion).

Update Item Attributes When selected, the merchandise extract program should
update certain item attributes during each extract that
occurs during a worksheet review period.

Price Change/Promotion Overlaps When selected, indicates an item/location can have a
price change occur during the middle of an active
promotion.

Cost Calculation Method The way cost is determined for the zone. Choose Highest

Location Cost or Average Location Cost.

Clearance/Promotion Overlaps When selected, indicates an item/location can be on
clearance and promotion at the same time.
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System Option

Definition

Recognize WHs as Locations

Allow Complex Promotions

Open Zone Use

Exact Deal/Funded Promotion Dates

Purge Reset Clearance Months

Default Out of Stock Days

# of Days Reject Held

Default Reset Date

Promotion # Days Rejects Held

Price Change Processing Days

Promotion History Months

Ends in Digits for Zero Decimal
Currencies

Event ID Required

External Prices Allowed

18 Oracle Retail Price Management

When selected, indicates warehouses can be assigned to
regular and clearance price zones. They cannot be
assigned to promotion price zones.

When selected, indicates all promotion types are
available.

When selected, indicates a zone can be used across
different types of pricing, regardless of zone type.

When selected, indicates that the dates of a deal
associated with a vendor funded promotion must match
the promotion component dates exactly. When selected,
only deals with the same begin and end dates as the
promotion component being created will appear in the
deal

The number of months RPM will retain clearance price
events that have reset before purging them.

The number of days that should be added to an items
clearance effective date in order to calculate the Out of
Stock date. The default is applied to generate the out of
stock date when the clearance is first created.

The number of days after the effective date of a rejected
price change or clearance that it is purged from the
system.

When selected, indicates a reset date should be defaulted
when a clearance is created. The reset date is defaulted to
one day greater than the out of stock date.

The number of days, set in system options, after the end
date (or start date for promotions with no end date) of a
rejected promotion that it is purged from the system.

The number of days, set in system options, between the
creation date of a price change and the first date it can
become effective. It allows the retailer to insure that price
changes are created with enough advance timing that
stores and other process areas can react.

The number of months, set in system options, after a
promotion is completed that is purged. This parameter is
also used to purge cancelled promotions.

The number of digit fields, set in system options, that are
available in the Ends In definition area. This field is used
for currencies that do not contain a place after the
decimal point. For currencies that contain places after the
decimal point, the digit fields that are available.

When selected, a promotion event must be assigned to
the promotion.

When selected, RPM will accept pricing events created in
other systems.



System Options Definitions

System Option

Definition

Zone/Parent Ranging

Apply Promo Change Type 1st
Location Move Lead Time

Location Move Purge Days

Dynamic Area Differentials

Allow Buy Get Cycles

Display Promotion Header Markup
%

Background Conflict Check

Display Full Promotion Column
Detail

Display Full Price Change/Clearance
Column Detail

Future Retail Seed Days Before VDate

Filter Price Change/Clearance
Results

When selected, RPM should perform ranging checks for
price changes, promotions, and clearances that are
created at a higher level than transaction/location. If the
indicator is set to yes, the system will not let you create a
price change at the parent or zone level if none of the
transaction item/location combinations are ranged. If the
indicator is set to no, the system will let you create a price
change at the parent or zone level even if none of the
transaction item/location combinations are ranged.

Allows you to indicate, in system options, which type of
promotion change type should be applied first.

The number of days, set in system options, required
before a location can be moved between zones in RPM.

The number of days RPM will retain location moves that
have either successfully completed or are the same
number of days past the scheduled effective date but
have had no action taken on them.

When selected, allows the worksheet to dynamically
update secondary locations based on changes to the
primary location.

When Selected allows Buy Get Promotions to contain
multiple identical items to be in the buy and get lists. It
also allows items to be on the buy list of one promotion
and the get list of another. The Point Of Sale system used
must be able to manage cycles for this option to work as
intended.

When selected, the total markup percentage for the
promotion will appear on the promotion header.

When selected, conflict checking of worksheets, price
changes, promotions, and clearances occur in the
background, or when the system is idle.

When selected, only a portion of the columns in the table
are populated. If the user wants to review the details for
the remaining columns, the user can do so by selecting
rows and requesting the additional data.

When selected, only a portion of the columns in the table
are populated. If the user wants to review the details for
the remaining columns, the user can do so by selecting
row(s) and requesting the additional data.

The number of days, set in system options, required for a
newly ranged item/location that is inheriting an active
promotion.

Defines weather the Markup columns appear on Price
Change and Clearance windows. Having the system
calculate and display this field may slow performance.
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System Options Definitions

System Option

Definition

Display Conflicts Only

# Days event displayed before VDate

# Days event displayed after VDate

Maximum Search Results

When selected, only conflicts appear on the conflict
review screen. If cleared # Days event displayed before
VDate (effective date) and # Days event displayed after
VDate must be specified.

The number of days before an effective date (VDate) that
a pricing event appears in the conflict review window.

The number of days after an effective date (VDate) that a
pricing event appears in the conflict review window.

Limits the number of search rows returned:
e  Price Change record search max
e  (learance record search max

e  Promotions record search max

If the number of rows for the search criteria exceeds the
value entered in the new option(s), RPM returns records
only up to that established value.
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Edit System Options

Edit System

Options

Navigate: From Task Pad, select System Options > System Options Edit. The System
Options workspace opens.

%5 System Options

I@ Options

¥ sales Calculation Method
* Multiple Ttem/Loc Promotions
* Update Itern attributes
¥ Price Change/Promotion Overlaps
* Cost Caloulation Method
* Clearancef/Promotion Ouerlaps
& Recognize WHs as Locations
* allow Complex Pramotions
& Dpen Zone Use
Exact Deal f Funded Promotion Dates
* purge Reset Clearance Maonths
¥ Default Out of Stock Days
* # of Days Rejects Held
¥ Default Reset Date
* Pramotion # Days Rejects Held
* price Change Processing Days
* promotion History Manths
¥ Ends In Digits For Zero Decimal Currencies
* Event ID Required
External Pricas Allowad
Zone/Parent Ranging
Apply Prorne Change Type 1st
¥ Location Move Lead Time
* | acation Mave Purge Days

Dynamic Area Differentials

Loy By oot ol

lAuerage Location Cost lzl

rnount Off lz‘

E |

E |

b

Cancel Save

System Options Workspace

1.
2.

Update any enabled fields as necessary.

Click Save to commit any changes and close the workspace.
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View System Options

View System Options

Navigate: From Tasks, select System Options > System Options View. The System
Options View workspace opens.

(il
@ Optons
¥ ssles Calculation Methaod |Srn00thed Auerage SalesE
=
|
|
|
|
|
|
|
IArnount Off E
................. [z |
................. [z |
.................
allogy B = = Lyl

System Options View Workspace

Click Close to exit the workspace.
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System Defaults

System Defaults

System Defaults Definitions

System Default

Definition

Options

Item Level The level of an item in an item group. =  Parent Item
= Parent Item/Diff
*  Transaction Level
Item
Pricing Strategy The pricing strategy is the default strategy |=  Area Differential
type displayed for the user when entering |« Clearance
the Pricing Strategy workspace. - Competitive
* Margin
*  Maintain Margin
Diff Type The category that a diff belongs. Valid diff types from
the Merchandising
System.
Type The type is the default price change type = Change by
displayed when creating a price change. Amount
*  Change by Percent
=  Fixed Price
Currency The primary currency used in RPM. See LOV =l button on

System Default screen
for code and

Handling

constraints will be taken into account when
conflict checking is performed in the
worksheet.

description.
Maintain Margin Strategy | Defines the default method used when =  Market Basket
Method creating a maintain margin pricing strategy. Margin

=  Current Margin
Default Price Defines weather the Markup columns * Standard Column
Change/ Clearance List appear on Price Change and Clearance View
View windows. Having the system calculate and | . Markup Column

display this field may slow performance. View

Ignore Constraint Defines whether or not promotion Select/Clear checkbox
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Edit System Defaults

Navigate: From Task Pad, select System Options > System Defaults Edit. The System
Defaults Edit workspace opens.

@ Defaults

¥ Itern Level - celect -

|C|earance

|Co|or

|Change By Arnount

| E |US Callar

System Defaults Edit Workspace

1. Update enabled fields as necessary.
2. Click Save to commit any changes and close the workspace.

View System Defaults

Navigate: From Task Pad, select System Options > System Defaults View. The System
Defaults View workspace opens.

@ Dafaults

’f‘.}.t.ern Level "I’ransaction Level Iterm

* Pricing Strategy |C|earance

DlFF Type |Co|0r

’f‘“'.l}lpe |Change By Armount

* Curreney |L|SD | . |US Collar
Maintain Margin Strategy Method |- Selac -

ml‘:;efault Price Change/Clearance List View |Standard Calurmnn View

Ignare Constraints

System Defaults View Workspace

Click Close to exit the workspace.
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Aggregation Levels

Maintain Aggregation Level Settings

Navigate: From the Task Pad, select Aggregation Level > Maintain Aggregation Levels.
The Aggregation Level Settings workspace opens.

%9 Aggregation Level Settings

|@ Aggregation Level Settings |

I &%
10 Department Nan{ Lovrest Definablj Worksheet Leve| Historical Sales | Reqular Clearance Promotion Include WH Invd Include On order] Price Change Am|
22| DW working dept| Departmeant Departmeant Week Current-Hew Z
TTT7| Rerail Depr Departmant Departmant Week O | O | O Current-Hew
7778 Cost Dept Departmant Departmant Week O O O O O Current-Hew
3457 jap depr Subclass Subclass Week | | | O | Current-Hew
20| Merch Extract .| Departmeant Departmant Week O O O O O Current-Hew
1234| Glassuare Subclass Departmant Week O O O O O Current-Hew
7000| DOC Test Dept | Department Departmant Week O | | | O Current-Hew
7001| DOC Test Dep...| Class Clasz Week O O O O O Current-Hew
13| SLH Test Dep... | Department Departmant Week O O O | O Current-Hew
8004 *Women Appa.. | Department Departmant Week O O O O O Current-Hew
1104| *Test Depart.. | Department Departmant Week | | O | | Current-Hew
1704| *Candidate Ru...| Department Departmant Week O O O O O Current-Hew |
2000/ djm_dept1 Department Department Week | | | O | Current-Mew
77| *Dairy Departmant Departmant Week O O O O O Current-Hew
1111| *Grocery Mon ... | Department Departmeant Weak O O O O O Currant-Mew
2222| *Deli Departmeant Departmeant Weak O O O O O Current-MHew
£000| *Health&8 eauty | Department Departmeant Weak O O O O O Currant-MHew
£100| Genersl Merch... | Department Departmeant Weak O O O O O Current-MHew =

Cancel Done

Aggregation Level Settings workspace

1. Select the record you want to update.

2. Click in the field that you want to change.

Lowest Definable Level: Select the lowest level of the merchandise hierarchy for
which a price strategy can be defined.

Worksheet Level: Select the level of the merchandise hierarchy at which
worksheets will be generated.

Historical Sales: Select the sales period RPM should represent as historical on
the worksheet.

Regular: Select the check box to indicate that regular sales should be included as
part of historical sales in the price worksheet.

Clearance: Select the check box to indicate that clearance sales should be
included as part of historical sales in on the price worksheet.

Promotion: Select the check box to indicate that promotional sales should be
included as part of historical sales in on the price worksheet.

Include WH Inventory: Select the check box to indicate that warehouse
inventory should be included in the calculations for sell through and price
change impact in the price worksheet.

Include On Order In Sell Thru: Select the check box to indicate that inventory
ordered is included in the sell through calculations on the price worksheet.
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Price Change Amount Calc: Select the method of calculating the price change
amount on the price worksheet.

— New-Current: The current price is subtracted from the new price.
— Current-New: The new price is subtracted from the current price
Past Retail Change Highlight Days: Enter the number of days previous retail

changes will cause the Last Price Change column of the pricing worksheet to be
highlighted.

Past Cost Change Highlight Days: Enter the number of days previous cost
changes will cause the Last Cost Change column on the pricing worksheet.

Pending Cost Change Window Days: Enter the number of days into the future
the system should look for pending cost changes.

Pending Cost Change Highlight Days: Enter the number of days into the near
future the system should look for pending cost changes. The Pending Cost
Change column on the worksheet will be highlighted if a cost change falls within
the Pending Cost Change Highlight Days.

Note: Pending Cost Change Highlight Days must be less
than or equal to Pending Cost Change Window Days.

Click Done to save any changes and close the workspace.
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Retrieve an Item Price

Pricing

Use the Price Inquiry workspace to look up the price of an item for a selected date and
location. The following information appears in the Price Inquiry Results table:

Column Description

Item ID/Description The transaction or parent level items found based on the selected
criteria.

Diff ID The differentiators for the parent item if Parent Item/Diff type is
selected.

Location/Description The selected locations, zones, or zone groups depending on selected

Primary Zone

Date

Regular Retail

Regular Retail UOM
Regular Multi-Units
Regular Multi-Units Retail

Regular Multi-Units Retail
UOM

Clearance Retail
Clearance Retail UOM
Promotional Retail
Promotional Retail UOM

Complex Promotion

criteria.

Selected if the zone is within the primary zone group.

The selected date. The date the item/location price is valid far.
The regular price of the item/location for the specified date.
The unit of measure of the regular item/location.

The regular multi-units of the item/location.

The regular multi-unit price of the item/location.

The unit of measure of the regular item/location multi-unit.

The clearance price of the item/location for the specified date.
The unit of measure of the clearance item/location.

The promotional price of the item/location for the specified date.
The unit of measure of the promotional item/location.

Selected if the item/location is included on a complex promotion.

User Guide 27



Retrieve an Item Price

Regular retail and multi-unit prices are calculated as follows:

Location hierarchy  Transaction Level Item

Parent Iltem

Parent Item/Diff

Location Transaction level price at the

prices for all locations in the

location.

Zone Average of transaction level
zone.

Primary Zone Primary zone price.

Average of prices for all
transaction level items under
parent at the location.

Average of prices for all
transaction level items under
parent at all the locations in
the zone.

Average of prices for all
transaction level items under
parent in the primary zone.

Note: "Price" refers to Regular Retail or Regular Multi-Units Retail.

Average of prices for all
transaction level items under
parent/ diff at the location.

Average of prices for all
transaction level item sunder
parent/ diff at the locations in
the zone.

Average of prices for all
transaction level items under
parent/diff in the primary
zone.

Clearance and promotion prices are calculated as follows:

Location hierarchy  Transaction Level Item

Parent Iltem

Parent Item/Diff

Location Transaction level price at the
location.

Zone Average of transaction level
prices for all locations in the

zone.

Average of prices for all
transaction level items under
parent at the location.

Average of prices for all
transaction level items under
parent at all the locations in
the zone.

Note: "Price" refers to Clearance Retail or Promotional Retail.

Average of prices for all
transaction level items under
parent/ diff at the location.

Average of prices for all
transaction level item sunder
parent/ diff at the locations in
the zone.
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Retrieve an Item Price

Retrieve an Item Price

Navigate: From Task Pad, select Price Inquiry > Retrieve Item Price. The Price Inquiry
workspace opens.

B3 price Inquiry

I@ Price Inquiry | :I
Filter
B8 B
E E N — 1
Itermn Type |Item lzl * Date
Ttern Level |Transaction Level [tern lzl
N —
|
Clear | | Fetrieve Price |
Price Inquiry Results || &
Item ID Item Descrip§ Diff ID Location Location Desq Primary Zone | Date Regular Retai| Regular WOM | Regular Multi
| Filker by:lzl | Filtar by.‘lzl | Filker by:lzl | Filtar by.‘lzl | Filker by:lzl | Filter by.‘lzl | Filker by:lzl | Filter by.‘lzl | Filker by:lzl | Filtar by.‘lzl
-

Price Inquiry workspace

1.

Note: RPM supports International Organization for
Standardization (ISO) currency code only.

Enter criteria as necessary to restrict the search to the price changes you want to
maintain.
Field Criteria

Merchandise Level  Select criteria in the following fields to search for prices in a specific
merchandise level:

Department

Class

Subclass

Item Type

Item Level

Diff Type

Item
Diff
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Field

Criteria

Zone/Location

Date

Select Zone Groups, Zones, and Locations to search for prices from
specific zones or locations.

Select the date you need to retrieve a price for.

2. Click Retrieve Price. Your results appear in the Price Inquiry Results table.

Price Inquiry Results || &
Ttem ID Diff ID Location Location Desq Primary Zone| Date Regular Retai| Regular UOM | Regular Multi| Regular Mu

| Filker by |z| | Flilker by:lzl | Filter by:lzl | Filter by.‘lzl | Fifter by.'lzl | Fifter by.‘lzl | Fllker by.‘lzl | Filker by:lzl | Filker by |z| | Flilker by:l:
2444 g Z1 D 08f10/2005 $200.00| EA z
100256126 =l Z1 D 08/10/2005 $6.88| EA

1001324196 =l Z1 D 08/10/2005 $220.00% EA

100134145 =l Z1 D 08/10/2005 $108.80% EA

100256142 =l Z1 D 08/10/2005 $6.88| EA

1001324161 g Z1 D 08/10/2005 $200.00| EA

100134170 2 21 I:‘ 0g/10/2005 $200.00| EA

100256011 g 21 I:‘ 081 0/2005 $6.88| EA

10013241532 g Z1 D 08/10/2005 $200.00| EA

1001241828 =l Z1 D 08/10/2005 $200.00| EA _
1001324209 =l Z1 D 08/10/2005 $248.00% EA

1001324137 =l Z1 D 08/10/2005 +200.00| EA

100256029 =l Z1 D 08/10/2005 $6.88| EA

1001324250 g Z1 D 08/10/2005 $1,000.00( EA

100256020 g 21 I:‘ 081 0/2005 $5.85 EA

100134233 2 Z1 I:‘ 0&/10/2005 f$19z.80% EA

100134129 g 21 I:‘ 08/10/20035 $200.00| EA

100256193 =l Z1 D 08/10/2005 $6.88| EA

100256062 =l Z1 D 08/10/2005 $6.88| EA -
4 I ElD

Price Inquiry Results table
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Export Price Inquiry Results

1. Select the row you want to export by clicking the box :I to the left of the row. Press
and hold the Ctrl key while selecting to select multiple rows.

2. Click the Export .'B button. The Save window opens.
Save E|
Save In: |B Termp lzl E

3 wards.0 [J {cASE2ETE-1BE7-1108-906A-00010240CESS)H

C3 {00761b06-803d-11d4-9790-00c04fEeeb3) |E[RTENEIEEbEE NS

i} {46891FF3-F43A-4AEE-B3F2-SC3FD4CC4RS1}
[ {e2249B6E-E714-11D7-52E5-0050DAZ1TSTE}
[ {7145F0A8-65813-11D6-AF7B-00B0DO142030}
[3 {aSbal4e0-7384-11d4-bae7?-00409631a2cE}
[3 {a=2823100-1481-11d4-9731-00c04f8ecb39}
3 {abda%912-5d00-11d4-bae7?-9367cals 7955}

4 [»

File Harme: IterruF'r'i-:Ell}‘:E: su |

Files of Tepe: |*.cs-.l lz‘

Save || Cancel |

Save Window

Select a location to save the file to from the Save In drop-down.
Enter a name for the file in the File Name field.
Click Save. The file is saved.

Open the file in the program of your choice such as a spreadsheet or word processor.

I e
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Price Guides

A price guide allows you to create a uniform price strategy. You can use them to
maintain consistent price points. You can determine if the prices in a guide should be
rounded in the same manner or if they should all end in the same digits.

Price guides can be set up at the corporate level or at the department level. A corporate
level price guide is created and maintained at the corporate level, but can be referenced
by many departments. If any changes are made to a corporate price guide, all
departments that are linked to the corporate guide will reflect the updated changes. A
department-level price guide is created and maintained at the department level.

After price guides are defined, they can be used when setting up pricing strategies, price
changes, clearances, and promotions. Price guides are also used when creating the
primary zone group for a merchandise level. When a price guide is attached to a primary
zone group definition, it will be applied to the initial prices proposed by RPM during the
initial price setting process in RMS (if the proposed price falls within one of the defined
intervals on the guide).

Create a Price Guide

Navigate: From the Task Pad, select Price Guides > Create Price Guide. The Create Price
Guide workspace opens.

%3 create Price Guide

I'(—“ Price Guide Create

Price Buide Type [cerporate =

* Currenc, . [usp |8 us pallar

Add Details |

Create Price Guide Workspace

In the Price Guide Type field, select the type of price guide you are creating.
In the Name field, enter the name of the price guide.

In the Description field, enter a description of the price guide.

In the Department field, enter the ID of the department, or click the LOV = button
and select a department.

p 0D PF

Note: This field is available only if you selected Department
in the Price Guide Type field.

5. In the Currency field, select the currency for the price guide.
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Click Add Details. The Price Guide Details Create pane opens.

I‘F Price Guide Details Create

| & Start Price:

From T ers Rt [tz L]

5.00| 543 s.00[g&] [ncrement

5.50] 5.99) 5.50) Mew Retail Based On: [ salact -

£.00] £.43] £.00] Autofill

£.50) £.95) £.50]

7.00| .49 7.00|

750 7.99| 7,50

2.00| 2.49 2.00|

250 8,99 2,50

2,50 2,99| 2,50

10,00 10,45 10,00

10,50 10,99 10,50 w|

From: I:l To: I:l Mew Retail: I:l Add Mew Retail Ends In: l:“:l
‘ ] pelete mntervals ‘ validste Tntarvsls ‘

Price Guide Details Create Pane

Add Price Intervals Individually

1.
2.

3.
4.

In the From field, enter the low price of the interval.
In the To field, enter the high price of the interval.

Note: The value in the From field must be lower than the
value in the To field.

In the New Retail field, enter the price that all values in the interval adjust to.
Click Add. The information is added to the table.

Add Multiple Price Intervals

1.

2
3.
4

In the Start Price field, enter the low price of the block of intervals.
In the End Price field, enter the high price of the block of intervals.
In the Increment field, enter the amount each interval should increase by.

In the New Retail Based On field, select how the new retail price should be

determined:

=  From Price: The new price will be set to the same value as the value in the From
column on the list of intervals.

= To Price: The new price will be set to the same value as the value in the To
column on the list of intervals.

= Average Price: The new retail will be set to the average value of values in the
From and To columns on the list of intervals.

Click Autofill. The information is added to the table.

Note: If the End Price is not divisible by the value in the
Increment field, RPM will suggest the last valid price in the
range. Click Yes to accept the price and continue, or No to
cancel the process.
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Define Ends in Values
1. Select the intervals you want to add an ends in value.

2. Inthe New Retail Ends In field, enter the digits the price ends in.

Note: The number of fields available are determined at
system set up. If your currency uses decimals the number of
fields corresponds to the number of decimals used in the
currency. If you currency does not use decimals, the number
of digits is determined at system set up.

3. Click Apply. The New Retail field on the selected intervals in the table is updated
with the Ends In Digits specified by the user.

Complete the Price Guide

Click Done to save any changes and close the workspace.

Copy a Price Guide

Navigate: From the Task Pad, select Price Guides > Copy Price Guide. The Copy Price
Guide workspace opens.

%3 Copy Price Guide

(@ Pricing Guides Origin

(@) Corporate Pricing Guides

() Department Pricing Guides %

I@ Pricing Guides Dastination

(@) Corparste Pricing Guides

() Department Pricing Guides %

I(_’J Create Copy Price Guide |

Guides lle?
Guide Type ‘ Name Description | Dept. | Currency Linked ‘
Ftrer by = [Fitter by ‘
Corparate Jodi's 2nd copy Jodi's 2nd copy uso =
Corparare HL-corparate HL-carparate uso

Carparate fas fas uso

Corporate SLH guide test guide uso

Carparate W Carp Guide Prices 5o low we call it crazy uso ||
Corporate corin's corporate hi uso =

cancel |[_save +Repeat |[_Done |

Copy Price Guide Workspace

1. In the Price Guides Origin pane, select the price guide type of the price guide you are
copying.
= If you select Department Pricing Guides, enter the department ID in the field to
the right, or click the LOV = button and select a department.

Note: Price guides that match the criteria entered appear in
the Create Copy Price Guide container.

2. In the Price Guides Destination pane, select the price guide type of the price guide
you are creating.

= If you select Department Pricing Guides, enter the department ID in the field to
the right, or click the LOV & button and select a department.

3. In the Create Copy Price Guide container, select the price guide you want to copy.
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4. Click Copy. The Pricing Guide Copy Details pane opens.

I@ Pricing Guide Copy Details

* Marne | |
* .
Description | | @
*
Currency UsD B |us pollar
" ? Start Price:
-
- Ernd Price:
From To New Retail
1.00 5.00 4,99 ool

Frarm: Ta Maw Retail: I:I
. Delate Intarvals |

Pricing Guide Copy Details Pane

Walidate Intervals |

5. Maintain the price guide as necessary.

6. Click Done to save any changes and close the workspace.

Link a Price Guide

* New Retail Basaed On:

Add Mew Retail Ends In:

T

Navigate: From the Task Pad, select Price Guides > Link Price Guide. The Link Price

Guide workspace opens.

%3 Link Price Guide

(f:‘ Department To Link

Departrnent 7000 BH+00oc Test Dept
(@ Price Guides List |
Guides e
Name Description Cunency Linked
ot B @ et B = usp x
HL-corparate HL-corporate UsD x
fon fan UsD
SLH guide rest guide usp
corin's corporate | hi usp 7]
Jodi's Corp Price G... | Jadi's Carparate Pr...| USD | 7]

Cancel _|[_save + Repeat |[_Done |

Link Price Guide Workspace
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1. Inthe Department field, enter the ID of the department you want to link to a
corporate price guide.

2. In the Price Guides List container, select the corporate price guide you want to link

to.

3. Click Link. A red X appears in the Linked column, indicating the corporate price
guide has been linked.

4. Click Done to save any changes close the workspace.

Maintain a Price Guide

Navigate: From the Task Pad select, Price Guides > Maintain Price Guide. The Price
Guides Maintenance workspace opens.

%3 Price Guides Maintenance

I/(J Pricing Guides List

Guides

12 |
Guide Type | Mame Description Dept. ‘ Currency Linked |
Fiter by =1 Filber by =] |
Department Corin's Rockin PG Sweetness 001 - *Meat usp 3
Department Huh? what? 1704 - *Candidate Rules Dep | USD
Drepartment PG for PC & Clear Testing PG for BT & Clear Testing 1704 - *Candidate Rules Dep | USE
Department BG Diff cur (AUD) ALD 1704 - *Candidate Rules Dep | ALUD
Corporate Jodi's 2nd copy Jodi's znd copy usD ]
X -
Cosime Jlea |

cancel |[_save +Repeat |[_pone |

Price Guides Maintenance Workspace

1. Select the price guide you want to edit.

Note: Linked department price guides cannot be

edited. They can only be viewed. The details of a linked

department price guide are owned at the corporate level, so

changes must be made to the corporate price guide.

2. Click Edit. The Price Guide Maintenance Details pane opens.
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(@ Price Guide Maintenance Details

.
Hame f1= o \

*
Description |;'Est|e deseription ¢a ‘@

Il

To

Newr Retail

100,00

104,99

100.00f

105,00

109,99

105,00}

110,00

114,99

110,00f

115.00

120,00

125,00

119,99

129,99

115.00f

125,00}

130,00

134,99

130,00

135,00

139,99

135.00f

140,00

144,99

140.00f

145,00

149,99

145.00f

Start Price:
End Price:
Increment:

Mew Retail Based On:

B

L 1
L1
L 1

T
Autofill

Fram: l:l To: l:l Hew Ratail: l:l Mew Retail Ends In: l:”:l Apply

‘ €] oelete 1ntenals | B validate 1ntervals ‘

Price Guide Maintenance Details Pane

Edit the enabled fields as necessary.

Update the intervals as necessary.

* Add price intervals individually.

= Add multiple price intervals.

= Define the ends in price.
5. To delete an interval:

a. Select the intervals you want to delete.

b. Click Delete Intervals. The intervals are removed from the table.
6. To verify the intervals are sequential:

a. Click Verify Intervals. If non-sequential intervals exist, an error message
appears.

b. Click OK. The non-sequential values are highlighted in red.
c. Correct the intervals as necessary.

= Add price intervals individually.

= Delete an interval.

7. Click Done to save any changes and close the workspace.

Candidate Rules

The pricing office of your organization determines the optimum strategies for using RPM
in your business. After these strategies are decided, you can define the candidate rules
and set up the following parameters:

e Candidate rules
e Variables for candidate rules

You use candidate rules to search the database for items that need to be highlighted for
pricing review. Candidate rules determine which item/locations will have retail prices
proposed in clearance worksheets. In other types of worksheets they provide a way to
identify and track specific items during the worksheet review process.

Candidate rules are defined at the corporate level. You can modify any of the candidate
rule parameters. Some rules have variable values. These values are assigned and can be
modified at the department level.
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Note: Rules that have variables defined are run only against
items in Departments where a value has been assigned to the
variable. If there is no variable value for a Department, the
candidate rule will not run against items from that
Department.

There are two types of candidate rules: Inclusion and Exclusion. Exclusion rules are
always run first and identify items that will not be included in the worksheet review.
Inclusion rules can contain a variable for Department level differences in the value to be
searched against. Items that meet an inclusion candidate rule are flagged on the
worksheet. Items that meet an exclusion candidate rule do not appear on the worksheet.

Note: Candidate rules are run against the worksheet when it
is first created. They are not run again if the worksheet is
updated.

Set Up a Candidate Rule and Define a Variable for the Rule

Navigate: From the Task Pad, select Candidate Rules > Create Candidate Rules. The
Create Candidate Rule workspace opens.

9 create candidate Rule

IP Create Candidate Rule
rCandidate Rule Maintenance
* Narne || |
Description | |@
Type -é- Inclusion
( : ) Exclusian
Status () Inactive
() Active
rCondition Definition
Field COperatar Wariable Walue
i I R R —
rConditions
Cancel || Save + Repeat || Done I

Create Candidate Rule Workspace

1. In the Name field, enter the name of the candidate rule.

2. In the Description field, enter a description of the candidate rule. This description can
be up to 250 characters.

3. Inthe Type, select the kind of candidate rule that you are creating.
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4. In the Status field, select the active status of the rule. Only active rules are run during
a review period.

In the Field column, select the field to which the candidate rule is applied.

In the Operator field, select the relationship that the Field item has to the Value or
Variable Name.

Note: All options may not be available for some field types.

Operator Relationship

= Equal to

< Less Than

> Greater Than

<= Less than or equal to

>= Greater than or equal to
Not equal to

7. In the Value field, enter the ID of value or click the LOV &l button and select a value.

Note: If you enter a Value, the rule runs against all
Departments that use this value in the rule. If you enter a
Variable, you can assign the value of the Variable by
Department.

Assign a Variable Value
1. Select the Variable check box.

2. If the Variable is a new variable, select the New check box.

3. In the Value field, enter the name if it is a new variable or click the LOV El button
and select an existing variable.

Complete the Candidate Rule
1. Enter additional conditions as necessary.

2. Click Add. The condition opens in the conditions area.

Note: A single rule can have multiple conditions. If multiple
conditions exist for a rule, an item must meet all of the
conditions in order for the rule to be met.

3. Click Done to save any changes and close the window.
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Maintain Rule Variables by Variable or by Department

Navigate: From the Task Pad, select Candidate Rules > Maintain Rule Variables. The
Rule Variable Maintenance workspace opens.

%3 Rule Yariable Maintenance

I(:' Rule ¥ariable Maintenance

Mathod by varzbe 5]
Rule Variable Maintenance By ¥ariable " d
Department | Description Yariable ¥alue |

Cancel || Save + Repeat || Cone I

Rule Variable Maintenance Workspace

1. Inthe Method field, select how you want to update the rule variables

2. Inthe Variable/Department field, select the value you want to use to update the rule
variable.

3. Inthe Variable Value field, enter the value to be associated with the variable when
the rule is run against items in the department.

4. To update the values for multiple departments:
a. Multi-select the departments you want to update

b. In the Value field below the Rule Variable Maintenance By Variable table, enter
the value to be associated with the variable when the rule is run against items in
the department.

c. Click Apply.
5. Click Done to save any changes and close the workspace.

Delete a Candidate Rule Variable

Note: If the variable is attached to a candidate rule, you must
delete the candidate rule before you can delete the variable.
To delete the candidate rule, see the Delete a candidate rule
procedure.

40 Oracle Retail Price Management



Candidate Rules

1. Inthe Department field, enter the Department number or click &l (LOV) and select
from the list of values.

2. Click View. A list of the defined variables with their assigned values appears.
Select the radio button for the candidate rule variable that you want to remove.

4. C(lick Delete. A message appears, “This variable will be deleted for all Departments.
Do you want to continue?”

5. Click OK. The variable is removed from the list.

Note: To leave the window without making changes, click
Cancel.

Update a Candidate Rule Variable

Note: Rules that have variables defined are run only against
items in Departments where a value has been assigned to the
variable. If there is no variable value for a Department, the
candidate rule will not run against items from that
Department.

1. Inthe Department field, enter the Department number or click &1 (LOV) and select
from the list of values.

2. Click View. A list of the defined variables with their assigned values appear.

Note: To apply the same variable to more than one
Department, select the desired Departments from the list.
For more information on selecting multiple items from a list,
see the Select multiple options from a list procedure.

3. Inthe Value field for the candidate rule variable that you want to edit, enter the
appropriate value.

4. C(Click Save. The information is saved.

Note: To leave the window without making changes, click
Cancel.
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Maintain a Candidate Rule

Navigate: From the Task Pad, select Candidate Rules > Maintain Candidate Rules. The
Maintain Candidate Rules workspace opens.

5 Maintain Candidate Rules

|'@ |
candidate Rule List |
Name Text ¥ariable Type Status |
SLL Second Retest test Projected Sales < [FU... @ Inclusion Active Z
SLL Retest 4198 Candida...[Sell Through = 0.2: .., @ Inclusion Active
Test Candidate Rules Department = 1818 Clas... Inclusion Active
Dept 2 Department = 2 Inclusion Active
Test2 Season Code = Sprin... @ Inclusion Active
Tast 3 Market Basket Code = 00.., Incluzion Active -
Dept 1704 Departrient = 1704 Inclusion Active ]

Cancel Il Save + Repeat Il Done I

Maintain Candidate Rules Workspace

1. Select the candidate rule you want to change.

2. Click Edit. The Candidate Rule Maintenance workspace opens with information
about the selected candidate rule.

3. Change information in any of the fields, as necessary.

Note: See the “Set up a candidate” rule and define a variable
for the rule procedure for additional information.

4. If you want to use the value as a variable:
a. Check the box in front of Use value as variable.
b. Enter or Click & (LOV) to display a list of existing values.
c. Select an appropriate value from the list.

5. If you want to edit only the Condition portion of a rule:

Note: To add a new Condition to a rule without changing
any existing Conditions, follow steps c-d below.

a. Inthe Conditions box, select the Condition that you want to change.

b. Click Edit. The components of the selected condition display in the Field,
Operator, and Values or Variable Name fields.
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c. Enter the appropriate information in the Field, Operator, and Values or Variable
Name fields.

d. Add to substitute the new or updated condition:

— Toinclude the new or updated Condition without removing the existing
Condition, click Add.

— To substitute the existing Condition with the one you just created or edited,
click Replace.

6. To return to the Candidate Rules window, click Cancel. All information that you did
not save in the Candidate Rule Maintenance window is lost.

7. To delete a condition, select the condition in the Conditions box.
Click Delete. The condition is removed.

To apply all of the changes that you made in this window, click Save. You are
returned to the Candidate Rules window.
Delete a Candidate Rule

Navigate: From the Task Pad, select Candidate Rules > Maintain Candidate Rules. The
Maintain Candidate Rules workspace opens with all of the current candidate rules listed.

B5 Maintain Candidate Rules

|'@ |
tandidate Rule List |l
Name Text Yariable Type Status |
SLL Second Retest test Projected Sales < [FU.., @ Inclusion Active Z
SLL Retest 4198 Candida,., [Sell Through = 0.2;: T, @ Inclusion Active
Test Candidate Rules Department = 1518 Clas.. Inclusion Active
Dept 2 Department = 2 Inclusion Active
Test 2 Season Code = Sprin.., @ Inclusion Active
Test 2 Market Basket Code = 00, Inclusion Active -
Dept 1704 Department = 1704 Inclusion Active -

Cancel || Save + Repaat || Crone

Maintain Candidate Rules Workspace

1. Select the candidate rule you want to delete.

2. Click Delete. A message appears, “Are you sure you want to delete the selected
rule?”

3. (Click OK to delete the rule. The rule is removed from the list.
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Note: Variables are not deleted if you delete a rule that has a
condition with variables and values assigned at the
Department level. This feature allows you to use the
existing variables and assigned values when you create a
new rule. To delete the variables, see the Delete a candidate
rule variable procedure.

Zone Structures

Zone structures allow you to group locations that are priced the same. Additionally, you
identify the types of pricing the zone is used for; Regular, Promotional, or Clearance.
There are several components that you need to define in order to use zone structures.

Zone Groups

Zone groups are a collection of zones. You can define multiple zone groups that are
suited to your business. After you define the zone group, you can define the zones in the
zone group. A location (store or warehouse) can only exist once in a given zone group.
Multiple currencies may exist within a zone group.

Zones

A zone is a group of locations that are priced the same within a zone group. Locations
within a zone must have the same currency. Not all locations must be assigned to a zone.

Primary Zone Groups

The primary zone group is used to determine how items are initially priced in the
merchandising system. When you create a primary zone group, you identify the
merchandise hierarchy level, the zone group, the markup percent, the markup type, and
the price guide. The merchandise hierarchy assigned to a new item in merchandising
system will determine the primary zone group definition in RPM used to initially price
the item. Based on the information associated with the primary zone group and the cost
of the item, as entered in the merchandising system, prices will be proposed.
Additionally, price changes that are created against a zone in the primary zone group are
stored at the zone level. These price changes can be displayed in the Price Inquiry
window.
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Create a Zone Group

Navigate: From the Task Pad, select Zone Structure > Create Zone Group. The Create
Zone Group workspace opens.

B9 Create Zone Group

I(—“ Create Zone Group

Zone Group 1D Zane Group Hame Type Like Group

S | =

Zone ID ‘ Name | Currency Location Count Base ‘

Save || Locations || Delete \|

cancel || Saue + Repeat |[ pore |

Create Zone Group Workspace

1. Inthe Zone Group ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone Group ID field appears with the next
available number. If you choose to update the field, you
must choose a unique ID.

In the Zone Group Name field, enter a description of the zone group.

3. Inthe Type field, enter the type of pricing this zone group is used for, or click the
LOV El button and select a type.

4. Click Next. Your zone group is created.

Add Zones to a Zone Group
1. Inthe Zone ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone ID field appears with the next available
number. If you choose to update the field, you must choose a
unique ID.

2. Inthe Zone Name field, enter a description of the zone.

3. In the Currency field, enter the currency for the zone, or click the LOV £l button and
select a currency.

Click Apply. Your zone is added to the table.
Add the appropriate number of zones for your zone group.
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Add Locations to a Zone
1. Select a zone.

2. (Click Locations. The Price Zone - Location Assignment pane opens.

(=) Price Zone - Location Assignment

Location ‘ Name | Location Type New Zone New Zone Name Effective Date Status

e |

Price Zone — Location Assignment Pane

In the first field, select the type of location you want to add to the zone.
4. In the Value field, enter the ID of the location or location group, or click the LOV
button and select a location or location group.
Click Apply to add the location or location group to the list of locations.
Click Save to commit any changes.

7. Click Done to save any changes and close the workspace.

Copy an Existing Zone Group
1. Inthe Zone Group ID field, edit the generated Zone Group ID field as necessary.

Note: The Zone Group ID field appears with the next
available number. If you choose to update the field, you
must choose a unique ID.

In the Zone Group Name field, enter a description of the zone group.
In the Type field, enter the pricing strategy that the zone group will use, or click the
LOV =l button and select a type.
4. Select the Like Group check box.
Click Next. The Like Group container opens.

6. Enter the ID of the zone group that you want to copy, or click the LOV El button and
select a group.

7. Click Done to save any changes and close the workspace.

Note: To edit the newly created Zone Group, see the
"Maintain a Zone Group" procedure.
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Maintain a Zone Group

Navigate: From the Task Pad, select Zone Structure > Maintain Zone Group. The
Maintain Zone Group workspace opens.

%5 Maintain Zone Group

I@ Price Zone Group List

—

Currency

=]
[ —

I

Zone Group 1D Name Type Location Count |
119( DWW currency Ragular =

130[SLH Regular 3

131|DW USD Regular 3

184 Jodi's 1221 28 Reqular 3

19%9( 2G-0009 Clearance; Requlan Promation 2

393| 1221 Warehouses Reaqular 3
402| corin test Reqular 15

Gancel Save + Repeat || Done

Maintain Zone Group Workspace

1. Filter for the records as necessary:

a. In the Location, Currency, and Type fields, enter the criteria you want to filter
for.

b. Click the filter button. Zone groups that match your criteria appear in the
table below.

Note: Click the clear filter button to remove the filter
criteria. All zone groups appear in the table below.

2. To delete a zone group:
a. Select a zone group.

b. Click Delete. The zone group, zones, and locations are removed.

Edit Zones
1. Select a zone group.

2. Click Edit. The Maintain Zone Group pane opens.

((—W Maintain Zone Group

Zone Group ID Zone Graup Name Type

T m
Zone ID Zone Nams Currancy
e ] 7 ) B
(4
Zone ID | Name ‘ Currency ‘ Location Count | Base
533‘ FRANC Al |CAD | D‘ :
331‘ a1 |LISD | 2‘ (@)

‘ save  |[ Locations |[  Delete \‘

Maintain Zone Group Pane
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3. After the Zone has been added to the Zone Group the currency cannot be changed.
The zone with the incorrect currency can be deleted and then re-created with the
correct currency.

Note: If there are no locations in the zone the currency field
is editable. If locations exist in the zone than the currency
field is NOT editable.

4. Add zones to the zone group.
To delete a zone:
a. Select a zone.

b. Click Delete. The zone is removed from the list of zones.

Note: You must first delete all locations from the zone before
you can delete it.

Edit Locations
1. Select a zone.

2. Click Locations. The Price Zone - Location Assignment pane opens.

/(=) Price Zone - Location Assignment

Tupe [stare =]
Location ‘ Name | Location Type New Zone New Zone Name Effective Date Status

Price Zone - Locations Assignment Pane

3. Add locations to the zone.

Note: When you add a location to a zone that was previously
saved, a location move is scheduled. Go to the "Maintain
Location Move" procedure to view the location move.

4. To delete a location from a zone.
a. Select a location.

b. Click Delete. The location is removed from the list of locations.

Note: When you delete a location from a zone a location
move is scheduled. Go to the "Maintain Location Move"
procedure to view the location move.

Complete the Zone Edits
Click Done to save any changes close the workspace.
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Create a Primary Zone Group

Navigate: From the Task Pad, select Zone Structure > Maintain Primary Zone Group. The
Maintain Primary Zone Group workspace opens.

B3 Maintain Primary Zone Group
If_’—_ﬁ Zone Retail Definition List | =
Zone Retail Definition List
Dept. Dept Description | Class Class Description | Subclass Subclass Descripti| Regular Price Zond Regular Price Zond Initial Price Setti
22 Dl working dept 12 HL-reqular 2096 Retail Markup
1 Corin's Departm.., 1z Corin's 2G 509| Retail Markup
1221 Kitchenware 12 HL-regular 100%| Retail Markup
7000 DOC Test Dept 402 |corin test 509 Retail Markup
4567 Waomens shoes 1z HL-reqular 196 Retail Markup
TOO1 DOC Test Dept. 2 121 DWW USD 259 Retail Markup =
pelete | Edit |[ add ||_
=
cancel |[_save +Repeat |[_Done |
Maintain Primary Zone Group Workspace
1. Click Add. The Zone Retail Definition Maintenance pane opens.
(@ zone Retail Definition Maintenance
Merchandise Leusl Regular Price Zane Group
toeperment [ @+
8 tneaew [ 18
Initial Price Settings
Markup % l:l (® Retail Markup () Cost Markup
| [

Zone Retail Definition Maintenance Pane

2.

In the Department field, enter the ID of the department, or click the LOV % button
and select a department.

In the Class field, enter the ID of the class, or click the LOV % button and select a
class.

In the Subclass field, enter the ID of the subclass, or click the LOV % button and
select a subclass.

Note: You must select the merchandise hierarchy levels
above class and subclass before you can identify class and
subclass. Class and subclass are not required. You can define
a primary zone group at the Department level.

In the Zone Group field, enter the ID of the zone group you want to associate with

the selected merchandise hierarchy level, or click the LOV % button and select a
zone group.

Note: Regular price zone groups are the only type of zone
groups that can be attached to a primary zone group.
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6. In the Initial Price Settings container:
a. Inthe Markup % field, enter the percent of markup that is applied to the cost of
the item.
b. Select either Retail Markup or Cost Markup to indicate how the markup is
calculated.
7. To add a price guide, click Price Guides. The Price Guide Definition window opens.

-,

(Price Gutae Derimition
Zone Currency Price Guide
EUR | | =
kD | | =
USD | | =]
| cancal || ok |

Price Guide Definition Window

8. For each currency, enter a price guide ID, or click the LOV &l button and select a
price guide.

Note: Only price guides that are associated with the
department selected in the Zone Retail Definition
Maintenance container appear. For each currency, you can
select a price guide, if a price guide has been set up for the
currency and department.

9. Click OK to save any changes and close the window.
10. Click Apply to add your changes to the table.
11. Click Done to save any changes and close the workspace.
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Maintain a Primary Zone Group

Navigate: From the Zone Structure menu, select Maintain Primary Zone Groups. The
Maintain Primary Zone Group workspace opens.

B3 Maintain Primary Zone Group
a
(& zone Retail Definition List |—|
Zone Retail Definition List (1”4
Dept. Dept Description | Class Class Description | Subclass Subclass Descripti{ Reqular Price Zond Regular Price Zond Initial Price Setti Markup Type
22 D working dept 12 HL-regular 20%| Retsil Markup
1 Corin's Departm... 12 Corin's 26 50%| Retail Markup
1221 Kitchenuare 12 HL-regular 100%)| Retail Markup
7000 DOC Test Dept 402 corin test 508 Retail Markup
4567 Wamens shaes 12 HL-regular 15| Retail Markup
7001 DOC Tast Dapt. 2 131 D USD: 25%| Retail Markup [
pelete | Edit |[ add ||_
+]
cancel || save + Repeat |[ pore |

Maintain Primary Zone Group Workspace

1. Click Edit. The Zone Retail Definition Maintenance pane opens.

I@ Zone Retail Definition Maintenance

Merchandise Lavel Requlsr Price Zone Group

Subclass B+

Initial Price Settings

Markup % l:l (® Retail Markup () Cost Markup

| G|
Zone Retail Definition Maintenance Pane

2. Edit the enabled fields as necessary.
3. Click Apply.

4. Click Done to save any changes and close the workspace.

Delete a Primary Zone Group
1. Select a primary zone group.
2. Click Delete. Your changes are removed from the table.

3. Click Done to save any changes and close the workspace.
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Codes

The foundation area allows you to maintain reason codes and link codes. Reason codes
are used to explain the rationale for clearances and price changes. Link codes are used to
associate items to each other at a location and price them exactly the same.

Link Codes

The maintain link codes area allows you to assign link codes to a transaction level
item/location. The items can be associated to the code through the merchandise
hierarchy, at the item level, or through item attributes such as diff or diff type. Locations
can be associated to the code through the zone group or zone or by entering the location
directly.

Market Basket Codes

The maintain market basket codes area allows you to assign market baskets codes to an
item/zone. The items can be associated to the code through the merchandise hierarchy,
at the item level, or through item attributes such as diff or diff type.

Create a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code
Maintenance workspace opens.

I'@ Code Maintenance |

Code Maintenance " &
Type Code Description 5IM |
Link Code il biea o]
Reqular Price T £ ':'

Link Cade Code Lala

Regular Price Reglodeteaw newlesc

Link Code Link 12 m

Link Code Sh-1704 Single Dept LT

Link Code M-Crept Multi Dept-1704-1234-1221

Link Code Parent-LC Parent Link Code

Link Code MZ-50 Multiple Zone

Link Code LT for WH Link Code for WH testing

Link Code Crrop It only On the left side L
Link Code Hodi Zone Hodi Zone

Feqular Price Code3333 Farmland Milk (O}

Reqular Price Code 456 Andy Dufresne ':'

Link Code Fizza Code used for all frozen pizzas

Link Code lhat If Link Code for What If stories

Feqular Price Code 2 Alli Code )

Clearance Price Code Clear Surnrer Everything Clearance ':'

Clearance Price Code Blue Code Blue Sala??? ':' p—

new [ osiete ||

Code Maintenance Workspace
1. Click New. The next line on the table is enabled.
In the Type field, select the type of code you are creating.

In the Code field, enter a unique identifier for the code.

P 0N

In the Description field, enter a description of the code.
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Edit a Code

5. In the SIM field, select the radio button to indicate that the reason code is used

exclusively by Store Inventory Management (SIM).

Note: Only one reason code for price changes and clearances

can be assigned as a SIM reason code.

6. Click Done to save any changes and close the workspace.

Navigate: From the Task Pad, select Foundation > Code Maintenance. The Code

Maintenance workspace opens.

I@ Code Maintenance

Code Maintenance " &
Type Code Description SIM |
Link Code s lges ]
Regular Price E ET=

Link Code Code Lala

Reqular Price ReqTodeMew newlesc

Link Code Link 12 T

Link Code SD-1704 Single Dept LT

Link Code M-Dept Multi Dept-1704-1254-1221

Link Code Parant-LC Parent Link Code

Link Code MZ-5D Multiple Zone

Link Code L for WH Link Code for WH testing

Link Code Drop It Only On the left zide L
Link Cade Hadi Zane Hadi Zane

Regular Price Code23233 Farmland Milk

Regular Price Code 46 Andy Dufresne

Link Code Pizza Code used for all frozen pizzas

Link Code Ith at If Link Code for What If stories

Regular Price Code 2 &l Code

Clearance Price Code Clear Surnmer Everything Clearance

Clearance Price Code Blue Code Blue Salerr? -

vew [ pelets ]|

Code Maintenance Workspace

1. Select the field you want to edit.

2. Make necessary changes.

3. Inthe SIM field, select the radio button to indicate that the reason code is used

exclusively by Store Inventory Management (SIM).

Note: Only one reason code for price changes and clearances
can be assigned as a SIM reason code. You are prompted to
confirm your choice to change the SIM reason code.

Click Save + Repeat to commit your changes.

Click Done to save any changes and close the workspace.
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Delete a Code

Navigate: From the Task Pad, select Foundation > Code Maintenance.

Maintenance workspace opens.

The Code

I@ Code Maintenance

Code Maintenance " &
Type Code Description SIM |
Link Code s lges ]
Reqular Price ET-1 ET=1 ':'

Link Code Code Lala

Reqular Price ReglodeMaw newDasc ':'

Link Code Link 12 T

Link Code SD-1704 Single Dept LT

Link Code M-Dept Multi Dept-1704-1234-1221

Link Cade Farent-LC Parent Link Cade

Link Code MZ-5D Multiple Zone

Link Code LT for WH Link Code for WH testing

Link Code Cirop It Only On the left side L
Link Code Dadi Zone Dadi Zone

Regular Price Code3333 Farmland Milk '§'

Regular Price Code 46 &ndy Dufresne ':'

Link Code Pizza Code used for all frozen pizzas

Link Caode 1ath at If Link Tode for What If staries

Feqular Price Code 2 Alli Code )

Clearance Price Code Claar Summer Everything Clearance ':'

Clearance Prica Code Blue Code Blue Salar?? ) -

vew ][ pelete ||

Code Maintenance Workspace

1. Select the record you want to delete.

2. Click Delete. The record is removed from the table.

Note: You cannot delete a reason or link code that is in use.

3. Click Done to close the window.
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Maintain Link Codes

Search for a Link Code

Navigate: From the Task Pad, select Link Codes > Maintain Link Codes. The Maintain
Link Codes workspace opens.

75 Maintain Link Codes

I@ Link Codes Search

rLink Code
Department I:l 8+ Zone Group I:l 8
Class B Zone B
Subclass B+ Location |:| B+
Itemn Type  [iem | Link Code I:I B+
Itern Leval  [Transaction Level Ttern =]
Diff Type celadt -
e —)
Diff B

Maintain Link Codes Workspace

Enter criteria as necessary to restrict the search to the link codes you want to

maintain.
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2. Click Search. Your results appear in the Maintain Link Codes table.

I/CJ Maintain Link Codes

rLink Code

Itern Type

Itermn Level

8
8

|Item

=]
i E—

|Transacti0n Lewvel Itern

=]

N m— -
8
I

Ttem Item Description | Parent Item Parent Item Desq| Location Location Descripti Link Code Link Code Descrip
Filter by Izl | Filtar by lzl | Filter by lzl | Fifter by lzl | Filter by lzl | Filter by Izl | Filter by lzl | Filter by lzl
100000008 Test Item 100.., 3 Western Physic.. | Prakazh b Prakazh CodeZ2 —
100000008 Test Itemn 100.., 4 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Item 100.., 5 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Item 100.., [ Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Itemn 100.., 7 Western Physic.. | Prakazh b Prakazh CodeZ2
100000008 Test Itemn 100.., 22 stare Lo 1 T Link Code 1
100000016 Test Item 100.., 3 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., 4 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., 5 Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Itemn 100.., [ Western Physic.. | Prakazh b Prakazh CodeZ2
100000016 Test Item 100.., 7 Western Physic.. | Prakazh b Prakazh CodeZ2
10000001 & Test Itern 100.., 23 store? LC 2 T Link Code 2
100000024 Test Itemn 100.., 8 Western Physic.. | Prakazh b Prakazh CodeZ2

Maintain Link Codes Table

Maintain or Override a Link Code

1. Search for and retrieve the link codes you want to maintain. Your results appear in
the Maintain Link Codes table.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above.
You may enter more than one department, in which case

you cannot enter class or subclass.

2. Select the locations for the link code:

= Zone Group: Enter the ID of the zone group that contains the zones the link code

should apply to, or click the LOV B button and select a zone group.

= Zone: Enter the ID of the zone that contains the locations the link code should
apply to, or click the LOV B button and select a zone.

= Location: Enter the ID of the location the link code should apply to, or click the
LOV & button and select a location.

3. Select the item type for the link code from the Item Type drop-down.

= Jtem: Select an item or for the link code.

a.

b.

In the Item Level drop-down, select Parent Item, Parent Item/ Diff, or
Transaction Level Item.

If enabled, select a diff type from the Diff Type drop-down.
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c. Inthe Item field, enter the ID of the item(s) you want the link code to apply
to, or click the LOV =l button and select an item.

d. If enabled, enter the ID of the diff(s), or click the LOV & button and select a
diff.

=  Jtem List: Select an item list for the link code.

Enter the ID of the item list you want the link code to apply to, or click the
LOV El button and select an item list.

4. Click Apply. The following may occur:
= A row is added to the table for each transaction level item/location that meets
the selected criteria.
= An existing row changes based on the selected criteria.
5. Click Done to save any changes and close the workspace.
Update Link Codes
1. In the Maintain Link Codes table select the rows you want to edit by clicking the
box :I to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.
2. Right click in the link code field. The Link Code dialog opens.
Link Code %]
Edited Walue 1-zh 5
| Apply || Cancel |
Link Code Dialog
3. Enter the ID of the link code in the Edited Value field, or click the LOV &l button and
select a code.
4. Click OK. Your changes appear in the table.

Delete a Link Code Relationship

1.

In the Maintain Link Codes table select the row you want to delete by clicking the

box :I to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

Click Delete. You are prompted to confirm your decision.

Click Yes. The link code relationship is deleted.
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Maintain Market Basket Codes

Search for a Market Basket Code

Navigate: From the Task Pad, select Market Basket Codes > Maintain Market Basket
Codes. The Maintain Market Basket Codes workspace opens.

B5 Maintain Market Basket Codes

I@ Market Basket Codes Search

rMarket Basket Code

Class B Zone B+
Subdazs .+

Itern Type  [Item

Itern Level  [Transaction Leuel Ttamn

R

Ciff Type - Select -

I —
Diff B
Margin Market Basket Code l:l E+

Competitive Market Basket Code I:I 8+

Cancel

Maintain Market Basket Codes Workspace

1. Enter criteria as necessary to restrict the search to the market basket codes you want
to maintain.

2. Click Search. Your results appear in the Maintain Market Basket Codes table.

I@ Maintain Market Basket Codes

rMarket Basket Code

Class B Zone B8+
Subclass .+

Itern Type |Item E|

Itern Level  [Transaction Level Itern =

Ciff Type - Select - IE‘

I —T

Diff B+

Rernove Margin Market Basket Code

Margin Market Basket Code l:l %

Ramove Compstitive Market Basket Coda [

Competitive Market Basket Code l:l S| Apply

I
Item Item Description | ParentItem | Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
Fitter by || [ Euter by [ ||| Fter sy [ ||| Fvtter £y w || Fer by (o[ Fiter by [ ||| Fitter 20 ¥ | [ Foteer £y
ioooo4050 LH Sweaters:Br..| 100004025 LH Sweaters 1 1 ool MBC 1 Z
ioooo4050 LH Sweaters:Br..| 100004025 LH Sweaters 1 2 ool MBC 1
ioooo40s50 LH Sweaters:Br..| 100004025 LH Sweaters 1 ] ool MBC 1
ioooo40ee LH Sweaters:Br..| 100004025 LH Sweaters 1 1 ool MBC 1
ioooo40ee LH Sweaters:Br...| 100004025 LH Sweaters 1 B ool MBC 1
ioooo40ee LH SweatersiBr..| 100004025 LH Sweaters 1 2 ool MBC 1
ioo00407e LH SweatersiBr..| 100004025 LH Sweaters 1 1 ool MBC 1
10000407e LH SweatersiBr..| 100004025 LH Sweaters 1 2 ool MBC 1
ioo00407e LH SweatersiBr..| 100004025 LH Sweaters 1 2 ool MBC 1
ioooo4024 LH SweatersiBr..| 100004025 LH Sweaters 1 1 ool MBC 1
ioooo4024 LH SweatersiBr..| 100004025 LH Sweaters 1 2 ool MBC 1
ioooo4024 LH SweatersiBr.. | 100004025 LH Sweaters 1 2 ool MBC 1

Maintain Market Basket Codes Table
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Maintain Market Basket Codes

1. Search for and retrieve the market basket codes you want to maintain. Your results
appear in the Maintain Market Basket Codes table.

=4
Item Item Description | Parent Item | Parent Item Description | Zone Group Zone Margin Market Basket Code | Margin Marke
Fitter by: [ ¥ ||[Fiter bp: [ ||| Fteer by: [7]|[ Fter by [ l|[Fiteer by [ ] [ Fteer 2y: [+ ][ Futear by [ =] [Foteer by
100004050 LH SweatersiBr.. | 100004025 LH Sweaters 1 i ool MBC 1 z
100004050 LH Sweaters:Br.. | 100004025 LH Sweaters 1 2 ool MBC 1
100004050 LH SweatersiBr.. | 100004025 LH Sweaters i 3 ool MBC 1
100004062 LH Sweaters:Br.. | 100004025 LH Sweaters i i ool MBC 1
100004062 LH SweatersiBr.. | 100004025 LH Sweaters i 2 ool MBC 1
100004063 LH Sweaters:Br.. | 100004025 LH Sweaters i 3 ool MBC 1
1000040758 LH Sweaters:Br..| 100004025 LH Sweaters 1 i ool MBC 1
1000040758 LH Sweaters:Br.. | 1000040235 LH Sweaters i z ool MBC 1
100004078 LH Sweaters:Br.. | 100004025 LH Sweaters 1 3 ool MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 1 oo1 MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 z oo1 MBC 1
100004054 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 3 oo1 MBC 1
100030063 Parent_tem-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030063 Parent_tem-1:. 100030055 Parent_tem-1 1 1 o1 MBC 1
100030071 Parent_tem-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030071 Parent_tem-1:. 100030055 Parent_tem-1 1 1 o1 MBC 1
100030080 Parent_term-1:.. [ 100030055 Parent_tem-1 1 1 o1 MBC 1
100030080 | Parent_tem-1:.. | 100030055 | Parent_tem-1 1 a ool MBC 1
100030098 | Parent_tem-1:.. | 1000320055 | Parent_tem-1 1 1 ool MBC 1 -
| I IED
Filter
e m— 1

Maintain Market Codes Table

2. Enter the ID of the merchandise level you want to apply the market basket to, or click
the LOV B button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above.
You may enter more than one department, in which case
you cannot enter class or subclass.

3. Select the zones for the market basket:
= Zone Group: Enter the ID of the zone group that contains the zones the market
basket should apply to, or click the LOV Il button and select a zone group.
= Zone: Enter the ID of the zone the market basket should apply to, or click the
LOV B button and select a zone.
4. Select the item type for the market basket code from the Item Type drop-down.
= Item: Select an item for the market basket code.

a. Inthe Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

b. If enabled, select a diff type from the Diff Type drop-down.
c. In the Item field, enter the ID of the item(s) you want the market basket
code(s) to apply to, or click the LOV B button and select an item.

d. If enabled, enter the ID of the diff, or click the LOV % button and select a
diff.
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= Item List: Select an item list for the market basket code.

Enter the ID of the item list you want the market basket code(s) to apply to, or
click the LOV B button and select an item list.

5. Inthe Margin Market Basket Code field, enter the ID of the code, or click the LOV %
button and select the code.
or
Select the Remove Margin Market Basket Code checkbox to disassociate the margin
market basket code from the item(s)/zone(s) that meet the selected criteria.

6. In the Competitive Market Basket Code field, enter the ID of the code, or click the

LOV B button and select the code.

or

Select the Remove Competitive Market Basket Code checkbox to disassociate the
competitive market basket code from the item(s)/zone(s) that meet the selected
criteria.

7. Click Apply. The following may occur:

= Arow is added to the table for each transaction level item/location that meets
the selected criteria.

* An existing row changes based on the selected criteria.
8. Click Done to save any changes and close the workspace.

Update Market Basket Codes
1. In the Maintain Market Basket Codes table select the row you want to edit by clicking

the box :I to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

I
Them Item Description | Parent Ttem Parent Item Description | fone Group fone Margin Market Baskel
Fitter by | ||| Fitker by || Fiker by | | Fitker by W Fitber by | TN Fitber by | ||| Fitber by
1001326001 tast 115 Se4 oos lz‘
100154058
100154074 Parent & DiffiLa..| 100154066 Parent & Diff 115 2135 oos
100154074 Parent & DiffiLa..[ 100154066 Parent & Diff 115 477 oos
100154074 Parent & DiffiLa..| 100154066 Parent & Diff 115 486 aons -
< I IED
Filter
Location l:l % E iii
L

Maintain Market Basket Codes Table
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2.

4.

Right-click in the field you wish to edit:
* Margin Market Basket Code - The Margin Market Basket Code dialog opens.

Margin Market Basket Code &l

8
Edited value %

| Apply || Cancel |

Margin Market Basket Code Dialog
* Competitive Market Basket Code - The Competitive Market Basket Code dialog

opens.
Competitive Market Basket Code g|
8
Editad Yalue a0z %

| Apply || Cancel |

Competitive Market Basket Code Dialog

Enter the ID of the Market Basket Code in the Edited Value field, or click the LOV %
button and select a code.

or

Clear the field to disassociate the market basket code from the selected record.

Click OK. Your changes appear in the table.
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Delete a Market Basket Code Relationship
1. Inthe Maintain Market Basket Codes table select the row you want to delete by

clicking the box :I to the left of the row. Press and hold the Ctrl key while selecting
to select multiple rows. Click Select All to select all the rows.

Il
Ttem Item Description | Parent Item Parent Item Description| Zone Group Zone Margin Market Basket Code | Margin Marke
Fitter by | T ||| Fitrer by W ||| Frtrer by | T Fiter by W ||| Fitrer by | W Fiter by | || Fitter by - | Filter by
100004030 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 1 oo1 MBC 1 Z
100004030 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 z oo1 MBC 1
100004030 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 3 oo1 MBC 1
100004065 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 1 oo1 MBC 1
100004065 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 z oo1 MBC 1
100004065 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 3 oo1 MBC 1
100004076 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 1 oo1 MBC 1
10000407& | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 z oo1 MBC 1
100004076 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 3 oo1 MBC 1
100004084 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 1 ool MBC 1
100004084 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 z oo1 MBC 1
100004084 | LH SweatersiBr.,, [ 100004023 | LH Sweaters 1 3 oo1 MBC 1
100030063 | Parent_tem-1:.. | 1000320055 | Parent_tem-1 1 1 ool MBC 1
100030063 | Parent_tem-1:.. | 100020055 | Parent_tem-1 1 1 ool MBC 1
100030071 Parent_tern-1t.. | 100030055 | Parent_tem-1 1 1 ool MBC 1
100030071 Parent_tern-1t.. | 100030055 | Parent_tem-1 1 1 ool MBC 1
100030080 | Parent_tem-1:.. | 1000320055 | Parent_tem-1 1 1 ool MBC 1
100030080 | Parent_tem-1:.. | 100030055 | Parent_tem-1 1 1 ool MBC 1
100030098 | Parent_tem-1:.. | 1000320055 | Parent_tem-1 1 1 ool MBC 1 -
1| I IED
Filter
Location I:I % IEI IEI

Maintain Market Basket Codes Table

2. Click Delete. You are prompted to confirm your decision.
3. Click Yes. The market basket code relationship is deleted.
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Calendars

Calendars are used to define review periods for your pricing strategies. A review period
is the amount of time you have to act on pricing events generated in the worksheet before
they expire.

After you create a calendar, you can maintain the different aspects of that calendar. You
can modify the name, description or end date of the calendar. You can also change the
rules and exceptions for future review periods.

Create a Calendar

Navigate: From the Task Pad, select Calendar > Create Calendar. The Create Calendar
workspace opens.

%5 create Calendar

|P Calendar Setup

* Narne | ‘

Description | |@
calendar Setup Review Period Setup
* Gtart Date l:liﬂ Fules Both  [7]
¥ End Date l:lEl Exception Frequency
*
bR s I:l Mew Calendar to Assign to Strategies When Calendar Expires

cancel |[_save +Repeat |[_pone

Create Calendar Workspace
1. Inthe Calendar Setup pane, in the Name field, enter a name for the calendar.

2. Inthe Description field, you can enter a description for the Calendar. Click the 5
button to open an editing window.

Set Up the Calendar
1. Inthe Calendar Setup area, in the Start Date field, enter the date the calendar
becomes active, or click the calendar = button and select a date.

In the End Date field, enter the date the calendar is no longer active.
In the Review Period Duration field, enter the length of the review period in days.

In the Days Between Review Periods field, enter the number of days between review
periods.
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Note: The last review period duration plus the days between
review periods must exactly reach the end date of the
calendar. If this is not the case, the system can automatically
adjust the end date, or you can chose to modify the Review
Period Duration, Days Between Review Periods or End Date
fields yourself.

Set Up Review Periods

1. Inthe Review Period Setup area, from the Rules drop-down, select the type of rules
to apply for the review period.

* Inclusion - Items that meet inclusion candidate rules will be highlighted in the
worksheet.

= Exclusion - Items that meet exclusion candidate rules will be excluded from the
worksheet.

= Both - Both inclusion and exclusion candidate rules are applied for the review
period.

= None - No rules are applied for the review period.

2. Inthe Exception Frequency field, enter the frequency, in review periods, that RPM
should process exceptions from the merchandising system.

= Enter 1 for every review period.

= Enter 2 for every other review period.

= Enter 3 for every third review period.

= Enter 0 if you never want RPM to process exceptions.

3. C(lick Calculate Review Periods. The review periods are calculated and the Review
Period Details pane opens.

I'(’J Review Period Details

Review Period Details ("4

Start Date End Date Exception |

= &
L
in
(4]

01/01/2005, 01/01/2005,

01/02/2005, 01/02/2005

(1=
g1z
HH
[« ]

01/03f2005) 01/03/2005)

01/04f2005 01/04/2005

i

01/05/2005] 01/05/2005| Both

01/06f2005] 01/06/2005,

=
z

i
[

01/07/2005) 01/07/2005

01/08f2005] 01/08/2005

01/03/2005) 01/09/2005)

= | e e
IENEE
[ | |

01/10/2005 01/10/2005

0171172005 01/11/2005

=
z

H
[4]

01/12f2005 01/12/2005

01/13f2005 O1/13/2005

1 EE (R R EEE R E R E

A==
4l
E1||E1

il

Review Period Details Pane
4. In the Review Period Details pane, in the Rules and Exceptions fields, edit as

necessary for each review period.

Complete the Calendar

Click Done at the bottom of the workspace. The new calendar is added and the Maintain
Calendar workspace closes.
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Maintain a Calendar

Navigate: From the Task Pad, select Calendar > Maintain Calendar. The Maintain
Calendar workspace opens.

%3 Maintain Calendar

@

Calendar List le®
Name Description Start Date End Date Review Period Duration | Days Between Review Pd Expired I
corin devac test 11/19/2004 11/20/2004 1 1 Z
Daily Calendar 10f08/2004 10/09/2005, 1 o (|

Demo Calendar Weekly Calendar 11/12/2004 02/10/2005 5 2 (]

Starts 11/24 11/24f2004 11/29/2004 6 o N -
Update Trern Arcribure 10/19/2004 10/17/2005 3 1 O

Testweekly schedule [ Test schedule 10/25/2004 12f26/2004] 5 2 (|

Future calendar 09f23f2005 09/25/2005 2 1 O =

[oeee 1 [eae ]|

Gancel |[_save +Repeat |[_pone

Maintain Calendar Workspace

1. Select the calendar you want to maintain from the Calendar List pane.

2. (Click Edit. The Calendar Detail and Review Period Details panes are displayed and
the fields that can be changed are enabled.

I@ Review Period Details

=
z
i+

Review Period Details &
Start Date End Date Rules Exception |

01/01/2005 01/01/2005 —

01/02/2005 01/02/2005| Both  |¥]

01/03/2005| o1/0z/z005| oth [ ]

01/04/2005, 01/04/2005| [Both :

01/05/2005] 01/05/2005) m

01/06/2005, 01/06/2005,

01/0%/2005, o1/ov/z00s| [path [

01/08f2005, 01/08/2005

01/09/2005, 01/09/2005)

01/10f2005 01/10/2005 ﬂ

01/11/2005 01/t 172005

01/12/2005 01122005

01/13/2005 01/13/2005

=

Review Period Details Pane
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I‘P calendar Details

*
bErma |2|JD5 Calendar |

Description | |@
talendar Setup Review Period Setup
Mew Galendar to Assign to Strategies When Galendar Expires
el E— ®

Calendar Detail Pane

Edit the enabled fields as necessary.
= (Calendar Detail
— End Date: Select the end date for the calendar.

— New Calendar to Assign to Strategies when Calendar expires: Select the
calendar that replaces the current calendar after the end date.

= Review Period Details
— Rules: Select Inclusion, Exclusion, Both, or None.

— Exceptions: Select if exceptions, from the merchandising system, should be
processed during the review period.
Click Calculate Review Periods. If edits are made to the calendar detail, you must
press the Calculate Review Periods button.

Click Done.

Delete a Calendar

1.

2
3.
4

Select the calendar you want to delete from the list.
Click Delete. You are prompted to confirm your decision.
Click Yes. The calendar is deleted.

Click Done to close the window.
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Maintain Location Move

Location Moves allows you to smoothly move a location from one zone to another within
a zone group. The process allows a location to keep all location level pricing events while
it transfers from the old zones pricing strategies to those of the new zone, while at the
same time inheriting the pricing events of the new zone. Keep the following in mind
when scheduling location moves:

A location does not automatically inherit the price of the new zone. Pricing events
scheduled after the move date in the new zone, will be applied to the new location.

Only location level promotions will follow a location into a new zone. Promotions
from the old or new zone that span the move date must be stopped before
scheduling a location move.

Request a Location Move

Navigate: From the Task Pad, select Zone Structure > Maintain Location Move. The
Maintain Location Move workspace opens.

B9 Maintain Location Move

[(® Location Move List ‘

Location Move List (-4

d & Location (3] | Location Nan Location Typ| Zone Group (3 Old Zone (2] | Old Zone Nan New Zone (3)| New Zone Naf Scheduled D4 Status Conflict Move Resul

171 12345678  |TestStroel.. |Store 521 For testing .. [ 08/01/2002|Scheduled =

178 12345672 [TestStroel.., [Store 521 For testing .. [ 08/01/2002|Failed

172 124 testing 124 |Store 521 For testing .. [ 08/01/2002|Scheduled

177 124 testing 124 |Store 521 For testing .. [ D8/01/2002|Failed Failed [—1

180 128 138 Store 521 For testing .. [ 08/01/2002|5cheduled -}

181 128 128 Store 521 For testing .. [ 08/01/2002|Failed

4

L LEL lgzor L Fortesting .| 08/01/2002]schadylad

() Maintain Location Move ‘

1
i

(i

Maintain Location Move Workspace

1.

Click New. The Zone Group Field is enabled on the Maintain Location Move pane.

[ Maintain Location Move ‘

8
8

Maintain Location Move Pane

In the Zone Group field, enter the zone group of the location you need to move, or
click the LOV &l button and select a zone group.

In the Zone field, enter zone of the location you need to move, or click the LOV
button and select a zone.

In the Location field, enter the location you need to move, or click the LOV El button
and select a Location.

In the New Zone field, enter the zone to move the location to, or click the LOV
button and select the new zone.
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6. In the Effective Date field, enter the date the location should move zones, or click the
calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Location Move Lead Time.
The earliest date a location move can be created is today’s
date plus the location move lead time.

7. Click Apply. The location move request appears with a status of Worksheet on the
Location Move list.

Schedule a Location Move
1. Select a location move with a status of Worksheet.
2. Select Schedule from the Action drop-down.

3. (Click Update. If no conflicts are found, the location move request is changed to a
status of Scheduled and it becomes locked and uneditable. The location will be
moved on the effective date.

Note: An alert is given when conflict checking is complete.

Reset a Failed Location Move
1. Select a location move with a status of Failed.
Select Worksheet from the Action drop-down.

3. (Click Update. The failed location move is changed back to a worksheet location
move request.

4. Fix the conflict that caused the location move to fail and reschedule it.

View Conflicts

In the Conflict column, click the failed link. The conflict window opens with the conflict
information displayed.

There are three types of conflicts:

e Promotion - A promotion from the old or new zone spans the effective date of the
move.

e Schedule - There is a location move already scheduled for the location.

o DPrice Strategy - The location or old zone is attached to a price strategy.

View Move Results

If RPM created any exceptions or exclusions in order for the location to be moved
successfully, those items are viewable in the move results column.

In the Move Results column, click the completed link. The conflict review window opens
with move results information displayed.
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Delete a Location Move

Note: Only location moves in Worksheet status can be
deleted.

Select a location move with a status of Worksheet.

2. Click Delete. A dialog appears asking "The selected Location Move Request will be
deleted. Canceling this task will not return these records. Do you wish to continue?"

3. Click Yes to delete the location move.
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Maintain Pricing Strategies

Pricing strategies allow you to define how prices are proposed when pricing worksheets
are generated. You can define pricing strategies at the department, class, or subclass level
to identify the items that are affected by the strategy. The lowest merchandise level you
can define for a price strategy is determined by the aggregation levels defined for the
department. An item/location can be on multiple regular pricing strategies as long as the
review periods within the calendar assigned do not overlap (clearance, competitive, or
margin) and one maintain margin pricing strategy which can overlap with a (clearance,
competitive, or margin) strategy.

After you have created a price strategy, you can maintain different aspects of the price
strategy.

Note: Updates to pricing strategies affect only future
worksheets. Current worksheets will not be updated.

Area Differential Pricing

Area differential pricing allows you to set prices for items at a particular zone or zone
group differently than another zone or zone group. The price differential is based on the
rules you define. Area differentials can be used when you create a price change to ensure
consistent pricing. These price changes are generated by selecting Price Changes for Area
Differentials within the Price Change task pad dialog. These price changes are generated
by selecting Price Changes for Area Differentials within the Price Change task pad
dialog. Differential pricing cannot be applied to other pricing events, such as clearances
or promotions.

When creating an area differential:

*  You first establish a primary area, by defining the merchandise hierarchy and zone
hierarchy for the primary area.

= Next, select the zones that fall within the secondary area.

=  Then define how prices for the items in the hierarchy will differ in the secondary
areas from the prices in the primary area. You can choose to price the item higher or
lower by percent, or set the price to the same as the primary area.

*  You can choose to exclude certain items in the merchandise hierarchy from the
secondary area differential prices.

* You can choose to create and associate a competitive pricing strategy with the
secondary area differential.

Area differentials are applied when price changes are created manually in the Price
Change Dialog or from the Create Price Changes for Area Differentials dialog. They are
also created in the worksheet if there are item/zone combinations brought into the
worksheet that are part of the primary area on an area differential strategy. When
competitive information is associated with an area differential the worksheet chooses the
lower of the retails proposed by the strategies.
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Note: See Create Price Changes for Area Differentials for
information about creating and applying price changes.

If you set up the secondary area to be auto-approved, secondary area price changes are
conflict checked, and if no conflict exists, created in approved status. If conflicts exist, the
secondary area price change is created in worksheet status. If you set up the secondary
are to not be auto-approved, secondary area price changes are created in worksheet
status. The Change the status of a price change topic provides additional information
about status changes and conflict checking.

Create an Area Differential

Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create
Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I-'(—" Strategy Maintenance ‘

e

Tepe |- se

cancel_|[_save + Repeat |[_Don=

Create Pricing Strategy Workspace

1. Inthe Type field, select Area Differential.
2. Click Next. Additional fields appear.

I(:' Strategy Maintenance

* *

Cefine Secondary Areas ||

Strategy Maintenance pane

3. Enter the ID of the merchandise level you want to apply the area differential to, or
click the LOV &l button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level
dialog allows it.

4. Select the zones that define the primary area:
=  Zone Group: Enter the ID of the zone group that contains the locations to add to
the area differential price strategy, or click the LOV & button and select a zone
group.
=  Zone: Enter the ID of the zone to add to the area differential price strategy, or
click the LOV =l button and select a zone.
5. Click Define Secondary Areas. The Area Differential Strategy Details pane opens.
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(@ Area Differential Strategy Details
(€

Zone Id Zone Name Differential Percent Auto Approve Price Guide |

gancel || save +Repeat |[ pone

Area Differential Strategy Details Pane

Define Secondary Areas

1.
2.

Click New to enable the fields.

In the Price Zone field, enter the ID of the zone that you want to add to the secondary
area of the area differential price strategy, or click the LOV &l button and select a
zone.

In the Price Guides field, enter the ID of the price guide you want to apply to the
differential pricing, or click the LOV &l button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

In the Differential field, select how the price differs from the primary area:

= Price Higher: The items at the specified secondary area are priced higher by the
percentage entered in the Percent field.

= Price Lower: The items at the specified secondary area are priced lower by the
percentage entered in the Percent field.

=  Price Equal: The items at the specified secondary area are priced the same as the
items in the primary area.

In the Percent field, enter the percent by which the secondary area price is different

from the primary area price.

Select the Auto Approve check box to indicate price changes for the area differential
should be created in Approved status.

Exclude Items From the Area Differential

Note: Expand the Item Exclusion section of the Area
Differentials pane to complete the procedure.

Enter or select criteria ID of the items you want to exclude.
Click Add. The information is added to the item exclusion table.
To remove an item from the item exclusion table:

a. Select an item.

b. Click Remove. The item is removed from the item exclusion table.
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Complete the Area Differential
1. Click Apply. Any changes are added to the table

2. Click Done to save your changes and close the window.

Edit an Area Differential Price Strategy
Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I@ Pricing Stratagy Search

Price Stratagy Id | Type #rea Differential | B+ |Ares Differential

Class .+ Zone .+
Subclazs .+
Calendar Status |- Selact - lzl

|

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List |

Pricing Strategies List | &
Price Strategy Department If Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone £
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QAz Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11[{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

zo0z 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414 Activewsar 1000|Sparts Cloth.,., 1000(Mens Sports..,
4 »

| [peiete |[_eax |

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.
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4. Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.

I'/(: Strategy Maintenance
Discount Percent l:l
Add Row
I &,
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown

Strategy Maintenance Pane

5. Make necessary changes.

Remove a Zone From an Area Differential Strategy
1. Select the zone you want to delete.

2. Click Delete. The zone is removed from the table

Exclude Items From the Area Differential

Note: Expand the Item Exclusion section of the Area
Differentials pane to complete the procedure.

1. Enter or select criteria ID of the items you want to exclude.
Click Add. The information is added to the item exclusion table.
3. Toremove an item from the item exclusion table:
a. Select an item.

b. Click Remove. The item is removed from the item exclusion table.

Complete the Area Differential
1. Click Apply. Any changes are added to the table

2. Click Done to save your changes and close the window.
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Clearance Pricing

A clearance pricing strategy allows you to define the method used to markdown items.

Create a Clearance Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create

Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I(—" Strategy Maintenance

Type [ select - =

cancel_|[_save + Repeat |[_Don=

Create Pricing Strategy Workspace

1. Inthe Type field, select Clearance.
2. Click Next. Additional strategy fields appear.

I(: Strategy Maintenance

-
=
.

| Define Strategy Details

Clearance strategy fields
3. Enter the ID of the merchandise level you want to apply the strategy to, or click the
LOV El button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if

the definition of the department in the aggregation level
dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to

the price strategy, or click the LOV & button and select a zone group.
Zone: Enter the ID of the zone to add to the price strategy, or click the LOV

button and select a zone.
In the Price Guides field, enter the ID of the Price Guide field, or click the LOV

button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

76 Oracle Retail Price Management



Clearance Pricing

In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV El button and select a calendar.

In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin with the next review period.

In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV =l button and select a calendar.

Note: You must select the Suspend check box before you can
add a new calendar.

Click Define Strategy Details. The Clearance Strategy Details pane opens.

|(: tlearance Strategy Details

Markdown Percent  [Regular Price

Clearance Strategies ” &;

Markdowvm Number Discount Percent |

Clearance Strategy Details Pane

Define Clearance Strategy Details

1.

In the Markdown Percent field, select the price from which the clearance price is
calculated.

Click Add Row.
In the Discount Percent field, enter the percent of the markdown.
Click Apply.

Note: If the price from which the clearance price is calculated
is Regular Retail, the Discount Percent fields must increase
with each markdown added.
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Edit a Clearance Price Strategy
Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I@ Pricing Strategy Search

Clazs .+ Zone .+

Subclass .+
Calendar Status |- Select - E|

oo Lo ]|

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List |

Pricing Strategies List | &
Price Strategy Department I{ Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone 2
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QAz Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11[{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

zo0z 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414 Activewsar 1000|Sparts Cloth.,., 1000(Mens Sports..,
4 »

| [peiete |[_eax |

Pricing Strategies List Pane

From the Pricing Strategies List, select the strategy you want to edit.

Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.
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I-/(Q Strategy Maintenance |

8
8
Discount Percent l:l
I
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown

Strategy Maintenance Pane

5. Make necessary changes.

Edit a Price Guide

Change or enter a price guide name, or click the LOV B button and select the
appropriate price guide if necessary.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend check box.

2. Enter a calendar name, or click the LOV % button and select a calendar.

Edit a Markdown

1. Select the Markdown number from the Clearance Strategies table.
2. Click Edit. The Discount Percent field is enabled.

3. Edit the discount percent.

4. Click Apply.

Delete a Markdown

1. Select the highest Markdown number from the Clearance Strategies table.
2. Click Remove Markdown.

3. Click Apply.
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Clearance Defaults Pricing

A clearance defaults pricing strategy allows you to set up a strategy for generating
subsequent markdowns after an initial clearance event.

Create a Clearance Defaults Pricing Strategy

Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create
Pricing Strategy workspace opens.

E Create Pricing Strategy

I-/(-T Strategy Maintenance ‘

Type [ Select- =]

cancel _|[_gave +Repeat |[_Done |

Create Pricing Strategy Workspace

1. Inthe Type field, select Clearance Defaults.
2. Click Next. Additional strategy fields appear.

I-'@ Strategy Maintenance

| Define Strategy Details ||

Clearance Defaults strategy fields

3. Enter the ID of the merchandise level you want to apply the strategy to, or click the
LOV El button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level
dialog allows it.

4. C(lick Define Strategy Details. The Clearance Defaults Strategy Details pane opens.

I-/(Q clearance Strategy Details

Discount Percent l:l
Days after First I:I
Reset Price this many days after out of stack date l:l add Row Apply
I &
Markdown Number | Discount Percent Days after First |

Clearance Defaults Strategy Details Pane
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Define Clearance Strategy Details

1.

4.

Enter the percent of the first markdown after the initial markdown in the Discount

Percent field.

Enter how many days after the first markdown that this markdown should be taken

in the Days after First field.

Enter when to reset the price to regular price in the Reset Price this many days after

out of stock date field.

Click Apply. A row is added to the table.

Add Subsequent Markdowns

1.
2.

Click Add Row.

Enter a percent in the Discount Percent field.

Note: Subsequent markdown percents must be greater than

the previous.

Enter a number of days in the Days after First field.
Click Apply. The markdown is added to the table.

7= Clearance Strategy Details
(&

I

Markdowm Number

Discount Percent

Days after First

1

5

2

15%

10

Clearance Defaults Strategy Details pane with markdowns

User Guide 81



Clearance Defaults Pricing

Edit a Clearance Defaults Price Strategy
Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I@ Pricing Strategy Search

Price Strategy Id | Type k:learance Defaul %+ Clearance Defaul

Class .+ Zone .+

Subclass .+
Calendar Status |- Selact - E‘

| [Coiear | [searsn |
Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List |

Pricing Strategies List | &
Price Strategy Department If Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone £
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QAz Dept

2001 50(QAl Dept

2022 S0[QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

zo0z 50(QAal Dept s50|qal Class 50{QA1 SubCla.,

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,
4 »

| [oetete |[_ear |

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.
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4. Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.

I@ Strategy Maintenance

|
|
|
Discount Percent l:l
<%
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown
Strategy Maintenance Pane
5. Make necessary changes.
Add Subsequent Markdowns
1. Select which row you want to add the markdown before.
2. Click Add Row.
3. Enter a percent in the Discount Percent field.
Note: Subsequent markdown percents must be greater than
the previous percents.
Enter a number of days in the Days after First field.
Click Apply. The markdown is added to the table.
I@ Clearance Strategy Details
[
Markdown Number Discount Percent Days after First
1 10%(5
2 15910

Clearance Defaults Strategy Details pane with markdowns
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Edit a Markdown

1. Select the Markdown number from the Clearance Strategies table.

2. (Click Edit. The Discount Percent and Days after First fields are enabled.
3. Edit the discount percent and days after first values.

4. Click Apply.

Delete a Markdown

1. Select the highest markdown number from the Clearance Strategies table.
2. Click Remove Markdown.

3. Click Apply.
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Competitive Pricing

A competitive pricing strategy allows you to define your pricing strategy for items based

on your primary competitor's prices

Note: All locations in a competitive pricing strategy must
use the same currency.

You can also assign reference competitors to a competitive pricing strategy. This
information allows you to compare the proposed prices to the prices available from other
retailers. If the proposed prices vary from the target percentages defined for the reference
competitors, you are informed so you can adjust the price in the pricing worksheet.

Create a Competitive Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create

Pricing Strategy workspace opens.

%9 create Pricing Strategy

I(: Strategy Maintenance

o [

Tepe |- se

cancel || save + Repeat || Done

Create Pricing Strategy Workspace

1. Inthe Type field, select Competitive.
2. Click Next. Additional strategy fields appear.

‘(—“ Strategy Maintenance

Define Strategy Details |

Competitive strategy fields
Enter the ID of the merchandise level you want to apply the strategy to, or click the

LOV &l button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level

dialog allows it.
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4. Select the zones for the strategy:
=  Zone Group: Enter the ID of the zone group that contains the locations to add to

the price strategy, or click the LOV =l button and select a zone group.

= Zone: Enter the ID of the zone to add to the price strategy, or click the LOV
button and select a zone.

5. In the Price Guides field, enter the ID of the Price Guide field, or click the LOV
button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

6. Inthe Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV =l button and select a calendar.

7. Inthe Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin with the next review period.

8. Inthe New Calendar field, enter the ID of the new calendar you want to associate
with the strategy, or click the LOV =1 button and select a calendar.

Note: you must select the Suspend check box before you can
add a new calendar.

9. Click Define Strategy Details. The Competitive Strategy Details pane opens.

(= competitive Strategy Details
(G p oy

Compste Tipe frasn [7]

* Reference Competitors

Competitor Competitor Store Compete Type Percent

N — &
S =
S — =
S =
S =

Competitive Strategy Details Pane
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Define Competitive Strategy Details

1.

In the Competitor field, enter the ID of the primary competitor or click the LOV
button and select a competitor.

In the Competitor Store field, enter the ID of the store that proposed retails are being
compared against.

Note: The currency at the competitor store must be the same
as the zones previously selected.

In the Compete Type, select how the price strategy determines the prices:
= Match: Prices are proposed to be the same as the primary competitor's prices.

= Price Above: Prices are proposed to be a percentage above the primary
competitor's prices.

=  Price Below: Prices are proposed to be a percentage below the primary
competitor's prices.

=  Price by Code: Prices are proposed by the market basket code for the
merchandise hierarchy/zone.

Define Match Strategy Details

1.
2.

Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price Above or Price Below Strategy Details

1.

4.

In the Compete Percent field, enter the percent above or below the primary
competitor's price that the new price is set at.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a primary competitor before a
price change is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price by Code Strategy Details

1.

In the Code field, select the competitive market basket code you want to use to set
the price.

In the Compete Type, select how the price strategy determines the prices:
=  Match: Prices are proposed to be the same as the primary competitor's prices.

= Price Above: Prices are proposed to be a percentage above the primary
competitor's prices.

=  Price Below: Prices are proposed to be a percentage below the primary
competitor's prices.

In the Compete Percent field, enter the percent above or below the primary
competitor's price that the new price is set at.
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4. Set up the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a primary competitor before a
price change is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Reference Competitors

1. In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV El button and select a competitor.

2. In the Competitor Store field, enter the ID of the store, or click the LOV =l button
and select a store.

3. Inthe Compete Type, select how to compare prices to the reference competitors:

=  Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

= Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

4. If you selected Price Above or Price Below, enter the percent above or below the
competitor's price that the new price is compared.

5. Click Done to save any changes and close the workspace.

Create a Competitive Price Strategy Associated with an Area Differential

Note: Expand the Competitor section of the Area
Differentials pane to complete the procedure.

1. In the Competitor field, enter the ID of the competitor or click the LOV =l button and
select a competitor.

2. In the Competitor Store field, enter the ID of the store that proposed retails are being
compared against or click the LOV =l button and select a store.

Note: The currency at the competitor store must be the same
as the zones previously selected.

3. Inthe Compete Type, select how the price strategy determines the prices:
= Match: Prices are proposed to be the same as the competitor's prices.

= Price Above: Prices are proposed to be a percentage above the competitor's
prices.

=  Price Below: Prices are proposed to be a percentage below the competitor's
prices.
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= Price by Code: Prices are proposed by the market basket code for the
merchandise hierarchy/zone.

Define Match Strategy Details

1.
2.

Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price Above or Price Below Strategy Details

1.

In the Compete Percent field, enter the percent above or below the competitor's price
that the new price is set at.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Define Price by Code Strategy Details

1.

In the Code field, select the competitive market basket code you want to use to set
the price.

In the Compete Type, select how the price strategy determines the prices:
=  Match: Prices are proposed to be the same as the competitor's prices.

= Price Above: Prices are proposed to be a percentage above the competitor's
prices.

=  Price Below: Prices are proposed to be a percentage below the competitor's
prices.

In the Compete Percent field, enter the percent above or below the competitor's price
that the new price is set at.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.
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Define Reference Competitors

Note: Expand the Reference Competitor section of the Area
Differentials pane to complete the procedure.

In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV El button and select a competitor.

In the Competitor Store field, enter the ID of the store, or click the LOV El button
and select a store.

In the Compete Type, select how to compare prices to the reference competitors:

= Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

=  Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

If you selected Price Above or Price Below, enter the percent above or below the

competitor's price that the new price is compared.

Click Done to save any changes and close the workspace.

Edit a Competitive Pricing Strategy

Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1.

In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I(:' Pricing 5trategy Search

Price Strategy Id | Type lcampetitive +
= =
= =l

Calendar Status |- Select - E|

Cotear ] Lswaen ||

Pricing Strategy Search Pane

Click Search. The results of your search are listed in the Pricing Strategies List pane.
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(C—‘) Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department I{ Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone Z
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 51|QA2 Dept

2001 S0/QA1 Dept

2022 S0[QAl Dept

1061 S0/QA1 Dept 50|QAl Class 50/Qa1 SubCla.,

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.
1 51|QA2 Dept S511|0A2 Class 5111|042 SubCla..

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 S0|QA1 Dept 50|Qal Class 50/Qa1 SubCla.,

2002 50|QAa1 Dept 50|QAl Class 50|QAa1 SubCla..,

2003 S0/QA1 Dept 50|Qal Class 50/Qa1 SubCla.,

2004 3|test3 1|test3 2|testl

2005 S0/QA1 Dept 50|QAl Class 50/Qa1 SubCla.,

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

|

Pricing Strategies List Pane

From the Pricing Strategies List, select the strategy you want to edit.

Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.

(G} Strategy Maintenance

Type  |Clearance Defaultle‘

e Cepartrnent
Class

Subclazz

50

S0

50

Discount Percent

Drays after First

B+ [¢21 Dept
B+ o1 clas:
B+ |24 subclass

Reset Price this many days after out of stock date

[ ]

Strategy Maintenance Pane

5. Make necessary changes.

Edit a Price Guide
Enter the price guide name, or click the LOV B button and select the price guide.

:
I &,
Markdown Number Discount Percent Days after First
| Edit || Rermove Markdown
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Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend check box.

2. Enter a calendar name, or click the LOV [l button and select a calendar

Edit a Competitor

1. Inthe Competitor field, enter or change the competitor ID, or click the LOV
button and select the competitor.

2. In the Competitor Store field, enter a competitor store ID, or click the LOV &l button
and select the store.

In the Compete Type drop-down, select the compete type.
4. For Price Above and Price Below compete types, setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
retail price can vary from a competitor before a price change
is proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Edit Reference Competitors
Define reference competitors as necessary.

Complete the Competitive Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.

92 Oracle Retail Price Management



Margin Pricing

Margin Pricing

A margin pricing strategy allows you to define the pricing strategy for items based on

margin targets.

Create a Margin Pricing Strategy
Navigate: From Task Pad, select Price Strategy > Create Price Strategy. The Create

Pricing Strategy workspace opens.

%5 Create Pricing Strategy

I(: Strategy Maintenance

e T

Tepe |- se

cancel |[_save + Repeat ][ _Dons

Create pricing strategy workspace

1. Inthe Type field, select Margin.
2. Click Next. Additional strategy fields appear.

I(—"' Strategy Maintenance

| Dafine Strategy Details

Margin strategy fields
Enter the ID of the merchandise level you want to apply the strategy to, or click the

3.
LOV E1* button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if

the definition of the department in the aggregation level
dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to

the price strategy, or click the LOV =l button and select a zone group.
Zone: Enter the ID of the zone to add to the price strategy, or click the LOV El*

button and select a zone.
In the Price Guides field, enter the ID of the Price Guide field, or click the LOV

button and select a price guide.

5.

Note: Only price guides associated with the selected
departments can be selected.
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In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV El button and select a calendar.

In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin in the next period.

In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV El button and select a calendar.

Note: You must select the Suspend check box before you can
add a new calendar.

Click Define Strategy Details. The Margin Strategy Details pane opens.

I(: Margin Sbrategy Details

Code Fselect - [7] Acceptable Range From l:l

Margin Target I:I Acceptable Range To l:l
Margin S5trategy Details " &
Code | Margin Target Acceptable Range From | Acceptable Range To |
+ Reference Competitors

Competitor Competitor Store Compete Type Percent
N — g T
) = I
o = e 7]
o[ 8 = e 7]
o I = = oscc IR

Margin strategy details

Define Margin Strategy Details

1.

In the Code field, select the margin market basket code you want to use to set the
price.

In the Margin Target field, enter the percent of margin you want to earn on the
item/zone.

Setup the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.
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4. Click Apply. An entry is added to the Margin Strategy Details table.
5. Define reference competitors as necessary.

6. Click Done to save any changes and close the workspace.

Edit a Margin Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I@ Pricing 5trategy Search

Clazs .+ Zone .+
Subdlass .+
Calendar Status |- Selact - lzl

| Coiear ] oo ||

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List |

Pricing Strategies List | &
Price Strategy Department I{ Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone 2
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QAz Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

zo0z 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2003 S50[Qa1 Dept s0[Qal Class S50[Qa1 SubCla..

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,
4 »

| [peiete |[_eax |

Pricing Strategies List Pane

3. From the Pricing Strategies List, select the strategy you want to edit.
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4. Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.

I@ Strategy Maintenance

8
|
|
Dizcount Percent l:l
I &,
Markdown Number Discount Percent Days after First
| Edit || Remaove Markdown
Strategy Maintenance Pane
5. Make necessary changes.
Edit a Price Guide
Enter the price guide name or click the LOV El button and select the appropriate price
guide.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend checkbox.

2. Enter a calendar name, or click the LOV &1 button and select a calendar

Edit Margin Details
1. Select a row in the Margin Strategy Details table.

2. Inthe Margin Target field, enter the percent of margin you want to earn on the
item/zone.

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

In the Acceptable Range From field, enter the bottom of the range.
4. In the Acceptable Range To field, enter the bottom of the range.
Click Apply.
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Delete Margin Details
1. Select the margin detail from the Margin Strategy Details table.
2. Click Delete. The row is removed from the table.

Edit Reference Competitors
Define reference competitors as necessary.

Complete the Margin Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.
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Maintain Margin Pricing
A maintain margin pricing strategy allows you to define the pricing strategy for items
based on future cost changes. The proposed retails can be based on current or market

basket margin percentages. Reference competitors may be assigned for comparison

purposes.

Create a Maintain Margin Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Create Pricing Strategy. The Create

Pricing Strategy workspace opens.

B9 Create Pricing Strategy

I-"(-1 Strategy Maintenance

Type [ Select- =]

cancel _|[_gave +Repeat |[_Done |

Create Pricing Strategy Workspace
1. Inthe Type field, select Maintain Margin.
2. Click Next. Additional strategy fields appear.

I(:' Strategy Maintenance

= =
= =
= [
= =
=
=
Define Strategy Details ||

Maintain margin strategy fields
Enter the ID of the merchandise level you want to apply the strategy to, or click the

3.
LOV El button and select the appropriate merchandise level.

Note: You must enter a department. Subsequent
merchandise levels are enabled as you add the level above, if
the definition of the department in the aggregation level

dialog allows it.

4. Select the zones for the strategy:
Zone Group: Enter the ID of the zone group that contains the locations to add to

the price strategy, or click the LOV & button and select a zone group.
Zone: Enter the ID of the zone to add to the price strategy, or click the LOV

button and select a zone.
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In the Price Guides field, enter the ID of the Price Guide field, or click the LOV
button and select a price guide.

Note: Only price guides associated with the selected
departments can be selected.

In the Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV =l button and select a calendar.

In the Suspend field, select the check box to indicate that reviews of the existing
strategy are stopped.

Note: Clear the check box to indicate the review periods
should begin in the next period.

In the New Calendar field, enter the ID of the calendar you want to associate with the
strategy, or click the LOV =l button and select a calendar.

Note: You must select the Suspend check box before you can
add a new calendar.

Click Define Strategy Details. The Margin Strategy Details pane opens.

I'(_:' Maintain Margin Strategy Details

Auto Approve [ ¥ Cost Change Forward Days “ |

* WMethod () Market Basket Margin

f | Current Margin

* Reference Competitors

Competitor Competitor Store Compete Type Percent

=
= = paten [~
e[ =8
o[ B
= = paten |71

Maintain margin strategy details

Define Maintain Margin Strategy Details

1.

Select the Auto Approve check box to indicate price changes should be created in
Approved status.

In the Cost Change Forward Days, enter the number of days into the next review
period that the strategy will consider cost changes when proposing price changes.

Note: Cost Change Forward Days should not exceed the
length of a review period.

Select the method for the strategy:

= Market Basket Margin: Select to have the margin for the item's market basket
applied to the item's new cost. The Margin Strategy Details area appears.
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I@ Maintain Margin $trategy Details

Auto Approve D * Cost change Forward Days

* Mathod (®)[Market Basket Margin

() current Margin

T

Margin Strategy Details I

Code Margin Target Acceptable Range From Acceptable Range To |

+ Reference Competitors

Competitor Store Compete Type Percent
M atch

Competitor

[
il I 0 o m
!!!H

Match
Match

Match

Margin strategy details

*  Current Margin: Select to have the current margin applied to the item's new cost.
The current margin fields enable.

I@ Maintain Margin Strategy Details

Auto Approve [ ¥ Cazt Change Forward Days
* Mathad (0) Market Basket Margin Increase () Margin %
@' Current Margin ':' Change by Cost Change Armount
Decrease () Margin %

(") Change by Cost Change Amount

+ Reference Competitors
Competitor Store Compete Type Percent

Match

Competitor

Kl

Match

Match

[
i 0 o
!!

Current margin increase and decrease fields

Define Market Basket Margin

1. Inthe Code drop-down, select the margin market basket code you want to use to set
the price.

2. Inthe Margin Target field, enter the percent of margin you want to earn on the
item/ zone.
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3. Set up the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. Inthe Acceptable Range To field, enter the top of the range.

Click Apply. An entry is added to the Maintain Strategy Details table.
Define reference competitors as necessary.

6. Click Done to save any changes and close the workspace.

Define Current Margin
1. Select how the strategy will apply an increase in margin to a proposed retail:

=  Margin %: Select to have the percent of the cost change added to the basis retail
to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
added to the basis retail.

2. Select how the strategy will apply a decrease in margin to a proposed retail:

= Margin %: Select to have the percent of the cost change subtracted from the basis
retail to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
subtracted from the basis retail.

3. Click Done to save any changes and close the workspace.

Define Reference Competitors

1. In the Reference Competitors section, enter the ID of the competitor in the
Competitor field, or click the LOV El button and select a competitor.

2. In the Competitor Store field, enter the ID of the store, or click the LOV =l button
and select a store.

3. Inthe Compete Type, select how to compare prices to the reference competitors:

=  Match: A pass or fail indicator appears on the worksheet depending on if the
proposed price matches the referenced competitors price.

= Price Above: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent above the referenced
competitor's price.

= Price Below: A pass or fail indicator appears on the worksheet depending on if
the proposed price is at least the specified percent below the referenced
competitor's price.

4. If you selected Price Above or Price Below, enter the percent above or below the
competitor's price that the new price is compared.

5. Click Done to save any changes and close the workspace.
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Edit a Maintain Margin Pricing Strategy
Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to edit.

I@ Pricing Strategy Search

Price Strategy Id | Type Maintain Margin | B+ Maintsin Margin

Class .+ Zone .+

Subclass .+
Calendar Status |- Select - E|

o seam |

Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.

I@ Pricing Strategies List |

Pricing Strategies List | &
Price Strategy Department I{ Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone 2
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 S51|QAz Dept

2001 50(QAl Dept

2022 50(QAl Dept

1061 50(QAl Dept s0|qal Class 50{QA1 SubCla..

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.

1 51|QAz Dept S511|qaz Class S5111[0A2 SubCla.

1943 S1|QAZ Dept S11[{QAZ Class SEZZ|QAZ SubCla..,

2023 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

zo0z 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2003 50(QAl Dept s0|qal Class 50{QA1 SubCla..,

2004 3|test3 1|test3 2|testl

2005 50(QAl Dept s0|qal Class 50{QA1 SubCla..

2041 1414 Activewsar 1000|Sparts Cloth.,., 1000(Mens Sports..,
4 »

| [peiete |[_eax |

Pricing Strategies List Pane

From the Pricing Strategies List, select the strategy you want to edit.

Click Edit, or double-click the strategy selected. The Strategy Maintenance pane
opens, and the fields that can be changed are enabled.
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I-/(Q Strategy Maintenance |

8
8
Discount Percent l:l
I
Markdown Number Discount Percent Days after First
| Edit || Fernove Markdown

Strategy Maintenance Pane

5. Make necessary changes.

Edit a Price Guide
Enter the price guide name, or click the LOV B button and select the price guide.

Change Calendars

Note: In order to specify a new calendar, the existing
calendar must be suspended.

1. Select the Suspend check box.

2. Enter a calendar name, or click the LOV % button and select a calendar

Edit Maintain Margin Details

1. Select the Auto Approve check box to indicate that price changes should be created
in Approved status.

2. Inthe Cost Change Forward Days, enter the number of days into the next review
period that the strategy will consider cost changes when proposing price changes.

Note: Cost Change Forward Days should not exceed the
length of a review period.
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3. Select the method for the strategy:

= Market Basket Margin: Select to have the margin for the item's market basket
applied to the item's new cost. The Margin Strategy Details area appears.

Auto Approve D * Cost Change Forward Days |2 |

* Method (@) |Market Basket Margin

| ! Current Margin

N " S
Margin Strategy Details " @;
Code Margin Target Acceptable Range From Acceptable Range To |

Margin Strategy Details

= Current Margin: Select to have the current margin applied to the item's new cost.

Edit Market Basket Margin

1. Inthe Code drop-down, select the margin market basket code you want to use to set
the price.

2. Inthe Margin Target field, enter the percent of margin you want to earn on the
item/zone.

3. Set up the acceptable range:

Note: Acceptable range is the amount by percentage that a
margin can vary from the target before a price change is
proposed.

a. Inthe Acceptable Range From field, enter the bottom of the range.
b. In the Acceptable Range To field, enter the top of the range.

Click Apply. An entry is added to the Maintain Strategy Details table.
Define reference competitors as necessary.

Click Done to save any changes and close the workspace.

Edit Current Margin
1. Select how the strategy will apply an increase in margin to a proposed retail:

= Margin %: Select to have the percent of the cost change added to the basis retail
to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
added to the basis retail.
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2. Select how the strategy will apply a decrease in margin to a proposed retail:

=  Margin %: Select to have the percent of the cost change subtracted from the basis
retail to determine the proposed retail.

= Change by Cost Change Amount: Select to have the amount of the cost change
subtracted from the basis retail.

1. Click Done to save any changes and close the workspace.

Edit Reference Competitors
Define reference competitors as necessary.

Complete the Margin Price Strategy
1. Click Save + Repeat to commit your changes.

2. Click Done to save any changes and close the workspace.

Delete a Pricing Strategy

Navigate: From Task Pad, select Pricing Strategy > Maintain Pricing Strategy. The
Maintain Pricing Strategy workspace opens.

1. In the Pricing Strategy Search pane, enter criteria as needed to find the pricing
strategy you want to delete.

I(:' Pricing Strategy Search

Price Strategy Id | Tepe Clearance Defaul +
= =
= =

Calendar Status |- Select - E‘

| [ciesr | [seamen ||
Pricing Strategy Search Pane

2. Click Search. The results of your search are listed in the Pricing Strategies List pane.
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(C—‘) Pricing Strategies List

Pricing Strategies List | &
Price Strategy Department I{ Department | Class Id Class Subclass Id | Subclass Zone Group | Zone Group Id Zone Z
Fitber by | ||| Fitter by | ||| Fitber bp:| TN Filber by:| T N| Fitber by | ®||| Fitker by | ®||| Fitker by:| T ||| Fitker by:| T ||| Fitter by | T ||| Fitter by T A

1942 51|QA2 Dept

2001 S0/QA1 Dept

2022 S0[QAl Dept

1061 S0/QA1 Dept 50|QAl Class 50/Qa1 SubCla.,

1062 11|izcqa_integr. 1liscqa_inteqgr. 1liscqa_inteqgr.
1 51|QA2 Dept S511|0A2 Class 5111|042 SubCla..

1943 S1|QAZ Dept S11{QAZ Class SEZZ|QAZ SubCla..,

2023 S0|QA1 Dept 50|Qal Class 50/Qa1 SubCla.,

2002 50|QAa1 Dept 50|QAl Class 50|QAa1 SubCla..,

2003 S0/QA1 Dept 50|Qal Class 50/Qa1 SubCla.,

2004 3|test3 1|test3 2|testl

2005 S0/QA1 Dept 50|QAl Class 50/Qa1 SubCla.,

2041 1414(Activewear 1000|Sports Clath.., 1000(Mens Sparts..,

b

|

Pricing Strategies List Pane

Click Yes.

o 0k~ w
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Click Done to close the window.

Click Delete. You are prompted to confirm your decision.

From the Pricing Strategies List, select the strategy you want to delete.



6

Worksheets

RPM uses strategies, calendars, and item/location information to automatically generate
worksheets. The Worksheet functionality allows you to maintain the proposed price
changes automatically generated by RPM.

The worksheet may contain many different columns.

Worksheet Detail

The Worksheet Detail workspace allows you to:

Review the auto generated price change proposals.

Review items that met rules or were exceptions.

Make clearance decisions.

Delete the Pricing Worksheet if no price changes need to be made.

Examine the information about price change proposals and make decisions about
which items to change and what retail prices to set.

Modify column values.

Perform what-if analysis on the Worksheet to help you make the best pricing
decisions.

Export the worksheet to a Comma Separated Value (csv) file that can be opened in
other applications such as spreadsheets and work processors.

Worksheet Columns

The worksheet may contain many different columns. See the descriptions and
calculations for each column below.

Column Description Editable | Calculation
% off Regular Retail | The percent difference between No Price Change Amount divided by Basis
the basis regular retail and the Regular Retail (Before VAT)
new retail of the item. Depending on your aggregation level
settings:

Price Change Amount = Current Retail -
New Retail

Price Change Amount = New Retail -
Current Retail

The zone level regular retail is used if it
exists.
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competitor C and the strategy
rules is met. "Fail" appears if the
strategy rule is not met.

Column Description Editable | Calculation

% off Basis Retail The percent difference between | No Price Change Amount divided by Basis
the basis retail (regular or Retail (Before VAT)
clea'rance) and the new retail of Price Change Amount equals the difference
the item. between the New Retail and the Clearance
This value is the same as % off or Regular Retail
Regular Retail if there is no Depending on your aggregation level
clearance retail. settings:

Price Change Amount = Current Retail -
New Retail

Price Change Amount = New Retalil -
Current Retail

The zone level clearance retail is used if it
exists.

Base Cost The base cost of the item on the No When the record is at a zone level, the zone
effective date (including price level base cost is used in the calculation if
change processing days). one exists.

Basis Cost The pricing cost of the item on No When the record is at a zone level, the zone
the effective date (including price level basis cost is used in the calculation if
change processing days). one exists.

Class ID The class hierarchy ID of the No
item's class.

Class Description The name of the class. No

Clearance Indicator | Checked and disabled if the item | Yes
is on active clearance. Unchecked
if the item is not on clearance.

Clearance Hyperlink that opens a window | No
with details on approved
clearances. "Pending" appears if
the item is on a pending
clearance.

Competitor A Alert | "Pass"appears if there is a No
competitor A and the strategy
rules is met. "Fail" appears if the
strategy rule is not met.

Competitor A Retail | Competitor A's retail price. No

Competitor B Alert | "Pass" appears if there is a No
competitor B and the strategy
rules is met. "Fail" appears if the
strategy rule is not met.

Competitor B Retail | Competitor B's retail price. No

Competitor C Alert | "Pass" appears if there is a No
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Column Description Editable | Calculation
Competitor C Retail | Competitor C's retail price. No
Competitor D Alert | "Pass" appears if there is a No
competitor D and the strategy
rules is met. "Fail" appears if the
strategy rule is not met.
Competitor D Retail | Competitor D's retail price. No
Competitor E Alert | "Pass" appears if there is a No
competitor E and the strategy
rules is met. "Fail" appears if the
strategy rule is not met.
Competitor E Retail | Competitor E's retail price. No
Conflict An exclamation point appears if | No When conflict checking is run again or the
conflicts were found during price change is taken or not taken, the
conflict checking. column is reset.
Cost Changes "Yes" appears if there are No
During Review approved cost changes that have
Period an effective date during the
review period of the worksheet.
Current Clearance The clearance retail for today if No The zone level clearance retail appears if it
Retail the item is on clearance. exits.
Current Clearance The unit of measure for the item | No
Retail UOM clearance price.
Basis Retail The active retail (regular or No The zone level basis retail appears if it
clearance) on the effective date exists.
before the current price change.
Basis Retail UOM The unit of measure for the item | No
basis retail.
Basis Retail Multi- The active multi-unit retail on the | No The zone level multi-unit retail appears if it
units effective date before the current exists.
price change.
Basis Multi-unit The active multi-unit retail on the | No
Retail effective date before the current
price change.
Basis Multi-unit The unit of measure for the active | No
Retail UOM multi-unit retail on the effective
date before the current price
change.
Current Cost The pricing cost today. No
Current Cost The cost markup of the item No Current Retail (regular or clearance, before

Markup %.

based on current cost and current
retail.

VAT) minus Current Cost divided by
Current Cost.

The zone level current cost is used if it
exists.
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the item based on the locations in
the row.

Column Description Editable | Calculation
Current Retail The retail markup of the item No Current Retail (regular or clearance, before
Markup % based on current cost and current VAT) minus Current cost divided by
retail. Current Retail.
The zone level current cost is used if it
exists.
Current Multi-Units | The unit value of the multi-unit | No The primary zone current multi-units will
retail price. appear if it exists.
For example: "2 ea." if there is a 2
for $5 multi-unit retail.
Current Multi-units | The retail value of the multi-unit | No
Retail retail price.
For example: "$5.00" if there is a 2
for $5 multi-unit retail.
Current Multi-units | The unit of measure for the item | No
UOM multi-unit.
Current Regular The item's regular retail value No The zone level current retail appears if it
Retail today. exists.
Current Retail UOM | The selling unit of measure for No
the current retail.
Current The regular retail value per unit | No Current Retail divided by Package UOM
Retail/UOM of measure in the package today.
For example: ".05/0z" if there is a
16 oz. can of soup that retails for
89.
Diff One The differentiator 1 value for a No
transaction level item.
Diff Two The differentiator 2 value for a No
transaction level item.
Diff Three The differentiator 3 value for a No
transaction level item.
Diff Four The differentiator 4 value for a No
transaction level item.
Effective Date The date that price change goes | Yes End of Review Period plus Price Change
into effect. Processing Days
New Item Location | An indicator appears if the No
Ind item/location is a new
combination in RPM.
First Received Date | The date this item was first No
received into the location.
Historical Sales The monetary historical sales of | No The weekly, monthly, half-yearly, or yearly

historical sales depending on aggregation
level setting.
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Column Description Editable | Calculation
Historical Sales The retail sales of the item for the | No The weekly, monthly, half-yearly, or yearly
Units current period. historical sales depending on aggregation
level setting.
Item Description The name of the item. No
Item ID The transaction or parent item ID. | No
Last Cost Change The date of the last cost change. | No
Note: Place the cursor over this
field to show the average or
highest cost of the item over the
locations in the zone
Last Price Change The date of last price change. No
Note: Place the cursor over this
field to show the items zone
price.
Last Received Date [ The date the item was last No
received into the location.
Link Code The link code assigned to the No
transaction level item.
A hyperlink opens a link code
information window.
Proposed Retail The markdown number if there is | No
Markdown #. a proposed clearance price
change.
Margin Market The market basket code for No
Basket Code transaction level items if one
exists.
Cost Markup %. On | The cost markup of the item No New Retail minus Basis Cost divided by
New Retail based on new cost and new retail. Basis Cost
The zone level basis cost is used if it exists.
New Multi-Units The unit value of the new multi- | Yes
unit retail price.
For example: "2 ea." if there is a 2
for $5 multi-unit retail.
New Multi-units The retail value of the new multi- | Yes
Retail unit retail price.
For example: "$5.00" if there is a 2
for $5 multi-unit retail.
New Multi-units The unit of measure of the new Yes

UOM

item multi-unit.

For example: ea. if there is a 2 for
$5 multi-unit retail.
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Column Description Editable | Calculation
New Retail The new proposed retail value for | Yes
the effective date.
Edit this field to override the
proposed price.
New Retail/ UOM The new retail value per unitof |No New Retail divided by the Unit Of Measure.
measure.
For example: ".05/0z" if there is a
16 oz. can of soup that retails for
.89
New Retail Markup | The percent retail sales margin of | No New Retail minus New Cost divided by
% the item based on the new retail. New Retail (Before VAT)
The zone level basis cost if used if it exists.
New Retail UOM The unit of measure for the item's | Yes
new retail.
If you enter a new retail, New
Retail UOM is required.
Original Retail The original retail of the item. No
Out of Stock Date The out of stock day for clearance | Yes Default Out of Stock Days after the effective
price changes. date
You can change this field.
Package Size The package size of the item. No
Package UOM The package unit of measure of | No
the item.
Parent ID The parent item ID if the No
worksheet is at transaction item
level and the item has a parent.
Parent Item The name of the parent item. No
Description
Pending Cost The date of the earliest pending | No
Changes cost change for the item for the
primary supplier.
A hyperlink opens a link to a
window with more information.
Price Change The monetary value of the price | No New Retail minus Basis Retail at the location
Amount change for one unit of that item.

Depending on your aggregation level
settings:

Price Change Amount = Basis Retail - New
Retail

Price Change Amount = New Retail -
Current Basis

The zone level basis retail is used if it exists.
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Column

Description

Editable

Calculation

Price Change
Indicator

Select "Take" to accept the
proposed price change for the
transaction level item and lock
the row for editing.

Select "Don't Take" to reject the
proposed price change and lock
the row for editing.

Yes

Price Changes

A hyperlink "NONE" if no price
changes exist during review
period.

A hyperlink "Pending" if price
changes exist during review
period. Click the hyperlink to
view pending price change
records.

Note: During the review period

means between today's date and
the end of the review period.

Primary Competitor
Alert

"Pass" appears if there is a
primary competitor and the
strategy rules is met. "Fail"
appears if the strategy rule is not
met.

Primary Competitor
Retail Changed Ind

"Yes" when a new or updated
competitor retail is brought into
RPM.

Note: If more than one strategy
uses the same competitor, "Yes"
will only appear in the worksheet
for the first strategy to find it.

Primary Competitor
Retail

The primary competitor's retail.

Primary Competitor
Retail UOM.

The items selling unit of measure
for the primary competitor.

Primary Competitor
Multi-Units

The unit value of the multi-unit
retail price on the most recent
shop date.

For example: "2" if there is a 2 for
$5 multi-unit retail

Primary Competitor
Multi-Unit Retail

The primary competitor's multi-
unit retail with the number of
units on the most recent shop
date.

For example: 2 for $5

Primary Competitor
Multi-units UOM.

The items unit of measure for the
multi-unit price on the most
recent shop date.
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Column Description Editable | Calculation
Primary Supplier The primary supplier ID for the | No
item.
Note: Place the cursor over this
field to view the supplier name.
Promotions Hyperlink that opens a window | No
with details on approved current
or pending (after the effective
date of the current price change)
promotions.
Proposed Cost The cost markup of the item No Proposed Retail minus Basis Cost divided
Markup %. based on proposed retail and by Basis Cost.
basis cost. The zone level basis cost is used if it exists.
Proposed Retail The retail on the proposed No Proposed Effective Date plus Price Prior
effective date. Create Days
Proposed The proposed retail per unit of No Proposed Retail divided by Package UOM
Retail/UOM measure in the package.
For example: ".05/0z" if there is a
16 oz. can of soup that retails for
89
Proposed Retail The unit of measure for the item's | No
UOM proposed retail.
Proposed Retail The retail sales margin of the item | No Proposed Retail minus Basis Cost divided
Markup % based on the new retail. by Proposed Retail (Before VAT)
The zone level basis cost if used if it exists.
For zone level records, if a zone level basis
cost exists, use that value in the calculation
Replenishment "Yes" if the item is on an active No
Indicator replenishment record.
Reset Date The reset date for the item. Enter | Yes Defaults to Out of Stock Date plus one day
a date to change the default.
Retail Label Type The retail label type of the item. | No
Retail Label Value The retail label value of the item. | No
Price Zone Group ID | The price zone group ID for a No
zone level item.
Note: Place the cursor over this
field to view the price zone group
description.
Price Zone ID The price zone ID for a zone level | No
item.
Note: The price zone description
is available as a mouse over.
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Column Description Editable | Calculation
Rule Binocular icon appears if the item | No
meets rules.
Click the icon to open a window
and view details of the rules met
by the record.
Projected Sales Units | The smoothed average regular No Total Sales divided by Total Weeks of Sales
price sales based on the number
of weeks of sales that have
occurred.
Sales Change The difference between the items | No Depending on your aggregation level
Amount new retail and the basis retail on settings:
the effective date multiplied by Sales Change Amount = Basis Retail - New
the projected sales for a week. Retail
Sales Change Amount = New Retail -
Current Basis
On Worksheet Status the sum of all
individual records. On Worksheet Detail per
item.
Seasonal Sell Thru % | The sell through percent for the | No Total Sales For the Season divided by Stock
current season. Total sales for the On Hand
stores in the zone or location Depending on your aggregation level
divided by stock on hand for the settings Warehouse Stock On Hand will be
zone/location. included or excluded.
Season/Phase Hyperlink opens Season/Phase | No
detail window.
Sell Thru % The sell through percent for store | No Sales divided by (Stock On Hand plus Sales)
locations in the zone. Depending on your aggregation level
settings Warehouse Stock On Hand will be
included or excluded.
The type of sales and the amount of time to
be considered is determined by the Sales
Calculation Method.
State The status of the details of the No
record.
Store On Hand The current stock on hand at No
store locations.
Store On Order The total on order qty for all No
stores in the price zone.
Note: On order is in the single
unit size of the item, not case size.
Store total inventory | Total inventory for all stores in No Store On Hand plus Store On Order plus

the zone.

Store In_Transit + Store OBNP_INV
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in the zone.

Column Description Editable | Calculation
Subclass ID The subclass hierarchy ID of the | No
item's subclass.
Note: Place the cursor over the
field to view the subclass
description.
UDA Hyperlink opens UDA No
information for the item if it
exists.
VPN The VPN for the primary No
supplier of the item.
Weeks of Sales The number of weeks the item No
Exposure has had sales exposure (on had at
location).
Weeks Since First The number of weeks since the No
Sale items first sale.
Total Inventory Total inventory for the No Total Warehouse Inventory plus Total Store
item/location. Inventory
WH Stock On Hand | The current stock on hand at No
warehouse locations in.
Warehouse On Total on order qty for all stores in | No
Order the price zone.
Note: On order is in the single
unit size of the item, not case size.
WH total Inventory [ The total inventory for all stores [ No Warehouse On Hand plus Warehouse On

Order plus Warehouse In Transit

Change the Value in a Cell

1.
2.

Double click the cell.

Enter a value, change a value, or select from a drop-down list.

Change the Values of Multiple cells

1.

Press and hold the Ctrl key while selecting cells or column headings to select

multiple cells or columns.

Right click on the selected cells or columns. A window appears that allows you to

edit the value for all selected cells.

3

Price Change Indicator

Edited Yalue

oaec- o]

| Apply

|| Cancel |

Example Edit Value Window

Enter a value, change a value, or select from a drop-down list.
Click OK. The values for all selected cells change.
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Maintain Columns

You can edit the worksheet to display only the columns you are concerned with, change
the order the columns display, and change the number of rows that appear.

Hide and Position Columns

5.

In the Worksheet Details pane, click the E button.

Select Column Display and Ordering... from the drop-down menu. The Column
Display and Ordering window opens.
X

Column Display and Ordering

Hide these columns: Show these columns:

Mew Retail -~
Itern ID

% off Regular Retail El
% off Baziz Retail

Baze Cost El
Basziz Cost
Class Id

4 |

| Cancel || 0K |

Column Display and Ordering Window

To hide columns:

a. Select a column to hide in the Show these columns pane.

b. Click the [«] button. The column name appears in the Hide these columns pane.
c. Repeat the steps above to hide additional columns.

To hide individual columns, right-click on the column heading in the Worksheet
Details pane and select Hide Column from the drop-down menu.

To position columns:

a. Select a column to re-position in the Show these columns pane.

b. Click the . |and [ buttons as necessary to move the columns. This
determines the position of the columns from left to right.

c. Repeat the steps above to re-position additional columns.

To reposition individual columns, click on the column heading in the Worksheet
Details pane and drag it to the desired position.

Click OK. The worksheet columns are repositioned to reflect your changes.

Sort the Worksheet

In the Worksheet Details pane, click the E button.

Select Sort Table... from the drop-down menu. The Column Display and Ordering
window opens.

Set the sort order of the worksheet:

a. Select a column from the Columns pane.

b. Click the [*_| button. The column name appears in the Priority Column pane.
c. Repeat the steps above to move additional columns.
d

Select a column in the Priority Column pane.
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g.

Click the =] and [ ™| buttons as necessary to move the columns. This
determines the order by which the worksheet information is sorted.

Clear the Ascending column to have the column sort date in a descending
manner.

Repeat the steps above as necessary.

4. Click OK. The worksheet columns are sorted to reflect your changes.

To sort based on individual columns, right-click on the column heading in the Worksheet
Details pane and select either Make Primary Sort, Ascending or Make Primary Sort,
Descending from the drop-down menu.

Adjust the Size of the Worksheet Content

In the Worksheet Details pane, click the E button.

Move the cursor over Size Content.

3. Select from the drop-down menu:

Smallest
Smaller
Standard
Larger
Largest
Fit All

4. The size of the content on the worksheet is adjusted.

Adjust Column Sizes

In the Worksheet Details pane, click the E button.

Move the cursor over Column Resizing in the drop-down menu.

3. Select from the drop-down menu:

Adjust Next Column Only
Adjust Subsequent Columns
Adjust Last Column Only
Adjust All Columns

4. The worksheet columns are adjusted.

To resize individual columns, position the cursor on the right-hand border of the column
heading. The cursor will change to a double arrow. Click and drag right or left to resize
the column.
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Set Non-Scrolling Columns

You can set up to seven columns to be locked or non-scrolling. This allows comparison of
values in the locked columns to all other columns in the worksheet.

In the Worksheet Details pane, click the E button.

2. Select Column Locking from the drop-down menu. The Column Locking dialog
opens.

Column Locking [‘5_<|

Murnber of calumnsz to be locked [0 ta 7) IZI

| Cancel || 0K |

Column Locking Dialog

Enter the number of columns to lock.
4. Click OK. The columns are locked (non-scrolling).

Maintain Views

Add a View
1. Click Maintain View. The Maintain View dialog opens.
I
Default Description Corporate |
Corp O —
Faberl ]
Faberz O
Faberz | |
fabers O
ITEM-ZOME | —]
pci firzt 1 d
Maintain View Dialog
2. Click Add. A new line appears in the list.
3. Enter a name for the view in the Description field.
4. Select the Default View checkbox if you would like the view you created to be the
default view.
5. Click Save. The view is saved and is accessible from the drop-down at the top of the
Worksheet Details pane.
Delete a View
1. Select the view you want to delete from the list.
2. (Click Delete. The view is removed from the list.
Select a View

Select a saved view from the drop-down list.
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Apply Filters

Since worksheets may contain many detail records, RPM gives you the ability to filter
those records so you see only the details that need attention. You can perform an ad hoc
filter on any column in the Worksheet Detail or you can create and save an advanced
filter that you can continue to use in the future.

Apply an Ad Hoc Filter

In the Worksheet Details pane, select a value from the Filter by: drop-down above the
column you wish to filter the worksheet by. The worksheet refreshes, with the filter
applied.

Clear an Ad Hoc Filter

In the Worksheet Details pane, select Clear Filter from the Filter by: drop-down above the
column that the filter was applied to. The filter is cleared and the worksheet returns to its
previous state.

Note: Any other filters applied will still be applied to the
worksheet.

Clear All Filters

In the Worksheet Details pane, select Revert to Default from the Filter by: drop-down
above any column. The filters are cleared and the worksheet returns to its original state.

Apply an Advanced Filter

Note: Advanced filters override any ad hoc filters previously
applied to the worksheet.

1. Inthe Worksheet Details pane, select Advanced Filter from the Filter by: drop-down
above the column you wish to filter the worksheet by. The Advanced Filter dialog

opens.
Advanced Filter E|
Show rows where
Mew Retail |is equal to IEI
| =]
|(none) IEI
| Cancel || 0K |

Advanced Filter Dialog

Select a condition to apply to the column from the top drop-down in the dialog.
Enter or select a value for the filter to look for in the next drop-down.

You may enter an additional condition and value in the remaining drop-downs.
Select a logical operator (And or Or) in the area between the drop-downs.

Click OK to apply the filter to the worksheet. The worksheet refreshes, with the filter
applied.

S T
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Maintain Worksheet Detalil Filters

In the Worksheet Details pane, click the Filter | 2| button. The Worksheet Detail Filter
window opens.

Worksheet Detail Filter X

Filter [select- [] [ _SaveFikerss .. |[ Delete Filter | [_Apply Filter |
Column | condition [ vatue ‘
Remoue 2l
Filter on & Column or 2 Value  (0) Column
@ value
Column [~ select - E‘ Condition |- salect - E Value “ Add Criteria

Worksheet Detail Filter Window

Note: Click the clear filter button to remove the filter
criteria.

Create a Worksheet Detail Filter

1.

Select Column to have the filter compare the values in two columns.
Or
Select Value to have the filter match a value in a column.

Select a column to filter by from the Column drop-down.
Select a condition to apply to the filter from the Condition drop-down.

Select a column to compare to the previous column in the Column drop-down if you
chose to filter by column above.

Or

Select of Enter a value for the filter to look for in the next field if you chose to filter by
value above.

Click Add Criteria. The criteria is added to the Worksheet Detail Filter table.
Repeat the steps above to continue adding criteria. Continue to the next step.
Click Save As to save the filter.

Enter a name for the filter in the Save Filter dialog.

Apply a Worksheet Detail Filter

1.
2.
3.

Select a filter from the Filter drop-down.
Select criteria from the Worksheet Detail Filter table. You can select multiple criteria.

Click Apply Filter. The Worksheet Detail Filter window is closed and the filter is
applied.
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Delete Worksheet Detail Filter Criteria
1. Select a filter from the Filter drop-down .
2. Select criteria from the Worksheet Detail Filter table.

3. Click Remove Criteria. The criteria is removed from the filter. Click Remove All, to
remove all criteria from the filter.

Delete a Worksheet Detail Filter
1. Select a filter from the Filter drop-down.
2. Click Delete Filter. The filter is removed from the Filter drop-down.
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View Conflict Check Results

The Conflict Check Results workspace allows you to review the results of background
conflict checking for worksheets, price changes, promotions, and clearances. If the
background conflict checking system option is selected, conflict reviews occur in the
background, or when the system is not busy performing other tasks. An alert appears in
the Conflict column of the worksheet, price change, promotion, or clearance maintenance
pane when conflict checking is complete. At that time, follow the procedures below to
view the results of background conflict checking.

When background conflict checking is off the system performs conflict checks
immediately when Conflict Check is clicked from the Price Change, Promotions, or
Clearances workspaces.

View Conflict Check Results

Navigate: From Task Pad, select Conflict Check Results > View Conflict Check Results.
The Conflict Check Results workspace opens.

73 conflict Check Results
I
Event Type | ID Promotion Co Promotion Col Department | Class Subclass Zone Result Result Date
| Filkar bylzl | Fifkar bylzl |F.l'!te.v bylzl | Filkar bylzl | Filkar bylzl |F.l'!ter bylzl | Filkar bylzl | Fitkar bylzl |F.l'!te.v bylzl |F.l'!ter bylzl
Warkzheat 1 200 Ma Conflict.,. | 03/01/2005
4 »

Conflict Check Results Workspace.

Select the conflict results you want to view.
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Delete Conflict Check Results

1. Select the conflict results to delete.
2. Click Delete.

Worksheet Status

Maintain a Pricing Worksheet

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

739 worksheet Status
II’EJ Worksheet Status |
Reazon | |@ Apply
adion |- selact - 4|
I
Merchandise Level | Merchandise ID Location Level | Location ID Location Status| Conflict| Last Review Date | Reas
Filker by: :I Fitter by: :l Filter by: :l Filker by: :I Fitker by: :l |F_.')tlz| Fitke :l Fitker by :l Fitkd
Cepartment 2064 f 03-0 =]
Cepartment 2 Zoneg 2 21 Mew 0z-02-200%
4] »
Select All || Unselec All || Worksheet Detail
Total Price Change Amount 40,00
Total Price Change S0OH o
Total Price Change Items 5
Total Sales Amount 0,00

Worksheet Status Workspace

1. Select the worksheet you want to maintain.

Note: You can select multiple worksheets as long as they are
for the same department and currency.

2. Click Worksheet Detail to maintain the details of the worksheet.
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Submit a Pricing Worksheet for Approval

The Pricing Worksheet status must be In Progress to enable the Submit action. To change
the status of the Pricing Worksheet from New or Updated to In Progress, you need to
have at least one row or item selected for price change.

1. Select the worksheet that you want to submit.
2. Review the information in the Worksheet Status window to ensure that it is correct.

3. From the Action drop-down list, click Submit.

Note: The status options that are available from the Action
drop-down list change based on current status of the
worksheet's details.

4. Click Apply. The status is changed to Submitted and the Pricing Worksheet is ready
for approval.

Note: Before the status changes to Submitted, RPM checks
the pricing worksheet to ensure that there are no conflicts.

Approve a Pricing Worksheet

Note: The Pricing Worksheet status must be in either
Submitted or Delete Pending status before you can select the
approve action.

1. Select the worksheet that you want to approve.

2. When you are ready to approve the submitted or delete pending Pricing Worksheet,
select Approve.

3. Click Apply. The Pricing Worksheet information is saved and applied.

Note: For worksheets in Submitted status, before the status
changes to Approved, RPM checks the Pricing Worksheet to
ensure that there are no conflicts. Delete pending status
worksheets are not conflict checked before being moved to
Deleted status.

When the system option, Dynamic Area Differentials is off,
secondary area worksheets are enabled when the primary
area is approved. When the system option is on, changes to
secondary areas happen dynamically after changes to the
primary area.

Reject a Pricing Worksheet

You can reject a Pricing Worksheet that has a status of Submitted or Delete Pending.
When you reject a submitted or delete pending Pricing Worksheet, its status changes to
Rejected or Delete Rejected.

Note: If you want to work with the Pricing Worksheet when
its status is Rejected, Reset the status of the Pricing
Worksheet (see the procedure below).
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1. Select the worksheet that you want to reject.

2. You can enter a Reason for the rejection in the Reason field. Click the £ button to
open an editing window where you can enter a reason up to 250 characters long.
From the Action drop-down list, select Reject.

4. Click Apply. The status of the Pricing Worksheet changes to Rejected or Delete
Rejected.

Reset the Status of a Pricing Worksheet
Use the Reset action to return the worksheet to its previous status.
1. Select the worksheet that you need to reset the status of.
2. From the Action drop-down list, select Reset.

3. Click Apply. The Worksheet Status window refreshes and the worksheet is returned
to its previous status.

Delete a Pricing Worksheet
1. Select the worksheet that you want to delete.
2. From the Action drop-down list, select Delete.

3. Click Apply. The Pricing Worksheet is moved to Delete Pending status and is ready
to have your deletion approved or rejected.

Note: The options that are available from the Action drop-
down list change based on worksheet's current status.
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Worksheet Detail

Maintain Worksheet Details

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

%5 worksheet Status
I@ Worksheet Status |
Reaszon | |@ Apply
Action [ select - =l
I
Merchandise Level | Merchandise ID Location Level | Location ID Location Status | Conflict| Last Review Date | Reas
Filker by : w | Fitrer by || Fitver by ||| Filber by ||| Fitker by ||| AT | A | | Fiber by it (NERES
Departrent 02-01-2005
Department 2 Zone a2 21 Hew 03-02-2005
4] 3
Select All || Unseladt All || Wwarkzhesat Datail |
Total Price Change Amount $0.00
Total Price Change SCOH o
Total Price Change Itermns 5
Total Sales Armount £0.00

Worksheet Status Workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

2. Click Worksheet Detail. The Worksheet Details workspace opens.
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%5 worksheet Details
@ Worksheet Details |
Itern Level 'Tran Level lEI
cotin Save View . . . D .
| & | - =]
I
Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H
Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
1901 RDP CMLTE 0,00 o i 5]
1910 RDP Item for RPM 0.00 0 i 5]
1911 RDP item for RPM 0.00 0 i 5]
1360 RPD RPM itzm 0.00 o i 5]
1961 RDP RPM itzm 2 0.00 o i 5]
1952 RDP RPM Item 3 0.00 o 5
1370 RDF RPM Item 0.00 o i 5]
[« l »
| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||
| Cancel Il Save Il Cone I

Worksheet Details Workspace
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Merchandise Extract Iltem Deletions

Navigate: From the Task Pad, select Worksheet > Merchandise Extract Item Deletions.
The Worksheet Extract Item Deletions workspace opens.

73 Merchandise Extract Item Deletions

@ |
I
Pricing Strategy Merchandise Id Merchandise Level Zone Zone Group Date Item Count
Fitter by: [ ||[ Fter 8y [ ]|[ Fter 8y [ ||[Fteer by [ ]|[ Fiteer 8- [ ]| tear 8- [ |[Foeer 8y B4
2853 62 Diapartrmant Tade T4z 1zf1g/z002 422
2855 36 Clazs TdE T48 i1zf18fz002 1
2858 63 Drepartrment Taa T48 izf18fz002 44
2861 69 Diepartrment =11 753 i1zf18fz002 2
2881) 40 Class 746 T48 1zf18fz2002 &2
2882 &0 Department 746 T48 1z2f18fz2002 124
2883| 72 Department 752 T52 1zf18fz2002 2
3082|319 Subclazs 742 T48 12f18/2002 1
2083 &9 Department 742 T48 1zf18/z2002 4
2288 Ve Department 746 T48 1zf18/z2002 7
2344 Te Department 752 T52 1zf18/z2002 2
2365 Te Department 459 455 12f18/2002 =]
2568|632 Department 752 T52 12f18/2002 24
2708 40 Clazz 742 T48 1zf18/2002 124
2887 &0 Department 759 T52 1zf18/2002 S
aczl =50 Dlanartmant 4 4 1zHaian I
|
@ |
&
Ttem Location Reason Candidate Rule Name
Filter by [ ]|[ Fiteer by [v]|[Fter by [ ][ Fiteer oy [

Merchandise Extract Item Deletions Workspace

1. Double-click on the row on the summary table that you would like to see more detail.
The detail table is populated with the items and information that were excluded from
the resulting worksheet for the particular run of the merchandise extract.

2. Filter the detail results by selecting the appropriate drop-down menus.

Column

Definition

Area Differential Exclusion

Invalid Maintain Margin Cost

Invalid Secondary Item

Item/location combinations that have been excluded from a
Secondary Area Differential.

The strategy is maintain margin and the item/location does
not have a cost change in the cost review period.

Item/locations that meet one of the below:

Does not belong to any link code whereas the same item
belongs to a link code in the primary area.

Does not exist in the primary area AND does not belong
to any link code in the secondary area.

Belongs to a link code that does not exist in the primary
area.
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Column

Definition

Missing Link Item

New Item Location

No Cost
No Retail
Candidate Rule Exclusion

Variable Link Code

Variable Link MBC

Variable Link Selling UOM

Variable Link Vat Indicator

Variable Zone Selling UOM

When one or more item from a item-link code/zone group is

missing the entire group is excluded.

Item/locations that meet one of the below:

= If any one item from a Link code is present in the
worksheet, all items in the same Link code must also be
present in the worksheet.

=  [Items sharing the same Link code should have the same
Basis UOM.

=  [Items sharing the same Link code should all have the
same Class Vat Indicator settings.

=  For Margin and Maintain Margin Strategies, items
sharing the same Link code should have the same Margin
Market Basket code.

=  For Competitive Margin Strategies, items sharing the
same Link code should have the same Competitive
Market Basket code.

Item/locations that are not present in at the start of a review
period cannot be added in the middle of a review period.

No cost could be found for the item/location.
No retail could be found for the item/location.
The item/location meets a exclusion candidate rule.

The item does not have the same Link Code at all locations in
the zone.

The items sharing a market basket code do not have the same
Link Code at all locations in the zone.

The items sharing a link code do not have the same Basis
UOM at all locations in the zone.

The items sharing a link code do not have the same vat
indicator at all locations in the zone.

The item does not have the same Basis UOM at all locations in
the zone. The strategy is maintain margin and the
item/location does not have a cost change in the cost review
period.

Edit Proposed Retail Prices

Enter a new retail price in the New Retail field as required for each item.
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Take or Reject Proposed Price Changes

1.
2.

Select the level to view the worksheet at from the Item Level drop-down.

Change the Price Change Indicator field in the appropriate row:

Itermn Level 'Tran Level lEI
=
Mew Retail UOM | Price Change Indicator | Conflict State Promotion

3 | Filkar by lEI | Fitkar by - E | Fitkar by - IEI | Fitkar by - IEI | Fitkar by -
24| EACH hd e
50| EACH Hew

Tak
24| EACH =re Mew

Daon't Take
88| EACH FHew
0z EACH e
29 EACH FHew
&2 EACH Hew
01) EACH e
o4 O |} bl

Price Change Indicator Column

3.

Select "Take" to accept the proposed price change for the item.

Select "Don't Take" to reject the proposed price change for the item.

Click Save. Your changes to the worksheet are saved and the Worksheet Status
workspace opens.

See "Worksheet Columns" for a complete list of the editable columns on the worksheet.

User Guide 131



Worksheet Detall

View Totals

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet

Status workspace opens.

%5 worksheet Status

f@) Worksheet Status

Tatal Price Change Amount |40 00

Total Price Change $0H o
Total Price Change Items =
Total Sales Amount $0.00

Reason | |@ Apply
Adion |- galact - =l
I &,
Merchandise Level | Merchandise ID Lecation Level | Location ID Lecation Status | Conflict| Last Review Date | Reas
Filter by W Fidter by Fitter by: ||| Filter by || Fitter bpe ||| Ay T | Atk ||| Fidter by || ity
Crepartment
Crepartment 2 Zonge g 21 Mew 0z-02-2005
4] »
Select All || Unselac All || Wworkzheeat Datail

Close

Worksheet Status Workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.
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2.

Click Worksheet Detail. The Worksheet Details workspace opens.

%3 wWorksheet Details
I@ Worksheet Details |
Itermn Lewel ITran Level lzl
|c0rin lzl | Save View Diff Type . D
I ]
Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On I*
Filtar by ||| Fiiter by || Fitter by :l Filkar by :l Filkar by || Fitter by | T ||| Fidver by | F||| Fitter by | ¥
- : 5
1301 RDP CMLTS 0.00 0 i 5]
1310 RDP Item for RPM 0.00 o i 5]
1311 RDP itzm far RPM 0.00 o i 5]
1980 RPD RPM itzm 0.00 o i 5]
1981 RDF RPM itzm 2 0.00 o i 5]
1952 RDP RPM Item 3 0,00 o i 5]
1970 RDP RPM Item 0,00 o i 5]
[« l >
Unzeladc All || Selact All || Reset Data || Wwhat If || Suggest Date ||
Cancel Il Save Il Done I

Worksheet Details Workspace

Select the row you want to view totals for by clicking the box :I to the left of the
row.

Press and hold the Ctrl key while selecting to select multiple rows. Click Select All to
select all the rows.

Note: If no items are selected, the totals appear for all items
where a price change would occur.

Click the Totals L= button. The Totals window opens.
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Price Change Totals| Sales Totals | Competitive Analysis totals

Zone ID Zone Name Price Change Amount| Price Change SOH Price Change Items

Recalculate Total || Cane

Totals Window

View Price Change Totals

1. Select the Price Change Totals tab. The totals for all of the item rows that you selected
appear on the Totals window.

2. Click Done. The Totals window is closed.

View sales totals

1. Select the Sales Totals tab. The totals for the sales for the item rows that you selected
appear on the Totals window.

2. Click Done. The Totals window is closed.

View Competitive Analysis Totals

1. Select the Competitive Analysis Totals tab. The totals for how you are competing in
all retail zones that you have selected appear on the Totals window.

2. Click Done. The Totals window is closed.
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What-If Analysis

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet

Status workspace opens.

%5 worksheet Status

I@ Worksheet Status |
Reason | |@
Adion |- galact - =l
I,
Merchandise Level | Merchandise ID Lecation Level | Location ID Lecation Status | Conflict| Last Review Date | Reas
Filter by W Fidter by Fitter by: ||| Filter by || Fitter bpe ||| Ay T | Atk ||| Fidter by || ity
Crepartment
Crepartment 2 Zonge g 21 Mew 0z-02-2005
4] »
Select All || Unselac All || Wworkzheeat Datail
Tatal Price Change Amount |40 00
Total Price Change $0H o
Total Price Change Items =
Total Sales Amount $0.00

Worksheet Status Workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select all of the worksheets.

2. Click Worksheet Detail. The Worksheet Details workspace opens.
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%5 worksheet Details

@ Worksheet Details |

Ttern Level 'Tran Level lEI
|c0rin lzl | Save View Diff Type . D

I

Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H

Filker by W\ Filker by || Fitker by :l Filker by :l Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
T 5

1901 ROP CMLTE 0.00 o] ﬂ

1910 RDP Item for RPM 0.00 a H

1911 RDP item for RPM 0.00 a ﬂ

1960 RPD RPM itern 0.00 a H

1961 RDP RPM itern 2 0.00 a H

1962 RDP RPM Itemn 2 0.00 a H

1370 RDP RPM Item 0.00 a H

Kl I 3

| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||

Cancel Il Save Il Done I

Worksheet Details Workspace

3. Select the row you want to perform a what-if analysis on by clicking the box :I to
the left of the row.

Press and hold the Ctrl key while selecting to select multiple rows. Click Select All to
select all the rows.
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Perform a What-If Analysis on a Clearance Pricing Strategy

1.

Click What If. The What If window opens.

Price Strategy - Clearance @

~Pricing Guides
Current
N S

—Martdown Percents

I
Markdown Number Current Mewr
1 10% 1008
2 209 2095
2 20% 0%
4 409 ENECS
=1 S0%% SO%
& 60596 055
T TO% TO%
2 209 S09%%5
| Cancel || Resat || Apply |

What If Window

Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.

= Markdown percent: Enter a markdown percent in the New Markdown Percent
field.

Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.

Perform a What-If Analysis on a Competitive Pricing Strategy

1.
2.

Click What If. The What If window opens.
Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.

= Compete type: Select a different compete type for the whole worksheet or by
code by selecting from the New Compete Type drop-downs.

= Compete percent: Enter a new compete percent in the New Compete Percent
field.

Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.

Perform a What-if Analysis on a Margin Pricing Strategy

1.
2.

Click What If. The What If window opens.

Make changes to the following fields to test what happens to the worksheet:
=  Price guide: Select a new price guide from the New drop-down.

= Margin target: Enter a margin target in the New Margin Target field.

Click Apply. The What If window is closed and the data in the Worksheet change to
reflect the changes made in the What If window.
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Reset the What-if Data
1. Click What If. The What If window opens.
2. (Click Reset. The values are returned to their original value.

3. Click Apply. The What if window is closed and the data in the Worksheet change
back to their original value.
Export a Worksheet

Export allows you to export the current view of the worksheet to a Comma Separated
Value (.csv) file.

Navigate: From the Task Pad, select Worksheet > Worksheet Status. The Worksheet
Status workspace opens.

%5 worksheet Status
II’EJ Worksheet Status |
Reazon | |@ Apply
Action |— Selact - lzl
I
Merchandise Level | Merchandise ID Location Level | Location ID Location Status| Conflict| Last Review Date | Reas
Filker by: :I Fitter by: :l Filter by: :l Filker by: :I Fitker by: :l |F_.')tlz| Fitke :l Fitker by :l Fitkd
Department 2064 Zone Jew 03-0 3
Cepartment 2 Zoneg 2 21 Mew 0z-02-200%
4] »
Select All || Unselec All || Worksheet Detail
Total Price Change Amount £ 0
Total Price Change S0OH
Total Price Change Itermns 5
Total Sales Amount 0,00

Worksheet Status Workspace

1. Select the worksheet you want to view the details of. You can select multiple
worksheets or click Select All to select of all the worksheets.

2. Click Worksheet Detail. The Worksheet Details workspace opens.
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%5 worksheet Details

@ Worksheet Details

|c0rin

]

| Save View

Ttern Level 'Tran Level

=]

[ (@i (2] 81 [=]

Diff Type .
I,
Item ID Item Description | Historical Salg Historical Sald Seasonal Sell | Sell Thru % | Rule Season/Phasd Store On H
Filker by W\ Filker by || Fitker by Filker by Fitker by | T\ Filker by | ||| Fitber by | ||| Fitker by | ||| Fitber by
. B
1901 RDP CMLTE 0,00 o i 5]
1910 RDP Ttem for REM 0.00 0 i 5]
1911 RDP item far RPM 0.00 0 i 5]
1360 RPD RPM itzm 0.00 o i 5]
1961 RDP RPM itzm 2 0.00 o i 5]
1952 RDP RPM Item 3 0.00 o 5
1370 RDF RPM Item 0.00 o i 5]
[«] l »
| Unzelad All || Selack All || Reset Data || What If || Suggest Date ||
Cancel Il Sauve Il Cane I

Worksheet Details Workspace

Select the row you want to export by clicking the box :‘ to the left of the row.

Press and hold the Ctrl key while selecting to select multiple rows. Click Select All to
select all the rows.
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4. Click the Export Bl button. The Save window opens.
Save In: |B Termp lzl E

Save

3 wERC.trap. dirD0 [J {aSbald4e0-7284-11d4-bae7-00409631a2c8}
3 wERD.trap. dirD0 [ {a2233100-1481-11d4-9731-00c04f8eebz9]
3 WERE.trmp. dir00 [ {abda9912-5d00-11d4-bae7-9367cala7955}
3 wERF.trap. dirdd [J {CASZZETES-1BBT-1108-906A-00010240CESS)
3 wERF.trap. dirdl 1 {CE302AFF-1BEE-110E-906A-00010240CESS}
3 wards.o
3 {oo7e1b0s-202d-11d4-9790-00c04f2ecb29]}
[ {46891FF9-Fa43A-4AEG-B3F2-SCEFD4CC4RE1Y

L I}

File Harme:

Files of Tepe: |*.cs-.l lz‘

Save || Cancel |

Save Window

Select a location to save the file to from the Save In drop-down.
Enter a name for the file in the File Name field.

Click Save. The file is saved.

Open the file in the program of your choice such as a spreadsheet or word processor.

© N o’
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Price Changes

A price change is the permanent change in the price of an item. You can use the price
guides to move the new price to established price points, round the price, or define price
internals.

The Create Price Change workspace allows you to establish the price changes for an item
or group of items at a location or group of locations. When you open the window, the
Price Change List and Price Change Maintenance containers open. After you create your
price change in the Price Change Maintenance container, it is added to the Price Change
List container.

If you select locations with multiple currencies, you can only choose to create a price
change by percent or to reset the POS price. Additionally, you cannot create multi-unit
pricing across multiple currencies.

Create price change allows you to create the following types of price changes.
= Regular: The price change is occurring at the retailer's initiative.
= Vendor Funded: The supplier is subsidizing a portion of the price change.

= Link codes: Associate items to each other at a location and price them exactly the
same.

When a price change is added to RPM, it must go through a series of checks before it can
be applied to an item/location. Depending on your user role, you may not be able to
move the retail price change to the next status. A change to submitted or approved
status, or from worksheet back to approved, results in a conflict check. A change to
approved status results in the application of area differential strategies for the price
change. A price change may be in any of the following statuses:

Status Definition
Worksheet The price change has been started, but not reviewed or sent out.
Submitted The price change has been completed and is pending review. Conflict

checking has occurred for the price change.

Approved The price change has been reviewed and accepted. The price change is
communicated to the locations for which the price change is effective.

Executed The new prices established are effective for the item/location.

Rejected The price change has been reviewed and declined.

After you create a price change, you can maintain different aspects of the price change.
You can create exceptions to the items and locations that exist on the price change, you
can change the specifics of the price change, and you can copy an existing price change.

The procedures below allow you to navigate and search for price changes through the
Maintain Price Change task on the Task Pad; however, you can accomplish these same
tasks after you create a price change and the price change is displayed in the Price
Change List pane in the Create Price Change workspace.
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Search for a Price Change

Search for a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Change. The
Maintain Price Changes workspace opens.

1. In the Price Change Search pane, enter criteria as necessary to restrict the search to
the price changes you want to maintain.

(@ price thange search

¥ Departrnent l:l 8+ ¥ price Change 1d | |
= =
= Status [ select - =l
Iten Level  [rvansaction Level ttam|¥] [] S=arch On This Leval Only Crasts Dats [ |8 o &
Effactive Date | ‘E TDl |E|
» Location
» Adwvanced Search
| Coieer | [sman |

Price Change Search Pane

Field Criteria

Type Select Regular, Vendor Funded, Link Code, or All price change types.

Status Select Approved, Executed, Rejected, Submitted, or Worksheet status price
changes.

Approved By Enter a username to search for price changes approved by a specific user.

Created By Enter a username to search for price changes created by a specific user.

Reason Code Select reason codes

Deal ID Select deal IDs to search for price changes related to specific deals. First
select Vendor Funded from the Type field.

Deal Detail ID Select deal detail IDs to search for price changes related to specific deal
details. First select Vendor Funded from the Type field, then select a deal
from the Deal ID field.

Price Change ID Select price change IDs to search for specific price changes.

Effective Date Select an effective date to search for price changes with a specific effective
date.

Approved Date Select an approved date to search for price changes with a specific approved

Create Date
Price Guide
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date.
Select a create date to search for price changes with a specific create date.

Select price guides to search for price changes with specific price guides.



Price Changes

Field

Criteria

Merchandise Level Select criteria in the following fields to search for price changes in a specific

merchandise level:
*  Department

= (lass

= Subclass

= Item Type

= [Item Level

= Diff Type

= Jtem

= Diff

Zone/Location Select Zone Groups, Zones, and Locations to search for price changes from

specific zones or locations.

Market Basket Select a Market Basket Code to search for price changes with a specific

Code
Link Code

Market Basket Code.

Select a Link Code to search for price changes with a specific Link Code.

Note: Select the Search on this Level Only checkbox to
restrict the search to the selected level.

Click Search. Your results appear in the Price Change List pane.

I@ Price Change List |

Price Change Wiew |Standard Columnn view| ¥ || g%
Id Link Code Item Item Descripd Item Level | Diff Id Diff Id Descri| Location Lacation Desq Location Typd Primary Zon
Fiteer by | :| Fiteer by | :| Fiteer by | :| Fiteer by | W\ | Fiteer by | w || Fiteer by w || Fitrar by | w ||| mitray by w ||| Fittey by w || Fitbey by w ||| Fitper by | #1
341 100151009 |RPM & **.., [Transaction .| 3 AUD locatio.. [Zene X
921 100151009 |RPM Q& **. | Tranzaction .., 2 ALD locatio.., |Zone :
20z 100118006 |Misty Test L..|Transaction ... 1000000027 |Sydney Store
201 100116006 |Misty Test L |Transaction ., 1000000025 |Las Vegas  |Store
4 [ 3
b 12E1EE|IE| Go to page of17 ﬁ
Selact All

cion [ ssiect~ [1]

Hew I Copy |

Price Change List Pane
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Create a Regular Price Change

Create a Regular Price Change
Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create

Price Change workspace opens.

%5 Create Price Change

I@ Price Change List
View [standard Column view[¥] | &,

Price Change
Location Desd Location Typd Primary Zon

Diff Id Diff Id Descri| Location

Item Descripy Item Level
citeer by w ||| Fiteer by ¥ ||| Fiter by [ w

[Fiteer sy ] =] [ Fiter o]+

d Link Code Item

Fiteer by | W[ Fiteer sy [ o ||| Fitver by [ | | Ftrer sy [ || itrer b [ ||| Ftter 84| w

»

4
s =

Action |- Selack - lz‘ | Conflict Check || Suggest Date |

Naw ]| Copy

Status
| [ Los Excaption. | [ Tram Exception ||

Delete |

I@ Price Change Maintenance

* Effective Date

|E| Multi Unit Pricing ]

Change Type [chang= By Amount
Multi Units

Changs Amaunt
Multi Unit Retail

Selling UOM B
Ignore Constraints Multi Unit U3 B8

* Location Selection

hd

Zone Group %
cancel |[ save +Repest || Dore |

Create Price Change Workspace

1. In the Price Change Maintenance pane, in the Type field, select Regular.
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Price Changes

I’F Price Change Maintenance

Tupe ®) Regular Price Guide l:l
() vendor Funded * Reason Code l:l =
() Link code
* Effective Date l:“ﬂ
Change Type |Changg By Armaunt E Multi Unit Pricing O

Change Armount | |

Ignore Constraints

~ Location Selection

=l

Location Selection [
Level | d Description | Location Type

¥ Itemn Selection

Itern Type  [ttem

&[]

Itern Level  [Transaction Level Item

Itern B+

Price Change Maintenance Pane

2. In the Effective Date field, enter the date the price change should go into effect, or
click the calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the price
change, or click the LOV El button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV =l button and select a reason code.
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Create a Regular Price Change

Set Up Price Change Type

1.

Select Locations
1.

In the Price Change Type field, select the type of price change that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a price change by percent or to
reset the POS price.

Change By Percent: A price for an item is changed by a percentage added to or
removed from the basis regular retail. The percent of change is determined by
the percent entered in the Change Amount field.

Change By Amount: A price for an item is changed by an amount added or
removed from the basis regular retail. The amount of change is determined by
the amount entered in the Change Amount field.

Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.
Reset POS Price: The item will be recognized on a price change but no change to

the retail will occur. When you select Reset POS Price, the Change Amount field
and Selling UOM field will be disabled.

In the Change Amount field, enter an amount.

If appropriate, define the multi-unit pricing for a price change:

a. Select the Multi Unit Pricing check box.

b. In the Multi Units field, enter the number of units that are part of the price
change.

c. Inthe Multi Unit Retail field, enter the new price for the items.

d. In the Multi Unit UOM field, enter the ID of the unit of measure that applies to

the price change, or click the LOV El button and select a unit of measure.

If appropriate, select the Ignore Constraints box. When unchecked, the promotion
constraints will be taken into account when conflict checking is performed on the
price change. When checked, promotion constraints will be ignored when conflict
checking is performed on the price change.

In the Location Selection area, select how you want to add locations to the price
change.

= Zone Group: Enter the ID of the zone group that contains the locations to add to
the price change, or click the LOV &l button and select a zone group.

= Zone: Enter the ID of the zone to add to the price change, or click the LOV +
button and select a zone.

= Location: Enter the ID of the location that you want to add to the price change, or

click the LOV & T button and select a location.

Note: You can create price changes at the zone or location
level.

Click Select. The zones and/ or locations that meet your criteria are added to the
table in the Location Selection table.
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Price Changes

Select Items
1. In the Price Change Maintenance pane, in the Item Selection area, select items on the
price change using the available fields.

¥ Item Selection

Item Type |Itam

E1IE]

Item Level |

Claar

Item Selection Il

Level | i Diff ID | Description

Item Selection area of Price Maintenance pane

Note: All fields with LOV &1+ buttons allow multiple
selections.

= To select items from all available items, enter an ID in the Item field, or click the
LOV El* button and select item.

= To limit the items available in the Item field, enter information in the enabled
fields:

— In the Department field, enter a department number, or click the LOV +
button and select a department.

— In the Class field, enter a class number, or click the LOV E1* button and
select a class.

— In the Subclass field, enter a subclass number, or click the LOV El* button
and select a subclass.

— In the Item Type drop-down, select Item or Item List.

Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

— In the Item Level drop-down, select Parent Item, Parent Item/ Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item/ Diff is selected.

— In the Diff Type drop-down, select a diff type.
— In the Diff drop-down, select a diff.

In the Item field, click the LOV Bt button and select items.

2. Click Select. Items that meet your criteria are added to the Item Selection table.

User Guide 147



Create a Vendor Funded Price Change

Complete the Price Change

1. In the Price Change Maintenance pane, click Apply to create price changes. One price
change will be created for each item/location intersection.

Change the status of your price change as appropriate.

Click Done to save your changes and close the workspace.

Create a Vendor Funded Price Change

Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create
Price Change workspace opens.

%5 Create Price Change

al

I@ Price Change List | —I
Price Change ¥iew [Standard Column vies[ ] || g%
d Link Code Item Item Descripfl Item Level Diff Id Diff Id Descri] Location Location Desd Location Type Primary Zom

[Fitcer sy | ¥ ||| Fieer sy [ ¥ || miteer sy ¥ | [ Fitter sy ] || iteer by || Fitter [ || Fitear o] | Fitear oy { || Fitar £ { | | tter 2y { ||| Fier £y 7]

2 E=

I@ Price Change Maintenance |

Type ®) Regular Price Guide l:l g
(") wendor Funded * Reason Code l:l E
(O Link Code
* Effective Date l:l
Change Type |Changg By Armaunt lz' Multi Unit Pricing O

change Amount | |

Ignore Constraints . %

~ Location Selection

Zone Group 8 -

Cancel ” Save + Repeat ” Lone I

Create Price Change Workspace
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Price Changes

1.

In the Price Change Maintenance pane in the Type field, select Vendor Funded.

I(:' Price thange Maintenance

Type () Regular
(@) vendor Funded
() Link Code

[ =

* Effective Date

Change Type [change By Amaunt

Change Amount |

8

Partner Type | Seledt -

*

* Funding Type |

} Location Selection

Price Guide

* Reazon Code

Multi Unit Pricing

[ 18
L 18

O

I 0 m

Location Selection Il
Level n Description | Location Type ‘
¥ Item Selection
Item Selection (=3
Level i Diff ID | Description ‘

| |

Price Change Maintenance Pane

In the Effective Date field, enter the date the price change should go into effect, or
click the calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

In the Price Guide field, enter the ID of the price guide you want to apply to the price
change, or click the LOV & button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide.

In the Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV =l button and select a reason code.
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Create a Vendor Funded Price Change

Select the Vendor and Deal

1. In the Price Change Maintenance pane, in the Partner Type drop-down, select the
partner type.

Manufacturer
Distributor
Wholesaler
Supplier

2. In the Partner field, enter the ID of the partner with the deal, or click the LOV
button and select a partner.

3. Inthe Deal ID field, enter the ID of the deal, or click the LOV &1 button and select a
deal.

4. In the Deal Detail ID field, enter the ID of the deal details, or click the LOV &l button
and select the deal details.

Setup Price Change Type
1. In the Price Change Type field, select the type of price change that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a price change by percent or to
reset the POS price.

Change By Percent: A price for an item changed by is a percentage added to or
removed from the basis regular retail. The percent of change is determined by
the percent entered in the Change Amount field.

Change By Amount: A price for an item is changed by an amount added or
removed from the basis regular retail. The amount of change is determined by
the amount entered in the Change Amount field.

Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

Reset POS Price: The item will be recognized on a price change but no change to
the retail will occur. When you select, the Change Amount field and Selling
UOM field will be disabled.

In the Change Amount field, enter an amount.

If appropriate, define the multi unit pricing for a price change:

a.
b.

Select the Multi Unit Pricing check box.

In the Multi Units field, enter the number of units that are part of the price
change.

In the Multi Unit Retail field, enter the new price for the items.
In the Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV El button and select a unit of measure.

150 Oracle Retail Price Management



Price Changes

Select Locations
1. In the location area of the Price Change Maintenance pane, in the Location field,
enter a location ID, or click the LOV =1+ button and select locations.

Note: Only locations on the deal are selectable.

2. Click Select. Locations are added to the table in the Location Selection table.

Enter Funding Information

1. In the Price Change Maintenance pane, in the Funding Type drop-down, select
Percent or Amount.

Note: If the selected locations have different currencies, only
Percent is available.

2. Inthe Funding Amount field, enter an amount.

Select Items
1. In the Item Selection area of the Price Change Maintenance pane, in the Item field,
enter an item ID, or click the LOV Elt button and select items.

Note: Only items on the deal are selectable.

2. Click Select. The items appear in the Item Selection table.

Complete the Price Change
1. In the Price Change Maintenance pane, click Apply to add all your changes.
2. Change the status of your price change as appropriate.

3. Click Done to save your changes and close the workspace.
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Create a Link Code Price Change

Create a Link Code Price Change

Navigate: From the Task Pad, select Price Changes > Create Price Change. The Create

Price Change workspace opens.

%5 Create Price Change

f(—) Price Change List

2

Price Change
1d Link Code | Ttam Ttem Dascript] Ttem Lavel | Diff 14 Diff Id Descri] Location Location Dasq Location Typd Primary Zon
citeer by | ¥ ||[ Fiteer by [ w ][ Fitver by [ > || [ Fiter s 7| [ Fiter o [ ]| [ ter v [ o] [cer ar [ || mitcer sy {=]|[ Fiteer s [ ] [ Fitser s ]|[ Fiter 2 {1
4 »
hS =
Selact All
Status Adtion |- Selact - lz‘ Update | Conflict Check || Suggest Date |
Delete | Hew ]| Copy | [ Los Excaption. | [ Tram Exception ||
(@ price thange Maintenance

Type

* Effective Date

¥ Reason Code

Change Type [chang= By Amount

|E| Multi Unit Pricing

Multi Units

Change Armount |

Selling LOM B

Ignore Constraints

* Location Selection

Zone Group %

Multi Unit Retail

Multi Unit UoM

=

|

hd

cancel |[ save +Repest || Dore |

Create Price Change Workspace

1.
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In the Price Change Maintenance pane, select Link Code.



Price Changes

I(:' Price Change Maintenance |

Tope () Regular =
() wendor Funded ¥ Reason Code l:l =
(@ {Link Codd
¥ Effective Date l:l@
Change Type | lzl Multi Unit Pricing |:|
=
=
[
=
* Link Code
* Currenc
Y usD

| |

Price Change Maintenance Pane

2. In the Effective Date field, enter the date the price change is should go into effect, or
click the calendar E button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date price changes can be created is
today’s date plus the price change processing days. If you
have emergency price change permission, Price Change
Processing Days will be ignored.

3. Inthe Reason Code field, enter the ID of the reason you are creating the price change,
or click the LOV =l button and select a reason code.

Select Link Codes

1. Inthe Link Code area of the Price Change Maintenance pane, in the Link Code field,
enter the ID of the link code, or click the LOV &l button and select a link code.

2. Inthe Currency field, enter the currency code, or click the LOV &l button and select
the currency.

3. Inthe Zone Group field, enter the ID of the zone group that contains the locations
you want to add to the price change, or click the LOV El* button and select a zone
group.

4. In the Zone field, enter the ID of the zone that contains the locations you want to add
to the price change, or click the LOV * button and select a zone.

Note: The Zone field is limited by the currency entered in
step 2.
5. In the Location field, enter the ID of the location that you want to add to the price

change, or click the LOV &1+ button and select a location.

Note: You can create price changes at the zone level.
Locations are not required.
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Change the Status of a Price Change

Set Up Price Change Type
1. Inthe Change Type field, select Fixed Price.

Fixed Price: The price for the item will be at a specified retail that will be defined in

the change amount field. Link code price changes can only be setup as fixed price.

In the Change Amount field, enter an amount.

If appropriate, define the multi unit pricing for a price change:

a. Select the Multi Unit Pricing check box.

b. In the Multi Units field, enter the number of units that are part of the price
change.
In the Multi Unit Retail field, enter the new price for the items.
In the Multi Unit UOM field, enter the ID of the unit of measure that applies to
the price change, or click the LOV B button and select a unit of measure.

Complete the Price Change
1. In the Price Change Maintenance pane, click Apply to add all your changes.
2. Change the status of your price change as appropriate.
3. Click Done to save your changes and close the workspace.

Change the Status of a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Changes. The
Maintain Price Changes workspace opens.

1. In the Price Change Search pane, search for and retrieve the price change you want to
maintain. Your results are displayed in the Price Change List pane.

I@ Price Change List |

Price Change View | g
Id Link Code Item Item Descripf Item Level Diff Id Diff Id Descri| Location Location Desqd Location Typd Primary Zon
Fitter by | :l Fitter by | :l Fifter by | :l Fitrer by || Fitter by | N | Fiiter by TN | Fitter by ||| Fitrer byl V|| Fidrer By || Fitter byo| T | Fiiter by
a6
F41 100151008 |RPM Q& **., |Transaction ., & AUD location, |Zone X
221 100151002 (RPM Q& ¥, [Transaction .., & AUD locatio., [Zone :
a0z 100112006 |Misty Test I..|Transaction .. 1000000027 |Sydney Store ]
Q01 100118006 |Misty Test L..|Transaction .. 1000000025 |Las Yegas Store
4 [ »
2 12245D|pp] Gotopage [1 |of17

scon [octea~ [3

Mew || Copy

Price Change List Pane
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Price Changes

(@ Price thange Search |

¥ Departrnent l:l B+ ¥ price Change 1d | |
= 5
= Fder =
Itern Level []5earch On This Level Cnly Create Date [ =R =]
S TRD T Effective Date [ =R =]

R —]
miff B
» Location
¥ Advanced Search

| Goeaan ]|

Price Change Search Pane

Note: If you are in the Create Price Change workspace your
price changes are displayed in the Price Change List
container when you click Apply. You do not need to open
the Maintain Price Change workspace.

Select the price change for which you want to change the status.

= In the table, select a row.

=  Click Select All. All records in the Price Change List pane are selected.

In the Action field, select the status to which you want to move the price change.
Click Update. You are prompted to confirm your decision.

Click Yes. If the system option, background conflict check, is off and conflicts exist,
the Conflict Review List window opens.

Conflict Review List

Conflict Review List " &

I Promotion Componen| Ttem Location Change Type Change Amount Effective Date

Change By

Price Change Tyj ID Promotion Comp Date Unit Retail on E4 Selling UOM Multi Units Multi-Unit Retai| Mult-Unit Selling
Price Change 3221 12-04-2004 $26.84 EACH
Price Change 3242 12-01-2005 $35.22 EACH

Conflict Review List Window
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Maintain a Price Change

Note: See "View Conflict Check Results" for more
information on background conflict checking. When
background conflict check is on, a binocular H icon
appears in the conflict column when conflict checking is
complete. Click the icon to open the Conflict Review List
workspace.

a. The current price change is displayed in the upper half of the window. Price
changes promotions, and/ or clearances for the same item/location are displayed
in the lower half of the window.

b. Click Close to close the Conflict Review List. The "Maintain a Price Change"
procedure contains additional information on how to adjust a price change.

6. Click Done to save any changes and close the window.

Maintain a Price Change

Navigate: From the Task Pad, select Price Changes > Maintain Price Change. The

Maintain Price Changes workspace opens.

1. In the Price Change Search pane, search for and retrieve the price change you want to
maintain. Your results are displayed in the Price Change List pane.

I@ Price Change List |

Price Change Wiew |Standard Column View ” d
Id Link Code Item Item Descripf Item Level Diff Id Diff Id Descr| Location Location Desqd Location Typd Primary Zon
Fitker by | : | Fitker by | : | Fitker by | : | Fitker by ||| Fitter by | N | Fiitber by| TN | Fitter by:| ¥ ||| Fitver by:| V|| Fitter by ||| Fitter by | T | Fiiter by | ™
241 100151003 [RPM Q@A **.. [Tranzaction ., 3 AUD locatio.. Zone b4
221 100151002 (RPM Q& *¥*., [Transaction .., 3 AUD locatio., [Zone :
202 100118006 |Misty Test L., |Transaction .. 1000000027 |Sydney Store
Q01 100118006 |Misty Test I..|Transaction ... 1000000025 (Las Vegas Store
4 [ »
hS| 123450k Gotopage [t |of17 E=
Select All
action | select - [v]
| Mew || Copy |
Price Change List Pane
(@ Price thange Search |
¥ Departrnent l:l B+ ¥ price Change 1d | |
B Type T =
B Status [ select - =1
Effactive Date | ‘ To | |
S N —] -
» Location
¥ Adwvanced Search
| Ceioa ] Lo ]|

Price Change Search Pane
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Price Changes

From the list of results, select the price change you want to maintain. The price
change details appear in the Price Change Maintenance pane.

I@ Price Change Maintenance

* s =
Effective Date 037022005
Change Type |<3|..angE By Amount |E| Multi Uit Pricing [

Change Amount |200,00 |

8
8

Location Selection " &
Level | i) ‘ Description | Location Type
Store | 1000000000 | Fargn | Store
Ttem Selection (=4
Level | jul ‘ Diff 1D | Description
Parent Item | 100163000 | |CN*1

| oo

Price Change Maintenance Pane

If necessary, change the status of the price change to Worksheet.
Edit the enabled fields as necessary.

Note: You cannot change the items and locations on a price
change.

Click Apply to add all any changes.

Click Done to save any changes and close the window.
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Maintain a Price Change

Copy a Price Change
1. From the list of results, select the price change you want to copy.
2. Click Copy. The price change details appear in the Price Change Maintenance pane.

I(J Price Change Maintanancae |

¥ Effactive Date o3fo2fz005 @

Change Type |(;|-.ange By Amount |E| Multi Unit Pricing [

hangs Ameunt (200,00 |

a8
2

Location Selection (3
Level | n Description Location Type
Store | 1000000000 | Fargo | Store
Item Selection (4
Level | jui) ‘ Diff 1D | Description
Parent Item | 100163000 | |CN-1

| oo |

Price Change Maintenance Pane

Edit the enabled fields as necessary.
Click Apply to add all any changes.

Click Done to save any changes and close the window.

Note: Effective dates, exceptions, and status are not copied
when copying a price change.

Delete a Price Change
1. From the list of results, select the price change you want to delete.
2. Click Delete. You are prompted to confirm your decision.
3. Click Yes. The price change is deleted.
4. Click Done to close the window.

Note: Only price changes with a status of Worksheet can be
deleted.
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Price Changes

Check for Conflicts

1.
2.

Suggest a Date
1.
2.

From the list of results, select the price change you want to check.

Click Conflict Check. If the system option, background conflict check, is on and
conflicts exist, the Conflict Review List window is displayed.

Conflict Review List

Conflict Review List " &

I Promotion Componen| Ttem Location Change Type Change Amount Effective Date

Change By Percent  15%

Price Change Tyj ID Promotion Comp Date Unit Retail on E4 Selling UOM Multi Units Multi-Unit Retai| Mult-Unit Selling
Price Change 3221 12-04-2004 $26.84 EACH
Price Change 3242 12-01-2005 $35.22 EACH

Conflict Review List Window

= If no conflicts exist, click OK.

= If conflicts exist, you must adjust the details of your price change before you can
move the price change to the next status.

Note: See View conflict check results for more information
on background conflict checking.

Click Done to save any changes and close the window.

From the list of results, select the price change you want to suggest a date for.

Click Suggest Date. The system runs a check of promotion constraints, then
calculates an appropriate date and places it in the effective date field.

Click Done to save any changes and close the window.
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Maintain a Price Change

Create a Location Exception

Note: Location exceptions can only be created for Zone Level

price changes

From the list of results, select the price change.

2. Click Location Exceptions. The locations selection area of the Price Change

Maintenance pane is enabled.

I(_’J Price Change Maintanancae

* Effective Date 03/02/2005

Change Type |Change By Arnount

Change Amount |200.00

Multi Unit Pricing  []

Location Selection (3
Level | n Description | Location Type
Store | 1000000000 | Fargo | Store
Item Selection (4
Level | jui) ‘ Diff 1D | Description
Parent Item | 100163000 | |CN-1

| Apply |

Price Change Maintenance Pane

3. In the Location field, enter the ID of the location where items are different than the

zone on the price change, or click the LOV & button and select a location in the zone.

4. In the enable price change fields, enter information about the price change for the

item/location.

Click Apply to add any changes.

Click Done to save any changes and close the window.
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Price Changes

Create Item Exceptions at the Transaction Level

Note: Item exceptions at the transaction level can occur only
when the price change was created at the item parent or item
parent/ diff level.

1. From the list of results, select the price change.

2. Click Tran Exceptions. The item selection area of the Price Change Maintenance pane
is enabled.

I(_’J Price Change Maintenance |

* i =
Effective Date 03/02/2008

Change Type |Changg By Armount lz' Multi Unit Pricing  []

Change Armount |zgg,gg |

8
8

Location Selection Il
Level | i) ‘ Description | Location Type
Store | 1000000000 | Fargo | Store
Item Selection " 52
Level | i} ‘ Diff 10 | Description
Parent Itam | 1001&3000 | |CN-1

| oo |

Price Change Maintenance Pane

3. In the Item field, enter the ID of the item for which items are different than the parent
item on the price change, or click the LOV & button and select an item.

4. In the enable price change fields, enter information about the price change for the
item.

Click Apply to add any changes.
6. Click Done to save any changes and close the window.
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Create Price Changes for Area Differential

Create Price Changes for Area Differential

Navigate: From Task Pad, select Price Changes> Price Changes for Area Differentials.
The Price Changes for Area Differentials pane opens.

B3 price Changes for Area Differentials

Price Changes for Area Differentials Pane

1. Select Primary area from the top Multi-Record Block.

I(J Price Changes for Area Differentials
I
Department Id | Department Class Id Class Subclass Id Subclass Zone Group Zone Group Id | Zone Zone Id Price Guide
1234| Glassware RPM-INT-2G1 18|22 21
1414| Activewesr All Locstians 1 USD locations 1
L414| Activewesr all Locations 1| USD locations 1
I
Zone Id Zone Name: Differential Percent Auto Approve | Price Guide Create Price l:llan4 Effective Date | Create Date State
[] creste Price changes Effective Date | | [ aeple |

2. Secondary areas for the Primary area will appear in the bottom Multi-Record Block.
Select the secondary area you want to create price changes for.

Click Create Price Changes.
Enter an Effective Date.
Click Apply.
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A clearance is designed to move out of date and slow selling merchandise out of a store.
A clearance is considered a permanent price change, and inventory is consequently
revalued. Once the reset date for a clearance has passed, the item’s price and inventory
value is returned to the regular price. The following clearances can be created.

e Regular: The clearance is occurring at the retailer's initiative.
¢ Vendor Funded: The supplier is subsidizing a portion of the clearance.

When a clearance is added to RPM, it must go through a series of checks before it can be
applied to an item/location. Depending on your user role, you may not be able to move
the clearance to the next status. A clearance may be in any of the following statuses:

Status Definition
Worksheet The clearance has been started, but not reviewed or sent out.
Submitted The clearance has been completed and is pending review. Conflict checking

has occurred for the price change.

Approved The clearance has been reviewed and accepted. The clearance is
communicated to the locations for which the clearance is effective.

Executed The clearance prices established are effective for the item/location.

Rejected The clearance has been reviewed and declined.

After you create a clearance, you can maintain different aspects of the clearance. You can
create exceptions to the items and locations that exist on the clearance, you can change
the specifics of the clearance and you can copy an existing clearance.

There are procedures you can use to navigate and search for clearances through the
Maintain Clearances task on the Task Pad; however, you can accomplish these same
tasks after you create a clearance and the clearance opens in the Clearance List pane in
the Create Clearance workspace.
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Search for a Clearance

Search for a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

I/C—) Clearance Search

&3 Departrment
Clazs
Subclass
Item Type
Itemn Level
Diff Type

*

Item

Driff

} Location

[ I8+
B
B

|Item

ransaction Level Itern|¥| [ $earch On This Level Only

- Select -

=
B

b Advanced Search

|~

* Clearance 1d |

Tupe Regulay

Status - Selact -

Create Date |

Effective Date |

Maintain Clearances Workspace

1. Enter criteria as necessary to restrict the search to the clearances you want to
maintain.
2. Click Search. Your results appear in the Clearance List pane.

(B lesrance ot |
Clearance view [Markup Columnn view |¥|| &
d tem Item Descripd Item Level | Diff Id Diff 1d Descri| Location Location Desd Location Typd Primary Zene| Exception Ind Pard
Fitrer by | W Fitear by | ||| Ficer sy | ¥ ||| Fitcer by | | Fitrar by | w ||| Fitter by | ¥ ||| Fiver ty | ¥ ||| Fitrer | wl| Fitrar by | w || Fiter by | ¥ ||| Fitrer ty | w ||| Fite

SE1(100022004 |Ariel sleepe., [Parent Item 11 Test ClrZon.., [Zone
542|100000016& |Test Item 1. [Transaction . 1000000014 |Baltimore Store
541(100000016 |[Test Itern 1. [Tranzaction .. 1000000014 (Baltimore Store

1000000001 (Minneapalis  [Stare

524/100025213 MM Fachion ..

ITranzaction ...

4

»

Y (1 z2450]kr Gotopage

Status

Approved Actian

- select - [+]

Conflict Check

Delete

Hew I Copy

Loc Exception | [ Tran Exception ||

Clearance List Pane
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Create a Regular Clearance

Navigate: From the Task Pad, select Clearances > Create Clearance. The Create Clearance
workspace opens.

%5 create Clearance

I@ Clearance List

tlearance

2

Location Desq Location Typd

Id Item

Item Descripy Item Level Diff 1d

Diff Id Descri| Location
Fitter by | ¥l Fitter b [ ¥ ||| Fiter 6y |+

Primary Zone| Exception In

Fitier by | ¥ ||[ Fitver by [ || Fitver by [ ¥ ||| Fiter by [ ¥ ||| Fiter by [ ¥ ]|[ Fiter £y ] ¥

[itier by | ¥ || Fiteer bp ¥

4 »
Selact All
Status Action [ gelect - E Update Canflick Check

Delste | Hew Il Copy

| [ LocException |[ Tran Exception ||

I@ tlearance Maintenance

Type eqular

) wendor Funded

* Reason Code

( [ |8
¥ Effective Date l:l

Change Type Gut Of Stock Date l:l

Earliest Reset Date

IAmDunt Off lzl

Change Amount |

Latest Reszet Date

Apply Subclass Defaults ]

* Location Selection

Zone Group 8 EI
Create Clearance Workspace

1.

In the Clearance Maintenance pane in the Type field, select Regular.
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Create a Regular Clearance

((=1 Clearance Maintenance
[E

Type (@) Regular Prica Guide l:l
() vendar Funded * Reason Code |:| =
¥ Effective Date l:IE
Change Type s cunt off Out O Stock Date l:IEI
Change Amaount | ‘ Reset Date l:l@

Apply Subclass Defaults  [7]

* Location Selection

Location Selection " &;

Level | d Description ‘ Location Type |

* Item Selaction

Itemn Type  [Item

]

Itern Level |Transaction Level Itern

Clearance Maintenance Pane

2. In the Effective Date field, enter the date the clearance is enabled, or click the
calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date clearances can be created is today’s
date plus the price change processing days, unless you have
emergency privileges.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the
clearance, or click the LOV &l button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the clearance, or
]
click the LOV =l button and select a reason code.

5. In the Out of Stock Date field, enter the date you expect the inventory to be
consumed, or click the calendar E button and select a date.

Note: Depending on your system settings the date may
default.
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6. In the Reset Date field, enter the date the price of the item returns to regular price, or
click the calendar [ button and select a date.

Note: Depending on your system settings the date may
default.

7. Select Apply Subclass Defaults to attach a Clearance Defaults Pricing Strategy to the
clearance.

Note: Set up a Clearance Pricing Strategy before creating a
clearance. See the Clearance Defaults section of the Maintain
Price Strategies chapter for complete information on setting
up a Clearance Defaults pricing strategy.

Set Up Clearance Type
1. In the Price Change Type field, select the type of clearance that is occurring.

Note: If you selected locations with multiple currencies, you
can only choose to create a clearance by percent.

Change By Percent: A price for an item changed by is a percentage added to or
removed from the basis retail price. The percent of change is determined by the
percent entered in the Change Amount field.

Change By Amount: A price for an item is changed by an amount added or
removed from the basis retail price. The amount of change is determined by the
amount entered in the Change Amount field.

Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

2. Inthe Change Amount field, enter the amount, percent, or fixed amount for the
clearance.

Select Locations

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A clearance
can only exist as a decrease in price.

1. Inthe Location Selection area, select how you want to add locations to the clearance.

Zone Group: Enter the ID of the zone group that contains the locations to add to
the clearance, or click the LOV El button and select a zone group.

Zone: Enter the ID of the zone to add to the clearance, or click the LOV £l button
and select a zone.

Location: Enter the ID of the location to add to the clearance, or click the LOV
button and select a location.

2. Click Select. Locations that meet your criteria are added to the table in the Location
Selection area.
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Create a Regular Clearance

Select Items

1. In the Clearance Maintenance pane, in the Item Selection area, select items on the
clearance using the available fields.

¥ Item Selection

Item Type

Item Level |

|Itam

E1IE]

Claar

Item Selection Il

Level

| i Diff ID | Description

Item Selection Area of Clearance Maintenance Pane

Note: All fields with LOV &l buttons allow multiple items to
be selected.

To select items from all available items, enter an ID in the Item field, or click the LOV
button and select item.

Or

a. Enter information in the enabled fields to limit the items available in the Item
field.

In the Department field, enter a department number, or click the LOV
button and select a department.

In the Class field, enter a class number, or click the LOV =l button and select
a class.

In the Subclass field, enter a subclass number, or click the LOV =l button and
select a subclass.

In the Item Type drop-down, select Item or Item List.

Note: If you select Item List from the Item Type drop-down,
only item lists will be selectable from the Item field. If you
select Item, only single items that conform to the other
criteria specified will be selectable.

In the Item Level drop-down, select Parent Item, Parent Item/Diff, or
Transaction Level Item.

Note: The Diff Type and Diff fields are only enabled if
Parent Item/ Diff is selected.

In the Diff Type drop-down, select a diff type.
In the Diff drop-down, select a diff.

b. In the Item field, click the LOV &l button and select items.
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2. Click Select. Items that meet your criteria are added to the table in the Item Selection

area.

Complete the Clearance

1. Click Apply to add any changes.
2. Change the status of your clearance as needed.
3. Click Done to save any changes and close the workspace.

Create a Vendor Funded Clearance

Navigate: From the Task Pad, select Clearances > Create Clearance. The Create Clearance

workspace opens.

%5 create Clearance
al
I@ Clearance List | —I
tlearance Wiew |Standard Column view|[¥] || g%
d Ttem Item Descrip§ Item Level | Diff Id Diff Id Descrif Location Location Desqd Location Typd Primary Zone | Exception In
[ Fitier by | ¥ ||| Fitver by [ ¥ ||| Fiteer b [ ¥ ||| Fiter o [ ¥ || Fiter o [ ¥ || Fiter e [ ¥ || Fiter e [ ¥ | Fiter e [ 7| [ Fiter e [ 7] [ iter o | ]| Fiter 2]
4 »
|
= P
(@ tlearance Maintenance |
Type -éw Regular Price Guide l:l %
(0) vendar Funded *Rezzan Code |:| 8
¥ Effective Date l:l
Change Type [arnaurt off =] out Of Stack Date l:l
Change Amaunt | | - =
Apply Subclass Defaults ]
* Location Selection
[

Zone @roup =]

Create Clearance Workspace

1. In the Clearance Maintenance pane in the Type field, select Vendor Funded.
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Create a Vendor Funded Clearance

((=1 Clearance Maintenance
[E

Type (@) Regular Prica Guide l:l
() vendar Funded * Reason Code |:| =
¥ Effective Date l:IE
Change Type s cunt off Out O Stock Date l:IEI
Change Amaount | ‘ Reset Date l:l@

Apply Subclass Defaults  [7]

* Location Selection

Location Selection " &;

Level | d Description ‘ Location Type |

* Item Selaction

Itemn Type  [Item

]

Itern Level |Transaction Level Itern

Clearance Maintenance Pane

2. In the Effective Date field, enter the date the clearance is enabled, or click the
calendar [ button and select a date.

Note: The Effective Date you can set depends on the number
of days set in the system option Price Change Processing
Days. The earliest date clearances can be created is today’s
date plus the price change processing days, unless you have
emergency privileges.

3. In the Price Guide field, enter the ID of the price guide you want to apply to the
clearance, or click the LOV &l button and select a price guide.

Note: The price guide only applies to the items in the same
department as the price guide and locations that share the
same currency as the currency on the price guide.

4. In the Reason Code field, enter the ID of the reason you are creating the clearance, or
]
click the LOV =l button and select a reason code.

5. In the Out of Stock Date field, enter the date you expect the inventory to be
consumed, or click the calendar E button and select a date.

Note: Depending on your system settings the date may
default.
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6. In the Reset Date field, enter the date the price of the item returns to regular price, or
click the calendar [ button and select a date.

Note: Depending on your system settings the date may
default.

7. Select Apply Subclass Defaults to attach a Clearance Defaults Pricing Strategy to the
clearance.

Select the Vendor and Deal

1. In the Clearance Maintenance pane, in the Partner Type drop-down, select the
partner type.

=  Manufacturer
= Distributor
=  Wholesaler
= Supplier
2. Inthe Partner field, enter the ID of the partner with the deal, or click the LOV
button and select a partner.

3. Inthe Deal ID field, enter the ID of the deal, or click the LOV &l button and select a
deal.

4. In the Deal Detail ID field, enter the ID of the deal details, or click the LOV &l button
and select the deal details.

Select Locations
1. In the location area of the Clearance Maintenance pane, in the Location field, enter a
location ID, or click the LOV Bl button and select locations.

Note: Only locations on the deal are selectable.

2. Click Select. Locations are added to the table in the Location Selection table.

Enter Funding Information

1. In the Clearance Maintenance pane, in the Funding Type drop-down, select Percent
or Amount.

Note: If the selected locations have different currencies, only
Percent is available.

2. In the Funding Amount field, enter an amount.

Select Items

1. In the Item Selection area of the Clearance Maintenance pane, in the Item field, enter
]
an item ID, or click the LOV El T button and select items.

Note: Only items on the deal are selectable.

2. Click Select. The items appear in the Item Selection table.
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Change the Status of a Clearance

Complete the Clearance
1. Click Apply to add any changes.
2. Change the status of your clearance as appropriate.

3. C(lick Done to save any changes and close the workspace.

Change the Status of a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

-
(@ rtlearance search

* Diapartrnant l:l B+ * Clearance 1d | |
E Type F:egul.ar E|
a8 Status | selact - |E|

Themn Level [ search on This Level Only Create Date [ |& 7= | =]
Effective Date | | To | |
L —
a
» Location
¥ Advanced Search
| oiaar | [soman

Maintain Clearances Workspace

1. Search for and retrieve the clearance you want to maintain. Your results appear in
the Clearance List pane.

(& clearance List

Clearance Wiew [Markup Colurmn view [ || &%

[ream [ Team Doscried Toom towal | Dife1a | 0i#F1a Daser] Loration | Location Dazd Loration Tyed Primary Zone| Bucaption ind Pard

Fiter Sy ] : sutrer by | w ||| Fuver sy [ > || Furer by [ || Frter b [ > |[ mviter s0 [ = || mtter sy [ ]| mrrer s [ ]| rer 20 [ > )| Frrer 20 [ > ]| [ Frrer b0 [ > ]| e

11

se1f1o00z2004

s4z[10000001e 1000000014 [EBaltimers

1000000014 |Bal

uuuuuuuuuu

=
= t224300bs] corras [ ]ets

N

| Naw 0 Copw

Clearance List Pane

Note: If you are in the Create Clearance workspace, your
clearances appear in the Price Change List container when
you click Apply. You do not need to open the Maintain Price
Change workspace.

2. Select the price change for which you want to change the status:
a. In the table, select a row.
b. Click Select All. All records in the Clearance List pane are selected.
In the Action field, select the status to which you want to move the clearance.
Click Update. You are prompted to confirm your decision.

Click Yes. If the system option, background conflict check, is off and conflicts exist,
the Conlflict Review List window is displayed.
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Conflict Review List

Conflict Review List

Promotion Componen| Item Location Change Type

Fixed Price

hange 3410 12-10-2004 $26.06 EACH

| #
P P

246 12-10-2004 $5.06

Conflict review list window

Note: See View conflict check results for more information
on background conflict checking. When background conflict

check is on, a binocular i icon appears in the conflict
column when conflict checking is complete. Click the icon to
open the Conflict Review List workspace.

The current clearance opens in the upper half of the window. Price changes,
promotions, and clearances affecting the same item/location appear in the lower
half of the window.

Click Close to close the conflict review list. The Maintain a clearance procedure
contains additional information on how to adjust a clearance.

Click Done to save any changes and close the window.
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Maintain a Clearance

Maintain a Clearance

Navigate: From the Task Pad, select Clearances > Maintain Clearances. The Maintain
Clearances workspace opens.

I/C—) Clearance Search
* Departrnent l:l E+ * Clearance Id |
Class B Type Regula

Subclass B+ Status - Select -

Ttern Level [[] search ©n This Lavel Only Create Date | | To | |

Diff Type [ select - E Effective Date | | To | |
S — T
Diff B8

L

} Location

b Advanced Search

| Cotear | Coea |

Maintain Clearances Workspace

1. Search for and retrieve the clearance you want to maintain. Your results appear in
the Clearance List pane.

@ Clearance List |
Cearance view [Markup Colurmn view ]| &
7] tem Item Descripf [tem Level | Diff Id Diff Id Descri| Location Location Desd Location Typd Primary Zone| Exception Ind Pars

Fitter by:| ||| Fitver by | ||| Fitver by | || Fitter byo| T|| Filter by W || Fitter by W[ Fitter by W || Fitver by T || Fitver b T Fitver by | || Fitber by || ik

Hornet Diff T...

561|100022004 |(Ariel zleapa.,. [Parent Ttam 11 Test ClrZon.. (Zone
542|10000001& |TestItemn 1. [Transaction . 1000000014 |Baltimore Store
541|100000016&  |TestItemn 1. [Tranzaction . 1000000014 |Baltimaere Store
S24[100025213 (MM Fashion .. [Transaction .. 1000000001 |Minneapoliz  |Store

4 [ »

W [[d222a50]pr] cotapage DF7 E
e e

| [ Delete | Mew I Copy |[_Loc Exception |[_Tran Exception ||

Clearance List Pane
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2. From the list of results, select the clearance you want to maintain. The clearance
details appear in the Clearance Maintenance pane.

(@ tlearance Maintenance

Qut OF Stock Date l:l
Rooce Boin 10402/ 2006
Apply Subclass Defaults [
Location Selection | ¢
Level ‘ 1d ‘ Description | Location Type
Stars |1000000020 |Or|and0 |Stwe
Item Selection Il ¢
Level | 14 | mif 1 | Description
Item |99990 | |p|. Regular Item 33930
| -—Apply |

Clearance Maintenance Pane

3. If necessary, change the status of the price change to Worksheet.

4. Edit the enabled fields as necessary.

Note: You cannot change the items and locations on a

clearance.

5. Click Apply to add all any changes.

6. Click Done to save any changes and close the window.
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Copy a Clearance
1. From the list of results, select the clearance you want to copy.

2. Click Copy. The clearance details appear in the Clearance Maintenance pane.

(@ tlearance Maintenance

® a8
Qut of Stock Date l:l
Reset Date 10/02/ 2008
Apply Subdass Defaults [
Location Selection | &
Level ‘ 1d ‘ Description | Location Type
Store |1EIEIEIEIEIEIEI2D |Or|ando |Stm’e
Iterm Selection | ¢
Level ‘ 1d ‘ Diff Id | Description
Item |99990 | |p|_ Reqular Itam 93390

| |
Clearance Maintenance Pane

3. Edit the enabled fields as necessary.
4. Click Apply to add all any changes.

5. Click Done to save any changes and close the window.

Delete a Clearance
1. From the list of results, select the clearance you want to delete.

2. (Click Delete. You are prompted to confirm your decision.

Note: Only clearances in worksheet status can be deleted.

3. (Click Yes. The clearance is deleted.

4. Click Done to close the window.
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Check for Conflicting Clearance
1. From the list of results, select the clearance you want to check.
2. Click Conflict Check. If the system option, background conflict check, is on and
conflicts exist, the Conflict Review List window opens.

Conflict Review List

Conflict Review List

Change Type Change Amount Effective Date

Fixed Price $25.85 12-01-2005

3410

Pri ange 2

46 2-10-2004 5.06 EACH

Conflict Review List Window

e If no conflicts exist, click OK.

o If conflicts exist, you must adjust the details of your clearance before you can
move the clearance to the next status.

Note: See View conflict check results for more information
on background conflict checking.

3. Click Done to save any changes and close the window.
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Maintain a Clearance

Create a Location Exception

Note: Location exceptions can only be created for Zone Level
clearances.

1. From the list of results, select the clearance.

2. Click Location Exceptions. The locations selection area of the Clearance Maintenance
pane is enabled.

(& tlearance Maintanance

B ]
=

Sut Of Stock Date =

Apply Subdass Defaults []

Location Selection I <2

Level |14 | Description [ Location Type [

Stare |1nﬂnnnﬂn20 |Or|ando |Stm’e

Item Selection I

Level ‘ 1d ‘ Diff 1d | O |

Irem |99990 | |DL Regular Item 93990

| Ceeete |
Clearance Maintenance Pane

3. In the Location field, enter the ID of the location where items are different than the
[ ]
zone on the clearance, or click the LOV £l button and select a location.

4. In the enabled clearance fields, enter information about the clearance for the
item/location.

Click Apply to add any changes.
Click Done to save any changes and close the window.
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Create Item Exceptions at the Transaction Level

Note: Item exceptions at the transaction level can occur only
when the clearance was created at the item parent or item
parent/ diff level.

From the list of results, select the clearance.

2. Click Tran Exceptions. The item selection area of the Clearance Maintenance pane is
enabled.

I’(: tlearance Maintenance

ut Of stock Dats l:l@
Reset Date 10/02/z00s |E

Apply Subdass Defaults [

Location Selection Il &%

Level ‘ 1d ‘ Description | Location Type |

Stare |1nnnnnnn20 |Or|andn |Sture

Item Selection | &

Level |14 | miff1a | pescription [

Irem |99990 | |PL Regular Iter 93390

| Ceeete |
Clearance Maintenance Pane

3. Inthe Item field, enter the ID of the item for which items are different than the parent
]
item on the clearance, or click the LOV &1 button and select an item.

4. In the enabled clearance fields, enter information about the clearance for the
item/location.

Click Apply to add any changes.

6. Click Done to save any changes and close the window.
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Promotions

Promotions

A promotion is a temporary reduction in price. In addition, you can track sales at one or
more locations for a given time period as well as track the sales of merchandise with no
price reductions, at given locations for a set time period.

Updates can be made to the details of an existing promotion and promotion components
can be added to an existing promotion.

Promotion Components

e Simple Component - A simple promotion component consists of an item, item
group, or merchandise level that receives a discount at a specific location or group of
locations when the customer purchases an item.

e Threshold Component - A threshold promotion component consists of an item, item
group, or merchandise level that receives a discount at a location or group of
locations when the customer purchases a quantity or a amount of an item. You must
define the threshold levels before you can create the threshold component.

¢ Buy/Get Component - A buy/get promotion component consists of an item, item
group, or merchandise level allows you to define which items must purchased by the
customer in order to receive a discount for an additional item.

Changes can be made to the details of a promotion component, and new details can be
added to promotion components.

In the Promotion Component Detail Maintenance pane, records that contain
item/location exceptions or exclusions are indicated by a down arrow. Records that are
item/location exceptions or exclusions are indicated by an up arrow.

Existing promotion components can be copied into a new promotion.

Add Funding Information to a Promotion

Funding is added to a promotion at the component level so that you can indicate the
vendor that is contributing to the promotion. If you choose to create deals, based on the
funded component, you must indicate the billing information for the deal. If the
promotion is associated with an existing deal, the billing information defaults from the
existing deal.

Promotion Event

A promotion event is a method of grouping promotions that occur during a period of
time. Each event can be associated with many promotions, but a promotion can only be
associated with one event.

Updates can be made to the details of existing promotion events.

Threshold Definition

A threshold is a discount that a customer receives for purchasing a pre-determined
amount of an item. You must define the levels that exist in the threshold, then associate
the threshold definition to the threshold component.
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Vendor Funding Defaults

When an item is on promotion at a retailer, part of the discount a customer receives may
be contributed by the vendor. When you set up a promotion, you can define the vendor's
contribution.

You can create billing information defaults at the vendor level, which allows you to
apply the information to any deal that is created through the promotions dialog that is
associated with the vendor

Promotion Constraint

The Maintain Promotion Constraint workspace allows you to maintain promotion
constraints. You set up promotion constraints at the department, class, or subclass level
for a particular zone or location. A warning will appear if a price change or promotion is
created that would fall a certain number of days before or during another approved
promotion or price change. The number of days before the promotion is the promotion
constraint.
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Create a Promotion

Navigate: From the Task Pad, select Promotion > Create Promotion. The Create

Promotion workspace opens.
OR

From the Maintain Promotion Events workspace, click New Promotion. The Create

Promotion workspace opens.

%5 Create Promotion

I-/C—" Promotion Header
Description | | =) End Date l:l
s
8
Feferenced Deals | Referenced Deals: Mone [Js=condary application of Discounts
I-/(J Promotion Components |
I &,
Component Id (3 | Component Name Status Secondary Application Conflicts |
Add Component || Create fram Existing
Corlicts Marage Oueraps carcel || save + Repest || Done |

Create Promotion Workspace

1. In the field to the left of the Promotion field, enter the name of the promotion.

o b 0N

In the Description field, enter additional information as necessary.
In the Start Date field, enter the day the promotion begins.
In the End Date field, enter the day the promotion stops.

In the Event field, enter the ID of the event you want to associate with the promotion,

or click the LOV button and select an event.

Update the Currency field as necessary.

7. Select Secondary Application of Discounts as necessary.

In the Valid Department field, enter the departments for the promotion, or click the
LOV button and select the departments.
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Associate a Deal with a Promotion
1. Click Referenced Deals. The Referenced Deals window opens

Referenced Deals

Available Deals

Deal ID Deal Type Yendor Name | Status Active Date Close Date Currency |

9802 Promational *Marmo Dry 5. Approved 08-31-2001 | 08-31-Z008 | euro . |

QE03 Prorotional WISE POTA,., | Approved 0%-21-2001 05-21-2008 | euro

Q204 Promotional LIGUORE MA,., | Approved 0%-21-2001 05-21-2008 | euro

203 Promotional LIGUOR MA.., | Approved 0%-21-2001 05-21-2008 | euro

Q207 Promotional *Marmo Cry 5. Approved 0g-29-2001 0g-23-2002 UKD

Q209 Prornotional *Mamo Cey S| Approved 0g-29-2001 0g-27-2002 EUFD

9811 Prornotional *Momo Dry 5. &pproved 08-29-2001 | 08-22-2008 | US Dollar

3515 Promational *Marmo Dry S..| &pproved 05-29-2001 | 08-31-2007 | US Dollar

Q216 Promational FAST FOOD .| Approved 0%-21-2001 08-21-2008 | auro

9517 Promatinnal LTS O B8 Snnrnusd Os-=1-20n01 Os-=1-200 LIS Dinllar vI

[=][a]

Linked Deals

Deal ID Deal Type Yendor Name | Status | Active Date Close Date Currency |
l
=

Cancel || Select |

Referenced Deals

Window

2. Select the deals you want to add to the promotion.
3. Click Select. The window closes.

4. Click Done to save any changes and close the workspace.
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Add Components to a Promotion

1.
workspace opens.

In the Promotion Components pane, click Add Component. The Create Component

%3 create Component

‘-‘(—T Promotion Component

* Pramaotion

I =

« Emei ]

cancel |[_save |[

save +Repeat J[_pone |

Create Component Workspace

2. Add the appropriate type of component to the promotion to:
= Create a simple component
=  Create a threshold component

= Create a buy/get component

Add a Component from an Existing Component

1. Click Create from Existing. The Copy Promotion Component window opens.

.
= Copy Promotion Component

¥ Brarmation

Start Date

03/ 26fz001 End Date  |gzfzofzool

Copy Promotion Component
2. Inthe Promotion field, enter the ID the component is associated with, or click the

LOV El button and select the promotion.

LOV El button and select the promotion.
Update the Start and End Date fields as necessary.
Click Copy. The component is added to the Promotion Component table.

In the Component field, enter the ID of the component you want to copy, or click the
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Search for a Promotion

Navigate: From the Task Pad, select Promotions > Maintain Promotion. The Promotions

Search workspace opens.

%5 Promotions Search

I@ Promotion Search Criteria

Prornotion |

Stark Diate: After l:l

Item

End Date: After |:|

I=]

b Location

» Advanced Search

Event
Status
Befare

Bafare

[ 18

 m
—

=
I@ Promotion Search Results |

Promotions Search Workspace

1. Expand the Promotion Search Criteria pane.
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(@ Promotion Search Criteria

Start Date: After l:l Befare l:l
End Data: Aftar l:l Before I:I
Ttern | [=]] |

* Location

R E— e —
o —
e R—

Diff 1D B Departmant I:I B+
Division l:l = Class B+
Group l:l g Subclass B+
vendor Funding [ gelect 7] Deal ID I:I S|

| [Cretresh ] [_seerdr ]|
Promotion Search Criteria Pane

2. Enter or select the criteria to limit your search.

3. Click Search. Promotions that match these criteria appear in the Promotion Search
Results pane.
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Maintain a Promotion

Navigate: From the Task Pad, select Promotions > Maintain Promotion. The Promotions
Search workspace opens.

%5 Promotions Search

I@ Promotion Search Criteria

Prornotion | Event l:l S|
Currency l:l S| Status l:l 8+
Stark Date: After l:l Before l:l

End Date: After l:l pefore l:l

Item | |8 |

b Location

» Advanced Search

=
I@ Promotion Search Results |

Promotions Search Workspace

1. Search for a promotion.
2. In the Promotion Search Results pane, select the promotion you want to edit.
3. (lick Edit. The Maintain Promotion workspace opens.
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(© Promotion Header

¥ Prometion ‘742 | it ‘summer tows | Comments £ * Start Date |11f15f2c|c|1 |a‘12:uu A |

Description [rey promo | 57 End Date [tirzorza01 | (1200 am |

Event | | B ‘ | Status |Appmugd * |
* Currency |,_|5D | B ‘us Lollar | Total Markup % |N;A |

Referenced Daals | Referenced Daals: None [ 2candary Application of Discounts

*valid Departrments |1DUZJZUU}3456;:| §+ |Mult|p|e Values |

(©® Promotion Components

I &
Component Id (}) Component Name Type Status Secondary Application Conflicts
2043 ETS threshold copy Threshold WWarksheet O
541 buy getfunded Buy/Get Warksheet |
a1 buy getfunded Buy/Get Approved O
222 Apprud buy get Buy/Geat approved ]
[ conflict check | [ _Add comporent | [ create from Existing | [ Delete Component | [ Edit

Component Id

| |
Cormponent Hame | |
| |
| |

Type
Status Action [ select - :]
Secondary Application of Dizcounts |

Update

Maintain Promotion Workspace

4. In the Promotion Header pane, edit the enabled fields as necessary.

5. Click Done to save any changes and close the workspace.

User Guide 189



Maintain a Promotion

Check for Conflicts

1. From the Promotion Components pane, select the promotion component you want to
check.

I@ Promotion Components |

I |
Component ID [} Component Name Type Status Sacondary Application | Conflicts
t 941 simple

055 Crefect 941 buyfget BuyfGet Worksheet O
3087 Defect 941 threzhold Threzhold Worksheet O

Conflick Check || Add Component || Delete Component || Edit |
Compenent 1D 2082
Component Mame Defect 941 simple
Type Simple
Status e e Action n

Secondary Application of Discounts
Update

Promotion Components Pane

2. Click Conflict Check. If the system option, background conflict check, is off and
conflicts exist, the Conflict Review List window is displayed.

Conflict Review List " &
I Promotion Componen| Ttem Location Change Type Change Amount Effective Date
Price Change Tyj ID Promotion Comp Date Unit Retail on E4 Selling UOM Multi Units Multi-Unit Retai| Mult-Unit Selli
Price Change 2221 12-04-2004 §26.24 EACH

Price Change 3243 12-01-2005 §35.22 EACH

Conflict Review List Window
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Note: See View conflict check results for more information
on background conflict checking. When background conflict

check is on, a binocular G icon appears in the conflict
column when conflict checking is complete. Click the icon to
open the Conflict Review List workspace.

= Jf no conflicts exist, click OK.

= If conflicts exist, you must adjust the details of your promotion before you can

move the promotion to the next status.

3. Click Done to save any changes and close the window.
Add a Component
1. Click Add Component. The Create Component workspace opens.

%9 create Component

(@ Promation tompanent

- fmp ]

Create Component Workspace

2.

Add the appropriate type of component to the promotion to:
= Create a simple component
= Create a threshold component

= Create a buy/get component

Add a Component from an Existing Component

1.

Click Create from Existing. The Copy Promotion Component window opens.

-
= Copy Promotion Component

¥ Pramotion

(=

Start Date

e @

End Date  |gafapizool |6

Copy Promotion Component

2.

In the Promotion field, enter the ID the component is associated with, or click the

LOV El button and select the promotion.

In the Component field, enter the ID of the component you want to copy, or click the

LOV El button and select the promotion.
Update the Start and End Date fields as necessary.

Click Copy. The component is added to the Promotion Component table.
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Associate a Deal to a Promotion
1. In the Promotion Search Results pane, select the promotion you want to edit.

2. Click Edit. The Maintain Promotion workspace opens.

B3 Maintain Promotion

(@ Promotion Header

* Promotion 742
Description
Event

* currancy

uso

¥ summer toys

toy prome

B Us collar
Fefarencad Deal: | Refersnced Deals: None
*
Valid Departments |1002)200;2456 1| B+ |Multiple values

Comments @

* Start Date 11/15/z001 || 1200 Am
& End Date 11/2972001 | [12:100 AmM
Status #pproved *

Total Markup % [l

Secondary Application of Discounts

I@ Promotion Components

I &
Component Id (}) Component Name Type Status Secondary Application Conflicts
2043 ETS threshold copy Threshold WWarksheet O
541 buy getfunded Buy/Get Warksheet |
a1 buy getfunded Buy/Get Approved O
222 Apprud buy get Buy/Geat approved ]
conflict check | [_add component ] [ create from Existing | [ Delete component |[_Edit

Component Id

Component Name

Type

Status Action [~ gelect - |Z|

Secondary Application of Discounts

| cenflicts || Mansge verlaps |[_cancel |[_Cene

Maintain Promotion Workspace

3. C(lick Referenced Deals. The Referenced Deals window opens
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Referenced Deals

Available Deals

Deal ID Deal Type Yendor Name | Status Active Date Close Date Currency |

as0z Promotional *Mamo Dry 5. Approved 08-31-2001 | 08-31-2008 | eurn — |

803 Promotional WISE POTA.., | Approved 0g-21-2001 0g-21-z002 UKD

Q804 Prornotional LIGQUOR MA.., | Approved og-21-2001 0g-21-2002 EUFD

Q805 Prornotional LIGUOR MA.., | Approved 0g8-31-2001 0g8-31-2008 EUFa

Q807 Promational *Marno Dry S..| &pproved 0%-23-2001 058-28-2008 | euro

Q209 Promational *Marno Dry 5. Approved 0g-23-2001 08-27-2008 | auro

2211 Promotional *Marmo Dry .. Approved 08-29-2001 | 08-22-2008 | US Daollar

2215 Promotional *Mamo Dry .. Approved 08-29-2001 | 08-31-2007 | US Collar

RSN Promotional FAST FOOD .| Approved 0%-21-2001 05-21-2008 | euro

951 Erorntingal LT[R RS Annrnuesd O8-31-2001 O8-31-200 115 Dinllar TI

il [

Linked Deals

Deal ID Deal Type Yendor Name | Status | Active Date Close Date Currency |
A
=]

Cancel || Salact |

Referenced Deals Window

4. Select the deals you want to add to the promotion.

5.
6.

Click Select. The window closes.

Click Done to save any changes and close the workspace.
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Add a Department to a Promotion

Use this procedure to add departments to a promotion after the promotion has been

created.

Navigate: From the Task Pad, select Promotions > Add Department to a Promotion. The
Add Department to Promotion workspace opens.

%5 Add Department to Promotion

I'/C; Promotion Search Criteria

Prarmotion | Event I:I 8

Currency I:I S| Status I:I 8+
* Start Date: After l:l * Before l:l

End Date: After l:l Before l:l

Item | |8 |

b Location

¥ Advanced Search

__Clear __Search |
|'@ Promotion Search Results |
|'/@ Add Department |

Add Department to Promotion Workspace

1. Enter or select the criteria to limit your search.

Note: You must enter a Start Date range.

2. Click Search. Promotions that match these criteria appear in the Promotion Search
Results pane. The Add Department pane opens.

I/CJ Add Department

8

Add Department Pane
3. Select the promotion to add departments to.

4. In the Department field, enter the Department number or click B+ (LOV) and select
from the list of values.

Click Add.

Click Done. The workspace closes, and the departments are added to the promotion.
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Promotion Components

Create a Simple Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%9 create Component

“[’—“ Promotion Component

* Descr ptian
* Component Type  [simplz ]

cancel || save |[ save +Repest || pone

Create Component Workspace

1. Inthe Promotion field, enter the ID the promotion is associated with, or click the
LOV &l button and select the promotion.

2. Inthe Description field, enter a description of the component.
In the Component Type field, select Simple.

Click Next. The Promotion Component - Simple pane opens.
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(@ Promotion component - simple

¥ Item Selection

Clear Selact

Item Selection " y;

Level 1] Diff ID | Description |

» Location Selection

Clear Selact

Location Selection " y;
Level ] Description | Location Type |
* Change Type Feeiez - 5]
=
=l
* Start Date & Time |01.-‘01.-‘2006 |E| |12:00 AM |
End Date & Time |12.-'31.-‘2006 |E||11:59 PM |
* aply Ta [oees- [o]
Price Guide | | H
| | Apply & Repeat || Apply || Clear ||

Promotion Component - Simple Pane

Add Items and Locations to a Promotion Component

1. In the Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV &l button and select the criteria.
Click Select. The items are added to the Item Selection table.
In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV &l button and select the criteria.

4. Click Select. The locations are added to the Location Selection table.
In the Change Type field, select the price change that occurs during the promotion:

= Change By Percent: A price for an item is changed by a percentage removed
from the original price. The percent of change is determined by the percent
entered in the Change Amount field.

= Change By Amount: A price for an item is changed by an amount removed from
the original price. The amount of change is determined by the amount entered in
the Change Amount field.

= Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

= No Change: The price of the item is not changed. For reporting purposes, the
item is recognized as being on promotion.
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10.

11.

= Exclude: The item will not be affected by price changes that occur as a result of
the promotion.

In the Change Amount field, enter the amount, percent, or fixed amount the price
changes.

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A promotion
can only exist as a decrease in price.

In the Selling UOM field, enter the unit of measure for the items, or click the LOV
button and select the selling UOM.

Update the Start and End Date & Time fields as necessary.

In the Apply To fields, select the types of item pricing that you want to apply the
promotion.

Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

Click Done to save any changes and close the workspace.

Add Funding to a Simple Component

1.
2.

Create a simple component

Expand the Funding pane.

(@ Funding

Corporate Funding Percent

Create Deals
vendar Type [supplier =]
vender 5673 SUPPLIER-2
Contribution % |10
Deal Billing Clear Apply

I

¥endor Type | ¥endor ID Contribution % Deal ID Deal Comp ID Use Deal Locations ‘ Use Deal Items

Funding Pane for Simple Components

3.

In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.

Select the Create Deals check box to create a deal based on this promotion
component and funding.

In the Vendor Type field, select the type of vendor that is funding the component.
In the Vendor field, enter the ID of the vendor, or click the LOV El button and select

a vendor.
In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.
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Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.

9. In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.

10. Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

11. Select the Use Deal Items check box to indicate that the items on the deal should be
used for the promotion.

Note: The Use Deal Locations and Use Deal Items check
boxes are disabled if the promotion component already has
items or locations.

12. If you selected the Create Deals check box, add billing information for a deal to a
funded component.

13. Click Apply to add your changes to the table.
14. Click Done to save any changes and close the workspace.

Create a Threshold Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%3 create Component

‘-'(2 Promotion Component

* Desari ption
* Component Type  [Gimple 7]

cancel |[ save |[ save +Repest |[ Done

Create Component Workspace

1. In the Promotion field, enter the ID the promotion is associated with, or click the
LOV El button and select the promotion.

2. In the Description field, enter a description of the component.
In the Component Type field, select Threshold.

4. Click Next. The Promotion Component - Threshold pane opens.
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IP Promotion Component - Threshold

¥ Item Selection

Item Selaction |
Level I Diff ID | Description |
¥ Location Selection

Location Selection " y;
Level I Description | Location Type |

* Threshald [ ] New Threshald

* Start Date & Time |01.|'01.|‘2006 |@ |12:00 A |
End Date & Time |12.-‘31.-‘2006 |@|11:59 P |

®eerly T [seless- [T

| Apply 8 Repeat || Apply [ Clear ||

Promotion Component - Threshold Pane

Add Items and Locations to a Promotion Component

1.

In the Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV &l button and select the criteria.

Click Select. The items are added to the Item Selection table.

In the Location Selection area, select how you want to add locations to the
promotion, or click the LOV & button and select the criteria.

Click Select. The locations are added to the Location Selection table.

In the Threshold field, select the threshold you want to associate with the promotion,
or click New Threshold to create a threshold definition.

Update the Start and End Date and Time fields as necessary.

In the Apply To fields, select the types of item pricing that you want to apply the
promotion.

Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

Click Done to save any changes and close the window.
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Add Funding to a Threshold Component

1.
2.

Create a threshold component.
Expand the Funding pane.

I‘P Funding

Corporate Funding Percent |10, naoc]

~ Threshald Uptake &

12 |

Threshold Discount ‘ Selling UOM | uptake 7 H

$5.00 0% 109)

$15.00 0%

Uptake %

Create Desls
endor Type [Manufactrer =l
Contribution % |w

| 12

Yendor Type

Supplier

Edit Dalets

Funding Pane for a Threshold Component

3.

10.

11.

12.

In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.
Select a threshold.

In the Uptake % field, enter the percentage of customers that you expect to take
advantage of the promotion at this threshold.

Click Apply to add your changes to the table.

Select the Create Deals check box to create a deal based on this promotion
component and funding.

In the Vendor Type field, select the type of vendor that is funding the component.

In the Vendor field, enter the ID of the vendor, or click the LOV ] button and select
a vendor.

In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.

In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.
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13. Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

14. Select the Use Deal Items check box to indicate that the items on the deal should be
used for the promotion.

Note: The Use Deal Locations and Use Deal Items check
boxes are disabled if the promotion component already has
items or locations.

15. If you selected the Create Deals check box, add billing information for a deal to a
funded component.

16. Click Apply to add your changes to the table.

17. Click Done to save any changes and close the workspace.

Create a Buy/Get Component

Navigate: From the Task Pad, select Promotions > Create Component. The Create
Component workspace opens.

OR

From the Create Promotion workspace, click Add Component in the Promotion
Components pane. The Create Component workspace opens.

%3 create Component

‘-"(3 Promotion Component

* Description
* Component Type  [gimple 7]

Create Component Workspace

1. Inthe Promotion field, enter the ID the promotion is associated with, or click the
LOV El button and select the promotion.
In the Description field, enter a description of the component.
In the Component Type field, select Buy/Get.
Click Next. The Promotion Component - Buy Get pane opens.
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I(: Promotion Component - Buy Get

Buy Item Get Item
Tee Ol *ChangeTipe  [satea 5]
(@) Any
=
*startDate & Time  [oy/01/2006 |@[12:00 am |
End Date & Time |12.-‘31.-‘2006 |E||11:59 =121 |
* Item Selection
=
=
-
=
Itern Type |Item lzl
Itern Level 'Transaction Level Itern lzl
=
Buy Items " &; Get Items " &;

Ttem | Description | Them Description |

¥ Location Selection

Promotion Component - Buy Get Pane

Define the Buy/Get Terms

1.

In the Buy Item area, select how the items on the list of buy items must be purchased.

= AllL All the items on the Buy Items list must be purchased in order to receive the
discount

* Any: Any of the items on the Buy Items list must be purchase in order to receive
the discount.

In the Quantity field, enter the number of items that need to be purchased in order to
receive the discount.

In the Get Item area, select the type of discount received when the qualifying items
and quantity is purchased.

=  Percent Off: A price for an item is changed by a percentage removed from the
original price. The percent of change is determined by the percent entered in the
Change Amount field.

= Amount Off: A price for an item is changed by an amount removed from the
original price. The amount of change is determined by the amount entered in the
Change Amount field.

= Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.
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4. In the Selling UOM field, enter the unit of measure for the items, or click the LOV
button and select the selling UOM.

5. In the Change Amount field, enter the amount, percent, or fixed amount the price
changes.

Note: There is no need to enter a negative sign before the
number entered in the Change Amount field. A promotion
can only exist as a decrease in price.

6. Update the Start and End Date & Time fields as necessary.

Add Items and Locations to a Promotion Component

Note: You may have to expand the Item Selection and
Location Selection area to view the criteria

1. Inthe Item Selection area, enter the criteria you want to use to select the items on
promotion, or click the LOV &l button and select the criteria.
2. Add the items to the Buy Items or Get Items table.

= C(lick Add to Buy Items to add items to the list of items that qualify the
purchaser for the discount.

= (lick Add to Get Items to add items to the list of items that receive the discount.

Note: Depending on the system setting for Allow Buy/Get
Cycles you may be prohibited from entering the same item
in the buy and get lists. If cycles are permitted, then multiple
identical items may be added to both the buy and get lists.

3. Inthe Location Selection area, select how you want to add locations to the
[ ]
promotion, or click the LOV & button and select the criteria.
Click Select. The locations are added to the Location Selection table.

In the Apply To field, select the types of item pricing that you want to apply the
promotion.

6. Click Apply. The promotion opens in the Promotion Component Detail Maintenance
pane.

7. Click Done to save any changes and close the window.
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Add Funding to a Buy/Get Component

1.
2.

Create a buy/get component.

Expand the Funding pane.
(= Funding
Corparats Funding Percent
Uptake %
Creste Deals
vandar Type [Manufacturer =
L
Contribution % ‘10

I

¥endor Type ¥endor ID Contribution % Deal 1D Deal Comp 1D ‘ Use Deal Locations

Funding Pane - Buy/Get Component

3.

10.

11.

12.

13.
14.

In the Corporate Funding Percent field, enter the percent that the retailer contributes
to the promotion.

In the Uptake % field, enter the percentage of customers that you expect to take
advantage of the promotion at this threshold.

Select the Create Deals check box to create a deal based on this promotion
component and funding.

In the Vendor Type field, select the type of vendor that is funding the component.

In the Vendor field, enter the ID of the vendor, or click the LOV &l button and select
a vendor.

In the Deal ID field, enter the deal the promotion is associated with, or click the LOV
button and select a deal.

In the Deal Comp ID, enter the ID of the deal component field, or click the LOV
button and select a deal component.

Note: The Deal and Deal ID field are disabled if you selected
the Create Deals check box.

In the Contribution % field, enter the percentage that this vendor contributes to the
promotion component.

Select the Use Deal Locations check box to indicate that the locations on the deal
should be used for the promotion.

Note: The Use Deal Locations check boxes are disabled if the
promotion component already has locations.

If you selected the Create Deals check box, add billing information for a deal to a
funded component.

Click Apply to add your changes to the table.

Click Done to save any changes and close the workspace.
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Add Billing Information for a Deal to a Funded Component

1.
2.

Click Deal Billing. The Deal Billing window opens.

Select the information about the deal that you require:

Deal Reporting Level: The frequency that the deal is reported.

Bill Back Method: The type of invoice that is created for the supplier. Select the
appropriate option.

Bill Back Period:The frequency that the vendor is charged for the bill back.
Select when to charge the vendor.

Invoice Processing Logic:The method used to create invoices. Invoices are
created automatically, manually, or not at all depending on the option selected.
Include VAT in Deal Billing: Select the check box to indicate that VAT should
be included in the invoice information.

Include Deal Income in Stock Ledger: Select the check box to indicate that deal
income accrual should be written to the stock ledger.

Click Done to save any changes and close the window.

Maintain a Promotion Component

Navigate: From the Task Pad, select Promotion > Maintain Component. The Maintain
Component workspace opens.

3 Maintain Component

in Promotion Component

S

Cancel || Save || Done

Maintain Promotion Component Workspace

1.

In the Promotion field, enter the ID of the promotion that the component is
]
associated with, or click the LOV &l button and select a promotion.

In the Component field, enter the ID of the component you want to maintain, or click
1
the LOV El button and select a component.

Click Next. Additional component maintenance panes are displayed.

Note: Collapse and expand areas and panes to view the
information needed to complete the task.
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Maintain Component Details

1.

w

N oo o &

In the Promotion Component Detail Maintenance pane, edit the name of the
component as necessary.

Enter the consignment rate used for the item while it is on promotion, if necessary.

To edit a specific record, select a record, or click Select All to make changes to all
records on the table.

Click Edit.
Edit the enabled fields as necessary.
Click Apply.

Click Done to save any changes and close the workspace.

Delete Component Details

1.

a r DN

In the Promotion Component Detail Maintenance pane, select the record you want to
delete:

= To edit a specific record, select a record

= (Click Select All to make changes to all records on the table.
Click Delete.

You are prompted to confirm your decision.

Click Yes. The item location is removed from the table.

Click Done to save any changes and close the workspace.

Define Item Exceptions and Exclusions

1.

In the Promotion Component Detail Maintenance pane, select the record for which
you want to create an item exception or exclusion. The Item Exceptions and
Exclusion pane opens.

In the Location field, enter a location ID, or click the LOV E1 button and select a
location.

Note: You can only create item exceptions or exclusions for
items above the transaction level.

Create the exception or exclusion:
= Click Create Exceptions to create an exception to the selected record.
=  Click Create Exclusion to create an exclusion.

The pane closes. In the Promotion Component Detail Maintenance pane exceptions
and exclusions are indicated in the Exclusion/Exception Indicator column:

= A down arrow indicates that the item/location records contains an exception or
exclusion.

* An up arrow indicates that the item/location records is an exception or
exclusion.

Click Done to save any changes and close the pane.
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Define Location Exceptions and Exclusions

1.

In the Promotion Component Detail Maintenance pane, select the record for which
you want to create a location exception or exclusion. The Location Exceptions and
Exclusion pane opens.

In the Location field, enter a location ID, or click the LOV 1 button and select a
location.

Note: You can only create location exceptions or exclusions
for locations at the zone level.

Create the exception or exclusion:
= C(lick Create Exceptions to create an exception to the selected record.
= C(lick Create Exclusions to create an exclusion.

The pane closes. In the Promotion Component Detail Maintenance pane exceptions
and exclusions are indicated in the Exclusion/Exception Indicator column:

= A down arrow indicates that the item/location records that contain an exception
or exclusion.

= Anup arrow indicates that the item/location records that is an exception or
exclusion.

Click Done to save any changes and close the pane.
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Promotion Event

Create a Promotion Event

Navigate: From the Task Pad, select Promotion Events > Create/ Maintain Events. The
Maintain Promotion Events workspace is displayed.

B Maintain Promotion Events

‘/(—1 Maintain Promotion Events

Event 1d Event Dascription Theme Start Date & Time End Date & Time

Fall Event | ‘App\e ‘ ‘10114/2004 “12:00 A ‘ ‘10115/2004 “11:59 P ‘
Event 1d Event Description Theme Start Date End Date
67 The Never Ending Event 10-31-2004 10-31-200%
7z RF 21 testing I Don't Know 10-19-2004 10-31-2004
74 Alli Event 11-01-2004 12-01-2005
63 smm prama avant auent 06-02-2005 09-31-2005

EE Starts today Fun 10-01-2004 10-22-2004

Delate New Promction

cancel |[_save +Repeat |[_Done |

Maintain Promotion Events Workspace

1. In the Promotion Events section, click New.

In the Event Description field, enter a name for the event you are creating.

In the Theme field, enter any additional informative information about the event.
In the Start Date and Time fields:

a. In the first field, enter the date the event starts, or click the LOV % button and
select a date.

P 0N

b. In the second field, enter the time the event starts.
5. In the End Date and Time fields:

a. In the first field, enter the date the event ends, or click the LOV % button and
select a date.

b. In the second field, enter the time the event ends.
6. Click Apply. The promotion event is added to the table.
Click Done to save any changes and close the window.
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1.

workspace is displayed.

Promotions

In the Maintain Promotion Events pane, click Add Promotion. The Create Promotion

B9 Create Promotion
(@ Promotion Header
* promotien  [4e01 * I:I Comments £ * Start Date l:l
Description | | End Date l:l
* Currency B [us collar Total Markup % [jyra
Referanced Deals: Nona |:| Secondary Application of Discaunts
*y5lid Departrments l:l 8-
I@? (e e (e ‘
I &
Component Id Component Name Type Secondary Application Conflicts |
Corflict check |[_Add Component |[_creata from Existing | [ Delete component | [ Edit |
Camponant 1d
Cormpenant Name
Type
Status = E
Secondary Application of Discounts
conflicts, || tanage overaps J[ cancel || save + Repeat | _Done
Create Promotion Workspace

2.

Add the appropriate details to create a promotion.

User Guide 209



Promotion Event

Maintain a Promotion Event

Navigate: From the Task Pad, select Promotion Events > Create/ Maintain Events. The
Maintain Promotion Events workspace opens.
B Maintain Promotion Events
@ Maintain Promotion Events
Event 1d Event Description Therne Start Date & Time End Date & Tirme
Fall Evant | ‘App\e ‘ ‘10]14/2004 “12:00 AM ‘ ‘10]15/2004 “ H
I

Event Id Event Description Theme Start Date End Date
&7 The Hever Ending Event 10-31-2004 10-31-200%
73 RF 21 testing ICon'tKnow 10-19-2004 10-31-2004
74 Alli Event 11-01-2004 12-01-2005
-] IMM promo event suent 08-02-2009 08-31-200%

EE Starts today Fun 10-01-2004 10-22-2004

Delate New Promction

cancel |[_save +Repeat |[_Done |

Maintain Promotion Events Workspace

1. Select the event you want to maintain from the table.

In the Promotion Events area, edit the enabled fields as necessary.

2
3. Click Apply. Your changes are added to the promotion event and appear on the table
4

Click Done to save any changes and close the window.

Delete a Promotion Event

1. Select the event you want to delete from the table.

2. (Click Delete. You are prompted to confirm your decision.
3. Click Yes. The record is removed from the table.
4

Click Done to close the window.
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Threshold Definition

Create a Threshold Definition

Navigate: From the Task Pad, select Promotion Threshold > Create Threshold. The
Create Threshold workspace opens.

%3 create Threshold

(@ Threshold treate

* Narme
* Currency
* Guslification Type

* Threshold Type

[ select -

[ select -

[ setact -

ET|ET|ET

Threshald Typs

selling Uom

L]

cancel |[_save + Repeat [[_Done

Create Threshold Workspace

1.
2.

8.
9.

In the Name field, enter a description of the threshold you are creating.

In the Currency field, enter the ID of the appropriate currency, or click the LOV
button and select a currency.

In the Qualification Type field, select how the threshold is met:

= Threshold Level: All items on the promotion can be counted together to meet the
terms of the threshold and have the promotion applied.

= Item Level: Each item on the promotion must meet the threshold to have the
discount applied.

In the Threshold Type field, select the measure that indicates how the threshold is
met:

* Quantity: A number of units of an item must be purchased by the customer from
the retailer.

= Amount: A value of the item must by purchased by the customer from the
retailer.

In the Discount Type field, select the method used to determine the new price of the
item.

= Percent Off: A price for an item is changed by a percentage removed from the
original price. The percent of change is determined by the percent entered in the
Change Amount field.

= Amount Off: A price for an item is changed by an amount removed from the
original price. The amount of change is determined by the amount entered in the
Change Amount field.

= Fixed Price: The price for the item will be at a specified retail that will be defined
in the change amount field.

If you choose Fixed Price in the Discount type field, you must enter the Selling UOM
for the item.

In the threshold area on the right, enter the amount or quantity that needs to be
purchased in the Threshold Type field.

In the Discount Type field, enter the percent off, amount off, or fixed price received.
Press Tab to add additional threshold levels.

10. Click Done to save any changes and close the window.
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Vendor Funding Defaults

Create Vendor Funding Defaults

Navigate: From the Task Pad, select Vendor Funding Defaults > Create Defaults. The
Create Defaults workspace opens.

%3 create Defaults

I(:' ¥endor Funding Defaults Creation

*vandar Type - Salactk - lzl

Cancel || Save + Repeat || Lone

Create Defaults Workspace

1.

In the Vendor Type field, select the type of vendor that is contributing to the
promotion.

In the Vendor field, enter the ID of the vendor, or click the LOV =l button and select
a vendor.

In the Deal Reporting Level field, select the frequency of deal reporting.

In the Bill Back Method field, select the type of invoice that is created for the supplier.

In the Bill Back Period field, select the frequency that the vendor is charged for the
bill back.

In the Invoice Processing Logic field, select the method used to create invoices.
Invoices are created automatically, manually, or not at all depending on the option
selected.

Select the Include VAT in Deal Billing check box to indicate that VAT should be
included in the invoice information.

Select the Include Deal Income in Stock Ledger check box to indicate that deal
income accrual should be written to the stock ledger.

Click Done to save any changes and close the window.
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Edit Vendor Funding Defaults

Navigate: From the Task Pad, select Vendor Funding Defaults > Maintain Defaults. The
Maintain Defaults workspace opens.

I@ Maintain Yendor Funding Defaults

Supplier GE Capital Manth Cebit Mote Week Automatic &ll.,
Supplier E5S Supplier .. [Month Credit Mote Manth Automatic &l
Supplier prada fazhion [Manth Credit Mote Annual Automatic All..
Supplier Glassware Pr.. [Manth Credit Mote Annual Autamnatic Al J I
Supplier James Hardie ...|Month Credit Mote Annual Automatic All.., J |
Supplier Super Sonic Manth Credit Mote Manth Ma Invaice Pr. D -
* vendor Type Suppliar
*
Wendor 1234560000 Max Brown Whale

* Deal Reporting Level

* Invaice Processing Logic

* pill Back Method

* pill Back Period

Include WAT in Deal Billing

Include Deal Incorne in Stock Ledger

|Aut0matic All Walues

[credit note

|Annua|

[

O
O

Maintain Vendor Funding Defaults Workspace

1.
2
3.
4
Delete a Vendor Funded Default

1.

2
3.
4

On the table, select a vendor.

Update the enabled fields as necessary.

Click Apply to add your changes to the table.

On the table, select a vendor. The details area is enabled.

Click Done to save any change and close the window.

Click Delete. You are prompted to confirm your decision.
Click Yes.
Click Done to save any change and close the window.

User Guide 213



Promotion Constraint

Promotion Constraint

Maintain a Promotion Constraint

Search for a Promotion Constraint

Navigate: From the Task Pad, select Promotion Constraints > Maintain Promotion
Constraints. The Promotion Constraints workspace opens.

%5 Maintain Promotion Constraints

I@ Promotion Constraint Search

Clazs

Subclass

a8+
8+

Zone

Location

B+
[ 18+

o] [

Cancel

Maintain Promotion Constraints Workspace

1. Enter or select the criteria to limit your search.

2. Click Search. Your results appear in the Promotion Constraints List.

I@ Promwotion Constraints

B+
| B

Clazs

Subclass

Zone

Locstion

¥ Constraint

B+
(I

Promotion Contraint List | &

DepartmentId | Department Class Id Class Subclass Id Subclass Location Id Location Constraint

Fitter by ¥ ||| Frtter by ¥ ||| Fitrer by ¥ ||| Filker by || Fidber by ¥ || Fitker by || Fidter by ¥ | | Fitter by ¥ ||| Fiter by h
1005 REPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000007 Fresno 5| &
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000005 @akland s |
1005 RPM QA Test D..[1015 RPM QA **Ple., [1025 RPM Q4 **Ple.,. (1000000002 Madison - Inclu... 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000021 Duluth 5
1005 REPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000020 aHanda 5
1005 RPM QA Test D..[1015 REM QA **Ple., [1025 RPM Q4 **Ple.,. (1000000013 Buffalo - Includi.. 5
1005 REPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.,. (1000000001 Minneapaolis 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000022 @mzha 5
1005 REPM QA TestD..[1015 REPM QA **ple.. (1025 RFM QA **ple.. (1000000008 Boston - largere.. 5
1005 RPM QA Test D.. 1015 REM QA **Ple., (1025 RPEM Q4 **Ple.. (1000000013 [lacksonuille 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM A **ple.. (1000000018 Charlestan 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM QA **ple.. (1000000017 Charlotre 5
1005 RPM QA TestD..[1015 RPM QA **ple.. (1025 RFM & **ple.. (1000000000 Fargo 5
1005 RPM QA Test D..[1015 REM QA **Ple., (1025 RPM Q& **Ple.,. (1000000004 Sioux Falls 5
1005 RPM QA Test D..[1015 REM QA **Ple., [1025 RPM QA **Ple.,. (1000000003 Pearia 5
1234 Glassware 1001 Decoration 1005 Gifts 1111111113 |Cent. Web YWH & 3]
1234 Glassware 1001 Decoration 1005 Gifts 5 Cent. Catalog V... 3
1234 Glassware 1001 Decoration 1005 Gifts 2222222524 W, Web WWH 12 3]
1234 Glassware 1001 Decoration 1005 Gifts 7 W, MalueMart U, 3| -
4 3

Promotion Constraints List
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Maintain a Promotion Constraint
1. Search for a Promotion Constraint.
2. Enter the ID of the merchandise level the promotion constraint should apply to, or
click the LOV B+ button and select the appropriate merchandise level
3. In the Location Selection area, select the locations the promotion constraint should
apply to.
=  Zone Group: Enter the ID of the zone group the constraint should apply to, or
click the LOV B button and select a zone group.
=  Zone: Enter the ID of the zone the constraint should apply to, or click the LOV
B+ button and select a zone.
= Location: Enter the ID of the location the constraint should apply to, or click the
LOV B+ button and select a location.
In the Constraint field, enter the number of days for the promotion constraint.
5. Click Apply. A row is added to the table.

Delete a Promotion Constraint
1. In the Promotion Constraints table, select the row you want to delete by clicking the

box :I to the left of the row. Press and hold the Ctrl key while selecting to select
multiple rows. Click Select All to select all the rows.

I
Department ID | Department Class Id Class Subclass ID Subclass Location ID Location Constraint
Fiftar by | Fitker by lzl |F.l'!ter by lzl | Fitkar by lzl | Fifkar by lz‘ |Fﬂ'!te.v by lzl |F.l'!ter by lzl | Filker by | Fitker by lz‘
22 Lol warking de.| 1 Dl Test Clas., |1 test subclass 1 | 1000001002 Mall of America ZZ
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports ... | 1000000000 Fargo 2
1414 Activewaar 1000 Sports Clothes | 1000 Mens Sports .. (1000000001 Minneapolis 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports o, | 1000000002 | Madison z
1000 s 1000 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports .. [ 1000000007 Fresno 2z
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports .. | 1000000014 | Baltirmore 2
1414 Activewear 1000 Sports Clothes | 1000 Mens Sports o, (1000001000 Edina 2
20 Merch Extract.,, [ 201 Merch Ext 1 2001 Merch Ext Sub,.[ 1000000000 Farga 10
20 Merch Extract., | 201 Merch Ext 1 2001 Merch Ext Sub..,| 1000000001 Minneapolis 10
20 Merch Extract., | 201 Merch Ext 1 2001 Merch Ext Sub..| 1000000002 [ Madizon 1o
20 Merch Extract.. | 201 Merch Ext 1 2001 Merch Ext Sub...| 1000000007 Fresno 10
20 Merch Extract., | 201 Merch Ext 1 z001 Merch Ext Sub..| 1000000014 | Baltimore 1o
20 Merch Extract.. | 201 Merch Ext 1 200z Merch Ext Sub...| 1000000000 Farga 10
zo Merch Extract., | 201 Merch Ext 1 zooz Merch Ext Sub..,| 1000000001 Minneapolis 10
20 Merch Extract... | 201 Merch Ext 1 200z Merch Ext Sub...| 1000000002 Madizan 10
20 Merch Extract., | 201 Merch Ext 1 zooz Merch Ext Sub,..| 1000000007 Fresno 10
20 Merch Extract.., | 201 Merch Ext 1 2002 Merch Ext Sub..| 1000000014 | Baltimore 10
20 Merch Extract,., | 202 Merch Ext 2 priufuic) Merch Ext Sub,.| 1000000000 Farga 10|
[4] 3

Promotion Constraints Table

2. Click Delete. You are prompted to confirm your decision.
3. Click Yes.
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Glossary

H

# Days Rejects Held: The number of days, set in system options, after the effective date
of a rejected price change or clearance that it is purged from the system.

A

Allow Complex Promotions: When selected in system options, indicates all promotion
types are available. When cleared, the RPM user will only be allowed to create/maintain
simple promotions.

Apply Promo Change Type First: Allows you to indicate which type of promotion
should be applied first.

Area Differential: Area differential pricing allows you to set prices for items at a
particular zone or zone group differently than another zone or zone group.

Auto Approve: When selected on a pricing strategy, indicates price changes created
should be created in approved status.

B

Background Conflict Check: When selected in system options, indicates conflict
checking for worksheets, price changes, promotions, and clearances will be performed in
the background, or when the system is idle. When cleared, conflict checking will occur
real-time.

Buy/Get Component: A component for which the items at specific locations are
promoted at a percent off, amount off, or fixed price, based on the purchase of other
items.

C

Candidate Rule: A set of criteria that is compared to each item/location processed by the
merchandise extract program to determine if the item/location meets one or more
conditions. RPM uses two types of candidate rules, inclusion or exclusion

Class: The fifth level in the merchandise hierarchy. The class breaks down the
merchandise hierarchy. A class can belong to one department.

Clearance: A clearance is designed to move out of date and slow selling merchandise out
of a store. A clearance is considered a permanent price change, and inventory is
consequently revalued. Once the reset date for a clearance has passed, the items price
and inventory value is returned to the regular price.

Clearance/Promotions Overlap: When selected in system options, indicates an
item/location can be on clearance and promotion at the same time.
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Component: The details of a promotion. A component can be simple, threshold, or
buy/ get.

Cost Calculation Method: The way cost is determined for the zone. Choose Highest
Location Cost or Average Location Cost.

Cost Change Forward Days: The number of days into the next review period that a
maintain margin pricing strategy will consider cost changes when proposing price
changes. Cost change forward days should not exceed the length of a review period.

Currency: On System Defaults, the primary currency used in RPM. In other areas of
RPM, the currency for a particular task

D

Deal: The agreement between a retailer an a vendor for rebates or discounts applied to
an item when ordered from the supplier or sold to the customer in certain quantities.

Default Out of Stock Days: The number of days, set in system options, that should be
added to a the effective date of a clearance in order to calculate the Out of Stock date. The
default is applied to generate the out of stock date when the clearance is first created.

Default Reset Date: When selected in system options, indicates that a reset date should
be defaulted when a clearance is created. The reset date is defaulted to one day greater
than the out of stock date.

Department: Belongs to a group in the merchandise hierarchy and provides a way to
define the areas of a group. A department is the fourth division in the merchandise
hierarchy.

Diff: A characteristic of an item that distinguishes it from another item. An item may
have up to four diffs.

Diff Type: The category to which a diff belongs.

Dynamic Area Differentials: When selected in system options, allows the worksheet to
dynamically update secondary locations based on changes to the primary location.

E

Effective Date: The date on which a event becomes available or active in the system.
End Date: The last day an element is effective in the system.

Ends In Digits for Zero Decimal Currencies: The number of digit fields, set in system
options, that are available in the Ends In definition area. This field is used for currencies
that do not contain a place after the decimal point. For currencies that contain places after
the decimal point, the digit fields that are available.

Event: The top level of a promotion, used to group several promotions together.

Event ID Required: When selected in system options, a promotion event must be
assigned to the promotion.
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Exact Deal / Funded Promotion Dates: When selected in system options, indicates that
the dates of a deal associated with a vendor funded promotion must match exactly.
When selected, only deals with the same begin and end dates as the promotion
component being created will appear in the deal

Exclusion Candidate Rule: When the exclusion rule is met, the item/zone will not be
brought into the worksheet for review

External Prices Allowed: When selected, RPM will accept pricing events created in other
systems.

Inclusion Candidate Rule: When the inclusion rule is met, the item is flagged by the
system in the worksheet for a pricing review

Item: The merchandise received from a supplier. In the system, the item field or column
will display the item number, the item description, or both.

Item Level: The level of an item in an item group.

L

Link Code: Link codes are used to associate items to each other at a location and price
them exactly the same.

Location: The store or warehouse involved in an event. In the system, the location field
or column will display the location number, the location description, or both.

Location Move Lead Time: The number of days, set in system options, required before a
location can be moved between zones in RPM.

Location Move Purge Days: The number of days RPM will retain location moves that
have either successfully completed or are the same number of days past the scheduled
effective date but have had no action taken on them.

Location Price Exception: When selected in system options, exceptions should populate
the Zone Location Retail Exception container for items where the current retail at a given
location is not equal to the current retail for the zone.

M

Market Basket Code: A market basket code is a mechanism for grouping items within a
hierarchy level in order to apply similar pricing rules.

Markup: An amount added to the cost price to determine the selling price.

Multiple Item/Location Promotions: When selected in system options, an item/location
can exist on more than one promotion (and more than one component within the
promotion).
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O

Open Zone Use: When selected in system options, indicates a zone can be used across
different types of pricing, regardless of zone type.

Out of Stock Date: The date when the inventory is expected to be exhausted.

P

Partner: A person or entity that has an association with your organization in various
areas of the procurement process. Partners can include those involved in transporting
goods, escheatment, providing credit, and providing services. A partner does not
provide items to a retailer.

Price Change: The permanent change in the price of an item.

Price Change Diff Type: A default indicator to define the diff type that will be displayed
when the user enters the price change and clearance dialogs. This default will only be
applied in the price change/clearance dialogs when the Item level default is set to Parent
/ Diff Type.

Price Change Item Level: Indicates the item level that is displayed when the user enters
the price change and clearance dialogs.

Price Change Processing Days: The number of days, set in system options, between the
creation date of a price change and the first date it can become effective. It allows the
retailer to insure that price changes are created with enough advance timing that stores
and other process areas can react.

Price Change Type: On System Defaults, indicates the price change type that will be
displayed when the user enters the price change and clearance dialogs. The options for
the drop down list are:

Price Change/Promotions Overlap: When selected in system options, indicates an
item/location can have a price change occur during the middle of an active promotion.

Price Guide: A price guide allows you to create a uniform price strategy. You can use
them to maintain a consistent price points. You can determine if the prices in a guide
should be rounded in the same manner or if they should all end in the same digits.

Pricing Strategy: A pricing strategy allows you to decide how item retails will be
proposed when pricing worksheets are generated.

Primary Zone Group: The primary zone group is used to determine:how to items are
initially priced in the merchandising system. which zone structure to store regular zone
retails against when creating price changes. When you create a primary zone group, you
identify the merchandise hierarchy level, the zone group, the markup percent, the
markup type, and the price guide. The merchandise hierarchy assigned to a new item in
merchandising system will determine the primary zone group definition in RPM used to
initially price the item. Based on the information associated with the primary zone group
and the cost of the item, as entered in merchandising system, prices will be proposed.

Promotion: A promotion is a temporary reduction in price. In addition, you can track
sales at one or more locations for a given time period as well as track the sales of
merchandise with no price reductions, at given locations for a set time period.
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Promotion # Days Rejects Held: The number of days, set in system options, after the end
date (or start date for promotions with no end date) of a rejected promotion that it is
purged from the system.

Promotion Constraint: A warning will appear if a price change or promotion is created
that would fall a certain number of days before or during another approved promotion
or price change. The number of days before the promotion is the promotion constraint.

Promotion History Months: The number of months, set in system options, after a
promotion is completed that is purged. This parameter is also used to purge cancelled
promotions.

R

Reason code: The resolution or reason that is applied to an event that occurs within a
system.

Rule Variable: The portion of the candidate rule conditions that allows a rule value to
vary at the department level

S

Sales Calculation Method: The method used by the merchandise extract program to
populate the Projected Sales column in the worksheet.

Simple Component: A component for which the items at specific locations are promoted
at a percent off, amount off, or fixed price.

Start Date: The first day an element is effective in the system.

T

Threshold Component: A component for which the items at specific locations are
promoted by achieving a specific purchasing level.

Z

Zone: A zone is a group of locations that are priced the same within a zone group.
Locations within a zone must have the same currency. Not all locations must be assigned
to a zone.

Zone Group: Zone groups are a collection of zones. You can define multiple zone groups
that are suited to your business. After you define the zone group, you can define the
zones in the zone group. Multiple currencies may exist within a zone group.

Zone Parent Ranging: When selected, RPM should perform ranging checks for price
changes, promotions, and clearances that are created at a higher level than
transaction/location. If the indicator is set to yes, the system will not let you create a
price change at the parent or zone level if none of the transaction item/location
combinations are ranged. If the indicator is set to no, the system will let you create a price
change at the parent or zone level even if none of the transaction item/location
combinations are ranged.
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